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Preface: About this Guide

How to Use this Manual

This Product Reference Guide contains comprehensive basic user instructions for the
Pegaso Industrial PDA software, batteries, dock, serial cable, data transfer, as well as
advanced user information such as bar code configuration and parameters.

This section provides an overview of the manual’s contents and organization.

Document Overview

This document contains the following material:

This Preface provides an overview of the contents for each chapter, and describes
document style conventions.

Chapter 1, "Batteries and Power", discusses checking battery power, power conser-
vation, battery installation, battery charging with a dock or battery charger, battery
storage, battery disposal, and resetting the mobile computer.

Chapter 2, "Configuring the Pegaso”, uses the control panels to adjust touchscreen
calibration, date and time, display backlight/contrast, volume/sounds, scanner,
power, and memory.

Chapter 3, "Software Applications", covers memory, installing, selecting, using,
and removing applications, entering data, and using the soft input panel with
Inbox, Internet Explorer, and Word Pad.

Chapter 4, "Networks, Communications, and Connections", describes installing,
setting up, and using ActiveSync and Networking,.

Appendix A, "Accessories", describes the Accessories, such as docks, battery charg-
ers, holsters, and soft cases available for the Pegaso.

Appendix B, Datalogic® Desktop Utility (DDU) allows Datalogic Windows
administrators to configure Windows®CE PDAs and PDTs to control individual
user access.

Appendix C, "Configuring the Web Server", describes configuring the Pegaso to
work with a Web Server.

Appendix D, "SNMP Interface", describes SNMP (Simple Network Management
Protocol) concepts, MIB (Management Information Base) files, and provides addi-
tional resources.

Appendix E, Cable and Connector Configurations contains pinout information,
to create standard interface cables for use in interconnecting the Dock to power

and/or peripheral devices.

Product Reference Guide \Y;



Preface: About this Guide

* Appendix F, "Programming Parameters", provides the programmable settings for

the Pegaso.

*  Appendix G, "Programming Bar Codes", provides bar codes for common setup
parameters used to program the Pegaso.

* Appendix H, "Glossary", is a glossary of terms used in this manual that you may
not be familiar with that are specific to Windows®CE and the mobile computer.

Registering Your Datalogic Product

Datalogic values your feedback. Please take a few moments and complete the Product
Registration form located on our website (www.datalogic.com). Registering your prod-
ucts ensures that you will be informed of the latest product news, technical specifica-
tions, software updates and other future developments from Datalogic.

Document Conventions

Formatting conventions are used throughout this guide to provide a consistent method
for representing screen shots, command entries, and keyboard characters. This guide
also provides special conventions for notes and cautions, information of high interest.

otely NOTES contain information necessary for properly diagnosing, repairing and operating
the terminal.

& The CAUTION symbol advises you of actions that could damage equipment or property.

CAUTION

A A WARNING symbol calls attention to actions that could result in personal injury.

WARNING

Keystrokes. Filenames, paths, field selections from a pull-down list, and data or key-
strokes entered by the user are shown in this monospaced typeface.

Windows Controls. Windows controls including command bar sequences, prompts,
dialog boxes, fields, pull-down lists, check boxes and radio buttons are printed in this
bold typeface.

Portable Keys

Keys on the Pegaso are bracketed by “greater than” and “less than” symbols
(<>) to distinguish them from keys on the PC.

<F1> — <F19> Keys. The Function keys, such as <F1>, refers only to keys on the
Pegaso.

Vi
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Document Conventions

<ENTER> Key. To differentiate the <ENTER> key on the portable from the Enter key
on the PC’s keyboard, portable keys are formatted with “greater than” and “less than”
symbols: <ENTER>.

Stylus Actions

Stylus actions apply to the Pegaso only; most PCs use a mouse as an input device.

Tap or Select. Tap the display screen once with the stylus to activate a specific button
or select an item from a pull-down list.

Double-Tap. Tap the stylus twice rapidly in the same location to open an application.

Tap and Hold. Tap and hold the stylus to view the context menu.

Refer to the Quick Reference Guide (QRG) for more information on using a stylus with
the Pegaso.

Mouse Actions

Applies to the software installation portions of this document using a PC; the Pegaso
comes equipped with a stylus. Refer to Stylus Actions on page vii, or see the QRG for
more information.

Click or Select. Press and immediately release the left mouse button without moving
the mouse. Clicking is used to select specific buttons on various forms and tables.

Double-Click. Click the left mouse button twice in rapid succession. Used to initiate
an application.

Right Click. Press and hold the right mouse button without moving the mouse.

Select. Click and release the left mouse button to choose an item or items from a pull-
down list.

Product Reference Guide vii
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Chapter 1
Batteries and Power

Overview

This section contains the following topics:
*  "Suspend Mode" starting on page 1-1
* "Battery Warnings and Cautions" on page 1-2

* "Battery Disposal"” starting on page 1-3.

Suspend Mode

The Pegaso will go into a suspend or sleep mode when it is idle for a period of time.
This duration can be customized using the Power control panel (refer to "Power Config-
uration” on page 2-21. Suspend mode works and looks just like you have turned the
unit off. Press <Power> to suspend (put to sleep) the Pegaso. Press <Power> again for the
Pegaso to resume its previous state.

Use the Battery Power control panel to set the idle duration and the initiation of suspend
mode. These features save battery power when the unit is not in use. Refer to "Battery
Tab" on page 2-21 for more information.

Suspending

The following conditions will put the unit into suspend (sleep) mode:

1. When the unit is on, and you press <Power> for 0.5 second to initiate suspend
mode.

2. When the sleep timer expires, indicating that there has been no use for a specified
period of time.

3. A discharged battery pack.

Resuming

Use one of the following methods to resume (wake up the Pegaso):
*  Dress <Power> to resume (wake up).
*  DPut the Pegaso into a dock.

*  Dress the Scan Trigger to wake up the unit (handled version only).

Product Reference Guide 1-1



Batteries and Power

When a battery pack is fully discharged while the unit is in suspend mode, the Pegaso
remains in the suspended mode until the battery pack is charged or external power is
supplied via the dock or a power cable.

Battery Warnings and Cautions

WARNING

Do not discharge the battery using any device except for the Pegaso. When the battery is
used in devices other than the Pegaso, it may damage the battery or reduce its life expect-
ancy. If the device causes an abnormal current to flow, it may cause the battery to become
hot, explode or ignite and cause serious injury.

Lithium-ion battery packs may get hot, explode or ignite and cause serious injury if
exposed to abusive conditions. Be sure to follow the safety warnings listed below:

Do not place the battery in or near fire, direct sunlight, or other high temperature loca-
tions, or heat the battery.

Do not connect the positive terminal and negative terminal of the battery to each other
or short circuit battery terminals with any metal object (such as wire, coin or metallic
object).

Do not expose the battery to liquids, or allow to get wet.

Do not disassemble, modify, open, crush, bend, deform, puncture, shred, remanufacture
or pierce the battery. The battery contains safety and protection devices, which, if dam-
aged, may cause the battery to generate heat, explode or ignite.

Use only battery packs that have been authorized by Datalogic per IEEE Standard 1725-
200x for GSM/GPRS/EDGE operation.

Promptly dispose of used batteries in accordance with local regulations.

Battery usage by children should be supervised.

Avoid dropping the PDA or battery. If the PDA or battery is dropped, especially on a hard
surface, and the user suspects damage, return it to a service center for inspection.
Only use the battery for the system for which it is specified.

In the event the battery leaks and the fluid gets into your eye, do not rub the eye. Rinse well
with water and immediately seek medical care. If left untreated, the battery fluid could
cause damage to the eye.

1-2
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Battery Disposal

near the temperature limits will increase the time necessary to fully charge the battery, and

Always charge the battery at 32°-104°F (0°-40°C) temperature range. Regularly charging
& will shorten the battery’s useful life.

If you remove the battery pack or it becomes completely discharged, there is a 30-minute
window in which to insert a charged battery pack before the backup battery fails. If your
backup battery completely discharges, the contents of the RAM memory will be lost. If your
back-up battery is less than fully charged, there is a proportionally smaller time available.

CAUTION

Use only the authorized power supplies, battery pack, chargers, and docks supplied by
your Datalogic reseller. The use of any other power supplies can damage the Pegaso and
void your warranty. Refer to Appendix A for the correct Power Supplies and Accessories.

Only use the battery with a charging system that has been qualified with the system per
this standard. Use of an unqualified battery or charger may present a risk of fire, explosion,
leakage, or other hazard.

Do not disassemble or modify the battery. The battery contains safety and protection
devices, which, if damaged, may cause the battery to generate heat, explode or ignite.

Do not place the battery in or near fire, on stoves or other high temperature locations. Do
not place the battery in direct sunlight, or use or store the battery inside unventilated areas
such as cars in hot weather. Doing so may cause the battery to generate heat, explode or
ignite. Using the battery in this manner may also result in a loss of performance and a
shortened life expectancy.

Do not place the battery in microwave ovens, high-pressure containers or on induction
cookware.

Immediately discontinue use of the battery if, while using, charging or storing the battery,
the battery emits an unusual smell, feels hot, changes color or shape, or appears abnormal
in any other way.

GTE Datalogic recommends annual replacement of rechargeable battery packs to ensure maxi-
‘ . mum performance under normal use. If battery pack has heavy use (requires charging
more than once a day), it is recommended that batteries be replaced at 6-month intervals.

Battery Disposal

If you must dispose of a battery pack, please follow the CAUTIONS below:

Use only a battery pack supplied by a Datalogic reseller for this device.The use of other
battery supplies can damage the Pegaso and void your warranty. Contact your reseller to

for the correct power supplies; view your options under "Battery Pack" on page A-2.
CAUTION

Product Reference Guide 1-3



Batteries and Power

When the battery pack is worn out, insulate the battery pack terminals with adhesive tape
& or similar materials before disposal.

CAUTION Recycle Lithium-lon Batteries.

Do not throw Lithium-lon Batteries in the trash

Please reference your local regulations for any further guidelines about battery disposal.

1-4 Pegaso™ Industrial PDA with Windows® CE



Overview

This section contains the following topics on configuring
your Pegaso. Most control panels are accessed by selecting/
tapping Start > Settings > Control Panel.

Chapter 2

Configuring the Pegaso

"Backlight" on page 2-2

"Bluetooth Manager" on page 2-3 (optional)

"Certificates" on page 2-6

"Datalogic Desktop Utility" on page 2-7
"Date and Time" on page 2-7

"Decoding" on page 2-8
"Device Info" on page 2-12

"Display Configuration" on page 2-12
"Error Reporting” on page 2-13

"Input Panel Properties” on page 2-14
"Internet Options" on page 2-14
"Keyboard Configuration" on page 2-17
"Network and Dialup” on page 2-18

"Owner" on page 2-19
"Password" on page 2-19

"PC Connection" on page 2-20
"Persistent Registry" on page 2-20
"Power Configuration" on page 2-21
"Regional Settings" on page 2-22
"Remove Programs"” on page 2-23
"Storage Manager" on page 2-23
"Stylus Calibration" on page 2-23
"System Properties” on page 2-25
"Volume and Sounds" on page 2-26

"Wi-FI" on page 2-27

Control Panel

o -
» 8. er

hi Certificates

Deskt...
Device Info Display Error

Repaorting

5§ 9 =

Input Panel  Internet Keyboard
Options F

{f||B-CMmI|5,ﬂ 3 1=1e|m|@ |%

Fle View 7] %

b

e & 7

Metwork Owmner Password
and Dighu...
) @,‘“’ a ;l;}
PC Persistent Power

Connection Registry

Reagional Remove Storage
Setfings Programs Manager

I 9

Stylus System Volume &

Sounds [+

&f”[}l:mtmunspﬁ 3 1=12pn|@ |%
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Configuring the Pegaso

Backlight

ore]lp Increasing backlight brightness can cause the battery pack to discharge at a faster rate.
1 " The battery discharge rate slows with a decrease in backlight usage.

Select Start > Settings > Control Panel > Backlight to open the Backlight control panel.

Brightness

1. On the Brightness tab (refer to Figure 2-1), use the slider to adjust the brightness
to the desired setting. You can also use the <UP> and <DOWN> arrow keys to adjust
this setting.

2. Auto Power-Save dims (rather than turning off) the backlight after 15 seconds of
inactivity. This features does not change the behavior of the Auto-Off Settings.
(Refer to "Power Configuration” on page 2-21).

3. The ambient light sensor automatically adjusts the intensity of the backlight on
the display and keypad in response to changes in lighting conditions. Select the
check box to enable or disable this feature.

Figure 2-1. Backlight Control Panel & Brightness
Backlight Properties oK X

Brightness | Auto-Off | Actvation |  [EEIMNEIIEHES | OK| |

Brightness | Auto-Off | Activation |

Warning: higher backlight brightne:|

o ek ke (B
A S backlight when not needec
Backlight Brightness:
o By e Tum off backight when using:
k . &) ' ; [v| Battery power, and device is idle

for more than 15 saconds |

[v] Dim if idle for 15 seconds
[ External power, and device is idk
[] Auto-adjust for ambient light for more than ;

Auto-Off

On the Auto-Off tab, enable the desired option checkbox and select the desired options
from the pull-down lists (refer to Figure 2-1).

2-2 Pegaso™ Industrial PDA with Windows® CE



Bluetooth Manager

Activation

1. On the Activation tab, just tap the checkbox(es) to enable or disable them (refer to
Figure 2-1):

* Set the backlight to turn on automatically when any key is pressed or the touch-
screen is tapped, either while on battery or external power.

* Turn on the backlight when the trigger is pulled.

¢ Deselect Launch Control Panel from the Keyboard to turn off the ability to
open the Backlight control panel with a key sequence.

orelg Using Auto-on while running from battery power will cause the battery pack to discharge
‘ at a faster rate. The battery discharge rate decreases with a decrease in backlight usage.

2. To exit and save your modifications, tap OK on the command bar, or press <Enter>
on the keypad.

Bluetooth Manager

Search for device

1. Select Start > Settings > Control Panel > Bluetooth Manager to open the Bluetooth con-
trol panel.

2. Search for the type of Device(s) you want to connect to by tapping Printer, Serial, or
All. The Pegaso will search for Bluetooth Devices within range.

3. Ifyou attempt to set up a connection when the Bluetooth Radio is disabled, you
will receive a message reminding you that the radio is turned off, and asking you if
you want to turn it on. Tap Yes if you need to enable the Bluetooth Radio.

Once searching is complete, Bluetooth Device Profiles will be displayed in the Discov-
ery tab. You can set up a connection to a device on the list, or clear it from the list by
tapping the Clear button.

Figure 2-2. Searching for a Bluetooth Device

Connections  Discovery | Settings | | Connections | Discovery | settings
Discovered Devices: Discovered Devices:

Name e Neme [ Addess

Searching for al AVIMAWALA 000A9402F229

Devices. .. SSHEARER 3 000AS402EF27

XXXx07-09-5111 00037A332C80

QL220 00037A29C553

g Unknown 0007808 14086
4] |»] < ]
|Discover| [Comedl[ Clear | ‘Dscwerl ‘Comectl [ Clear [
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Configuring the Pegaso

Connect to a Bluetooth Device

1. From the list of available devices, double tap the one you want to activate, or select
and then tap Connect.

2. The resulting dialog will display services that are available on the device.

Name: XXXX07-09-5111
Select a service:
&hPrinter

¢ Serial

& ActiveSync

Virtual Port: [None ]

[] Authenticate

Select the service you want to connect to. The following table shows the icons that dis-
play for different types of service.

Table 2-1. Bluetooth Device Icons

Icon Service

E? Dialup Networking

= Printer

. File Transfer Protocol (FTP) Object Exchange (OBEX)

LE Object Push (OPP) Object Exchange (OBEX)

& ActiveSync

@ | Human Interface Device (HID) - Keyboard

Serial

V& al Port allows you to specify the incoming port, which is used to communicate seri-
ally with an incoming device just as if it were a physical COM port. This option is avail-
able only if you have selected a Printer or Serial service.

You can also select Encrypt or Authenticate from the Bluetooth control panel to apply or
modify those settings.
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Bluetooth Manager

1. To require Authentication, tap the checkbox, then <[]
tap OK. Enter a PIN to authenticate the ]~
connection.
2. The Authentication Request dialog will then Name:  3000{07-09-5111
open, requesting that you enter a PIN. Use the Address: 100037432080
Input Panel to type in the PIN. Enter PIN: |

3. Tap OK to complete.

) ) . £sc|1]2]3]415]6]7]8]9]0]- -4
The dialog will also appear when an Authentication Taslatwlels [E[sTulT1olplT1]

. : : caP[als]alf]aln[i [k 1] [
request is received from another device. T TR T TR T T T2
culail " T4 ] [4[1]<]>

Viewing or Deleting Paired Devices

Once you have set up a Pairing, you can view the settings by double-tapping its name
from the Connections tab. The Pairing info dialog will display different options,
depending on what type of device you have selected and what service you use.

Pairings
* For a printer connection, tap the arrow to change the Virtual Port, or Delete to

remove the device pairing.

* Tap Sync to initiate a Sync (available only if the service is an ActiveSync connec-
tion).

Figure 2-3. Pairing Info

Bluetooth Manager m
Connections D'ts'coveryl Settings'

Paired Devices {double tap to edit):
&5 q1220 (como:)

Search for devices:

N
=

Printer Serial All
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Bluetooth Icons

The icons displayed in the taskbar at the bottom of your Pegaso’s screen will show you
the state of the Bluetooth connection, as shown in Table 2-2.

Table 2-2. Bluetooth taskbar icons

Icon Name Description

EB Disabled Icon Indicates that Bluetooth has been disabled.

Indicates that the Bluetooth radio is on but the device

& Unpaired lcon is currently not paired to another.
9 , Indicates that the Bluetooth radio is on and the
Paired Icon o . .
device is paired with at least one other device.
Di Indicates that the device is discoverable by other
iscoverable ,
& Bluetooth devices.
Settings
The Settings tab allows you to enable or disable the Bluetooth radio and specify settings
for Incoming Connections.
Tapping Find Me will make the Pegaso available to other Bluetooth devices for 60 sec-
onds, allowing them to set up a connection.
| Connections | Discovery | Settings [ Connections | Discovery | Settings
[ Enable Bluetooth Radio
- Incoming Connection
Bl Find Me
[] Discoverable
el 2| for 60 Seconds
Port: [None v Port: INone vl
| Fndve | | appy || mRo | | FndMe | | appy | | mf
Tap Apply to apply the settings you have selected.
Certificates

Certificates are used by some applications for establishing trust and to secure communi-
cations. See the Microsoft Windows CE help on your unit for further information
about Certificates.
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Datalogic Desktop Utility

Datalogic Desktop Utility

Tap Start > Settings > Control Panel > Datalogic Desktop Utility to access configuration utili-
ties such as the Datalogic Desktop Utility (DDU) settings. See "Datalogic® Desktop
Utility for Windows® CE", starting on page B-1, for complete information.

DDU Settings may be configured with Datalogic Configuration Utility (DCU) and

Wavelink™ Avalanche.

Date and Time

In this control panel, you can change the year, month, date, time, time zone, or select
automatic adjust for Daylight Savings Time. To set or change the date and time:

1.

2.

Select Start > Settings > Control Panel > Date/Time.

Date/Time Properties m
I Date/Time |

[ 4 | June 2008 [ > |
S M TWTF S

Select the month to open a pull-down list of
months or tap the arrow buttons on either side of
the month to increase or decrease the month.

1 .2 3 4.5 6 7
g 0 i it 17 1302
15 16 17 18 19 20 21
22 ¥E¥ 24 25 26 27 28
2930 1 2 3 4 5

| 3:46:56 PM

Time Zone

To change the year, select the year to open a
numeric dial. Select the up arrow to increase the
value; select the down arrow to decrease the

! 0O lue in th |(GMT-08:00) Pacific Time (US & Ca| =]
value. Or you can type a new year value in the R

ﬁeld D__rlnrk for daviinht savinn Apply |
. '1?||;‘)Dah.’m||:'pﬁ>mm|@|%

To change the time, select the hour, minute, sec-

onds, or AM/PM and select the up arrow to

increase the value; select/tap the down arrow to decrease the value. Or you can
type a new time value in the field.

Select your correct time zone from the pull-down list.

To automatically adjust the clock for Daylight Savings Time, enable the checkbox
at the bottom of the screen.

Select Apply to save your changes and make additional modifications.
* Select OK to save your changes and exit Date/Time Properties.

* Select/tap the close button to exit without saving your changes.
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Configuring the Pegaso

Decoding

You can configure the Pegaso’s decoding options by tapping on Start > Settings > Control
Panel > Decoding. Decoder configuration can also be accomplished for large numbers of
terminals using DCU (Datalogic Configuration Utility) and Wavelink Avalanche®.

There are two sections in the Decoding control panel, each containing additional pages.
There are several General Configuration pages and multiple Bar Code symbology pages.

Other decoding parameters are described in Programming Parameters, starting on
page F-1; bar code settings are provided in Programming Bar Codes, starting on
page G-1.

Configure Control Panels

Select the desired configuration from the following options shown in Figure 2-4, and
the other Decoding Properties figures on the following pages.

Use the pull-down menus or tap the left and right arrow keys to navigate the different
pages from the Configure menu.

Figure 2-4. Decoding Properties: Audio

Decoding Properties Decoding Properties 7 JOKJ X
N Settings /<[~ Configure Settings || = |
ora ‘Addio I .
1D Bar Code »| General Options Audio
Volume 7 Deqoding Qptions Volume ——————— J
Devices G ontne g
-Beep rBeep
Type ]:Z-.::-.“,-:'J Read m Type I:;::-:.‘J Read lLI

Tone —I lllll : Tone 17
Duration .—.‘ J_' Duration J—
_' " '

Number —_J Number

To view other configuration options, select Configure > General from the menu.

*  Audio: Sets volume, tone, duration, and number of various types of beeps.
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Decoding

Figure 2-5. Decoding Properties: General Options

Decodinag Properties ? BOKR % Decoding Properties 7 JOK X
LTy Settings |6 | = [ Configure Settings |||
era Audi ¥
= ’ General Options
D o General Options
- Decoding Options
Vokna s [V] Label Programming Enable
Type ]:Z-.::-.“,-:'J Read m Symbology IDs IOH:—E
Tone |7 Label Prefix -NULL- |w
Duration —U— Label Suffix [-ENTER-
Number —————— | Data Separator [-ENTER- ||

* General Options: Select from Label Programming Enable, Symbology IDs, Label
Prefix, Label Suffix, and Data Separator options.

Figure 2-6. Decoding Properties: Decoding Options

Decoding Properties 7 JOKJ X Decoding Properties Em
QLY Settings ¢ | = [ Configure Settings || = |
era Audio ’ .
DB Coday || Conesd OOl Decoding Options
Voume - oding Opti Symbology
Devices I 1
.BeEn — C 1
T Code 93 L 1
Type |Good Reac 7] Code 128 K 1
B EAN-13 M1
EAN-8 G 1
Tone Ji Tnkadasiumd 21 D 1 EI
Duration ———— }— L= |
' . " Redundancy |1 |v|
SHukicy . . .J [ Aggressive Decoding

To view other configuration options, select Configure > General from the menu.

* Decoding Options: Set the User ID character associated with a symbology, the Redun-
dancy and select Aggressive Decoding when available.
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Configuring the Pegaso

Figure 2-7. Decoding Properties: Devices

Decoding Properties [l [ Decoding Properties [l [
_g?nﬁgure Settings | Configure Settings [E Igl

General il Audio Devi
General /% SUCES
Volime Decodin/f Options rKeyboard Wedge ———
: . Devi [V] Bar Code
Type |Good Read =l [¥] Magnetic Stripe
i [¥] RFID
Tone Ji
A ‘Read Ahead
Duraton ———— J— [V] Internal Laser
Number J

To view other configuration options, select Configure > General from the menu.

* Devices: Enable the keyboard wedge for bar code scanner, Magnetic Stripe Reader,
RFID, and enable Read-Ahead for attached devices.

Bar Code Symbology Pages

Use the pull-down menus from Configure > 1D Bar Code, or tap the left and right arrow
keys to navigate the different pages of the bar code symbology pages. Each bar code
symbology opens to its own page, as shown in Figure 2-9 on page 2-11.

Figure 2-8. Available 1D Bar Code Symbologies

Decoding Pr§ _—
Configure |issd Codabar Interleaved 2/5
i Code 128 .
\ e Code 39 Matrix 2/5
1D Bar Cod ISR Code 93 MSI
Mag Strie|  Can-13 Code 128 Pharmacode 39
1 Audio EAN-8 EAN-13 Standard 2/5
Type || ©S!DataBar-14 EAN-8 Trioptic
651 DataBar Limited GS1 DataBar-14 UPC-A
FonaWcs et N tad GS1 DataBar Limited UPC-E
vl GS1 DataBar Expanded ~ UPC/EAN Extensions
Duration| Matrx 2/5
MSI
Nurmbes Ehamcode 39 See Appendix G for details on parameters available for
Standard 2/5 each symbology.
& [mose, _

Refer to the sample symbology control panels in Figure 2-9 for examples of the types of

fields and options you can modify.

OTE Decoding parameters are described in Programming Parameters, starting on page F-1;
bar code settings are provided in Programming Bar Codes, starting on page G-1.
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Decoding

Figure 2-9. Common Symbologies: Code 39 and UPC-A

Decoding Properties E m

Decoding Properties n m

Configure Settings ||| Configure Settings || = |
Code 39 [V] Enable UPC-A [V] Enable
Lengths

Min |1_E Max WE [ 7] Send Check Digit

[¥] Send System Digit
[7] Convert to EAN-13

["] Enable Checksum
[ Send Checksum
[w] Full ASCTI Conversion

[ ] Concatenate

* Code 39: Select from enable, min/max lengths, enable checksum, send checksum,
and Full ASCII conversion.

* UPC-A: Select from Enable, Send Check Digit, and Send System Digit.

orelp Other decoding parameters are described in Programming Parameters, starting on
‘ page F-1; bar code settings are provided in Programming Bar Codes, starting on
page G-1.
Mag Stripe Reader

Figure 2-3. Decoding Properties: Mag Stripe Reader

Configure Settings |¢& |l=b|

General

1D Bar Code B Mag Stripe

ag Stripe
B | Y E ‘ Enable  Require
1 Code
2 Mag Stripe Trackd fvifs ] ]
3 UPC-A hecksum Track2 [V M
4 Audio bcksum Tack3 [V ]

[w] Full ASCII Conversion

To view other configuration options, select Configure > General from the menu

*  Mag Stripe: Select to Enable or Require Track 1, 2, or 3.
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Configuring the Pegaso

Device Info
Select Start > Settings > Control Panel > Device Info to view the device serial number, model
number, firmware version, and keyboard type.
The serial number is also displayed on a label inside the Battery compartment, as shown

in Figure 2-10.

Figure 2-10. Serial Number Locations

Device Info |

Device Information
S/N: F507033031 Serial
Number
Model: Pegaso
Version: 0.56
Keyboard type: 19 Key

Language: Western
European

Display Configuration

To change the default Background or Appearance (Windows Color Scheme), select Start
> Settings > Control Panel > Display.

Background
To change the Background image:

Background | Appearance |

1. Select Start > Settings > Control Panel > Display.

2. Place a new image in the Windows directory. [] Tile image on background
This file must be exactly 480 pixels wide by
640 pixels high.

3. The current file is located in the Windows
directory with the Datalogic logo file named
DeskLogo .bmp.

4. Select the new file name by using Browse.
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Error Reporting

Appearance
To change the default Windows color scheme:

1. Tap the Appearance tab. Pckground]
Scheme:

| Save... | | Delete | | Apply |

2. Tap the Scheme pull-down list and select a new

Windows color scheme if desired.
3. Tap OK on the control bar, or press <Enter> on Window Text
the keypad.
Dialog Box Text
=
Irem: |Desktop lL] ﬁ

Settings

To change the Display settings:

| Background | Appearance| Seftings |

1. Tap the Settings tab.

Rotation
2. Select the desired Rotation using the radio but- @0 O 180°
tons. () o0° ) 270°
3. Change the Resolution by selecting the desired Resciuken
setting. @ QVGA (320x240)
O VGA (640x480)

4. Tap OK on the control bar, or press <Enter> on
the keypad.

Error Reporting

1. Select Start > Settings > Control Panel > Error Reporting

2. Enable or disable error reporting and related =T~ il

features by tapping on the desired selections. Error Reporting [0K]

"A Report software errors to
3. Tap OK on the control bar, or press <Enter> on d Microsoft to help improve

the keypad. products.

[] Enable error reporting
[ Display upload success
[] Display upload failure
File system usage:
() 128 ke .

Larger sizes increase
(O 256 kB the opportunity to
() 384 kB correct problems.
@ 512K8
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Input Panel Properties
To change the Soft Input Panel settings:

Input Panel ]
Current input method:

1. Select Start > Settings > Control Panel > Input

Panel. Kevboard

2. Change the desired settings. Jutions.= |
. [ Allow applications to change the

3. To change the Soft Keyboard Options, tap input panel state

Options. To quickly switch input methads,

tap the Input Panel arrow and

4. Change the soft keyboard options as desired, gnmt;ﬁut:ﬁf’mg?mw from

selecting from:

* Large or small keys.
* Using gestures for space, backspace, shift, and enter.

5. To exit the Soft Keyboard Options, tap OK on the Soft Keyboard Options [0K]
control bar, or press <Enter> on the keypad. B S

. . @ Small keys d]f]g]
6. To exit Input Panel settings, tap OK on the con- €lvlb]
[ Use gestures for Space,

trol bar, or press <Enter> on the keypad. Backspace, Shit and Enter

‘ |§|' Space

E] G-E] Backspace
F

@lantar

Internet Options

To change the Internet default settings:
1. Select Start > Settings > Control Panel > Internet Settings.

2. On the General tab (refer to Figure 2-11A), type in the URL of the desired start
page and the desired search engine. You can also select a User Agent, change the
Cache Size, clear the Cache, and clear the History.

3. On the Connection tab (refer to Figure 2-11B) modify the network access settings
as desired.
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Internet Options

Figure 2-11. Internet Settings

) ] ¢ ]

General | connection | Securiy | r_<[» [ General| Connection | security | pr[ |
Start Page: ;
= | Use LAN (no autodial)
[http:/ www.mobile.datalogic.com L )
Autodial name: |USB | v’
Search Page:
|http:f,!www.google.com;’ ie [ Access the Intemet using 2
proxy server
User Agent (requires browser restart):
[Defautt (Windows CE) =] Address: |
Port: 80
Cache Size (in KB): 512
Bypass proxy server for local
D addresses

4. On the Security tab (refer to Figure 2-12A) add sites or modify the security settings
for Internet, Local intranet, Trusted Sites, and Restricted Sites.

Figure 2-12. Internet Settings

2 ’
| General | Connection | Security | pr_<[ »

X
=~ ActiveX controls and plug-ns || [
0 “r{l o Script ActiveX controls markef
- Disable
Local Trusted Enable
intranet sites
| Prompt I
4| | D Initisize and script Actvexcc ||
Disable
@ Internet Enable
Prompt
This zone contains all Web sites you [=] Run ActiveX controls and plug
haven't placed in other zones Disable v
_ rzﬁ_—:L O
[ Sites... | ] Settings... | | ~ Yot -

5. The Privacy tab (refer to Figure 2-13) allows you to modify the settings by tapping
the radio buttons. You can Accept, Block or receive a Prompt for First-party and

Third-party Cookies. Enable/Disable session cookies by selecting/deselecting the
check box.
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Figure 2-13. Internet Privacy Settings

| Connection | security | Privacy | adl«[»
Cookies

Third-party
() Accept
O Block

O Prompt @ Prompt
Always allow session cookies

6. On the Advanced tab (refer to Figure 2-14A) modify the advanced settings for
Accessibility, Browsing, Multimedia, and Security by tapping the check boxes.

Figure 2-14. Advanced Internet and Popup Settings

[N Internet Options OKj X Il Intemnet Options OKj X
Security | Privacy | Advanced | pop( <] | [ Privacy | Advanced| Popups | aE
EifAccessibility 7 Popup Windows

|| Always expand ALT text for [ | =
Anchors navigate on access | [] Block popups

'=| Browsing 0 = 7
- [] Always send URLs as UTF-8 (R |
Display a notification about e—

V| Enable stylesheets | Advanced |
| | Enable page transitions

v| Theming support

f _ Display notification when a
|_| Disable automatic SIP [V popup has been blocked
=] Underiine links 5 o th t
N s Open new pages in the curren
_ b [ [ Window
<] | L»

7. The Popups tab provides options for blocking popups, to display notification
when popups have been blocked, and to open new pages in the current window.

8. To exit Internet Settings, tap OK on the control bar or press <Enter> on the keypad.

2-16 Pegaso™ Industrial PDA with Windows® CE



Keyboard Configuration

Keyboard Configuration

1. Select Start > Settings > Control Panel > Keyboard Options to open the Keyboard con-
trol panel.
2. Adjust the slider for Multi-Tap Timeout to match your personal preferences. Use the
box provided to test the timeout delay.
3. Click the Load Map tab to select a keyboard keymap by browsing, or click the but-
ton for Default Map. Use the box provided to test the current keyboard mapping.
4. Use the Triggers tab to define the behavior of each Trigger by selecting it from the
drop-down box, then clicking the desired option. Available items will vary
depending on the model.
oo roperes —
Options [ Load wap | Triggers| || Options | Load Map | Trggers| [ options | Load Map| Triggers |
Mult-Tap Timeout 330 ms Trigger: | ESNNGNGG_~
=1 Current map:
e } : @ BarCode (O Disable
] - | O Image O Key Press
(O RFAD
‘DefaultMap| | ooy |
Type here to test Type here to test mapping:
| |
5. Tap OK to exit the Keyboard Options control panel.
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Network and Dialup

To change the Network and Dialup connection settings, complete these steps:

1. Select Start > Settings > Network and Dialup Connections.

Figure 2-15. Changing the Network & Dialup Connection Settings.

Bl 2 %
USB

Make New Serial
Connection

#$
[

47|/ conn... || 2o > 4:36 oM A

Gommecton | £.] [ [&5] [#]<]

"Summit WLAN Adapter” ... [ 2

IPAddr&sINameSewers]

Summit WLAN Adapter ... [ E3

An IP address can be automatically
assigned to this computer.

@ Obtain an IP address via DHCP:

O specify an IP address

IP Address: :
Subnet Mask: :
Defaul Gateway: [ . | | |

[1p Address| Name Servers|

Name server addresses

SO —
secondayons: [ ]
e N —
CE Y —

87|/ @ conn...|| L ge» 240 pm A

87| @ conn... || o g 2:09om G2 | By

2. Double-tap the connection to view or change the settings. The SDCCF10G1 item
shown as an example can vary, depending on the radio installed and the number of

connections.

3. Complete the two tabs as shown in Figure 2-15:

* IP Address: Select DHCP or set static IP settings.

» Name Servers: If using static IP, set DNS and WINS servers.
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Owner

Owner

To change the Owner default settings:

1.

3.

Select Start > Settings > Control Panel > Owner
Properties. The Input Panel opens to facilitate
entering data.

Enter data using the input panel or the keypad
on the PDA.

To exit the Owner Properties control panel, tap
OK on the control bar, or press <Enter> on the

keypad.

For more information on using the Network ID tab,

refer to "Setting up the Network ID" on page 4-7.

Password

To change the Password default settings:

1.

4.

Select Start > Settings > Control Panel > Password
Properties.

Enter the desired password twice as indicated
in the two fields.

Select to enable password protection at power-
on and/or enabling password protection for

the screen-saver.

To exit the Password control panel, tap OK on

the control bar, or press <Enter> on the keypad.

Owner Properties m m
Identification | Notes | Network ID |
Name:
[10hn Smith
Company:
[Datalogic Mobile,Inc.
Address:

1505 Westec Drive
Eugene, OR 97402

Work phone; [541-743-4800
Home phone: |

At power-on
[V Display owner identification

Password Settings |

Password:

IW'
Confirm password; |*******

[V] Enable password protection at
power-on

[¥| Enable password protection for
SCreen saver
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PC Connection

The PC Connection control panel determines how ActiveSync works with the PDA. To
modify the default settings:

1. Self;.ct Start > Settings > Control Panel > PC Con-
nection. m]

: [v] Enable direct connections to the
2. Selec't the first checkbox to enable direct con- el
nections to the desktop computer. Wi ot
desktop computer using:
3. Tap Change Connection to modify the connec- sH;

tion method from USB or Serial. _Change Connection.... |

Warning: Changing the

4. To exit the Change Connection dialog, tap OK connection may disable
communications with your
on the control bar, or press <Enter> on the key- desktop computer.
pad.

5. To exit the PC Connection Properties control
panel, tap OK on the control bar, or press <Enter> on the keypad.

Persistent Registry
Persistent Registry saves the RAM-based registry to

persistent storage. Persstent Registry |
. . . Y2 Persist or clear registry
1. Tap Persist to persist the registry. , settings now or persist

settings automatically at a
regular intenval.

2. Tap Persist registry settings to automatically |
persist the settings at the time specified in the

dr OdeWI'l box Persist registry settings:

[V] Every |1 hour |v|

3. Tap Clear to delete all persistent registry files
Warning: automatically persisting the

from the Flash FX disk. registry at frequent intervals can
degrade system performance.

Persist |  Clear |

‘ - Automatically persisting the registry at frequent intervals may slow system performance.

2-20 Pegaso™ Industrial PDA with Windows® CE



Power Configuration

Power Configuration

To adjust power management settings, select Start > Settings > Control Panel > Power. Use
this control panel to check the charge on the battery or to change the Power settings.

Battery Tab

The Battery tab provides power indicators for External power, Main battery, and Backup
battery as shown in Figure 2-16 on page 2-21. To save your settings, tap OK on the com-
mand bar, or press <Enter> on the keypad.

Schemes Tab

The Schemes tab allows you to switch the power scheme and specify the Idle settings for
User (in 1-minute increments) or System (in 5-minute increments). You can also specify
Suspend settings in 5-minute increments). To save your settings, tap OK on the com-
mand bar, or press <Enter> on the keypad.

Device Status Tab

The Device Status tab displays the power usage of active devices.

Figure 2-16. Battery and Power Tabs

Power Properties 7 JOKY X

Battery | Schemes | Device Status | |t 2 Jox] x
Bal | Schemes | Device Status Power Properties 7 JOKY X
500d Good | Power Scheme: || Battery | Schemes | Device Status |
= |{3| ACPower e R e e
3 = s BKL1: High (D0)
NDSO: High (DO0)
) . SDCCF10G1 High (D0)
Total time i Switch sta.be to User Idle:
Remaining power: |After 1 minute |:
| 10

Switch state to System Idle:
| After 5 minutes ~

Switch state to Suspend:
[Never N
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Regional Settings

To change the Regional Settings defaults, select Start > Settings > Control Panel > Regional
Settings.

1. Select your locale from the spin box. See Figure 2-17 on page 2-22.

2. Review the Appearance Samples in the bottom half of the screen. Click Customize
to change the appearance of Number, Currency, Time, and Date.

Figure 2-17. Region and Custom Settings

‘ Number | Currency | Time ﬁl
Decimal symbol: I—LI
No. of decimal places: [2  |v]
Digit grouping symbol: l_zl
No. of digits in group: lﬁ
List separators: [ =]
Negative sign symbol: ] vl
Negative number ]-1.1 vl
Display leading zeros: m
Measurement system: |U.S. |w

3. The options on the Language tab are disabled because the Pegaso will display only
in English.

4. The Input Panel will open to facilitate data input.

Figure 2-18. Language and Input Tabs

Region[Language [input] [Region] Language| Inpu |
User Interface Language: Default Input Language:
! : Select the input language o use
The option wil determine the when you start your device.
language used for the menus, dislogs
and akrts. I

: Installed Input Languages:
|Engish (United States) =l Select input languages you pian to
use.

5. To exit Regional Settings, tap OK on the control bar, or press <Enter> on the keypad.
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Remove Programs

See "Removing Programs” on page 3-7.

Storage Manager

To change the Storage Manager control panel default settings:

1. Select Start > Settings > Control Panel > Storage

Manager. m}
- Store Info:

2. From the Store Info pull-down list, select the -

desired storage device. Capocity: 30.47 MB
Unallocated:  0.00 B

3. You can also format, dismount, and create par- Sector Sze:  512.00 B
titions on storage devices using this control Format | Dismount |
panel. e

New

4. To save and exit the Storage Manager control |
panel, tap OK on the control bar, or press =
<Enter> on the keypad.

& Dismounting or formatting the persistent storage drive will erase all files and programs
stored in Memory.

CAUTION

Stylus Calibration

You might need to recalibrate the touch screen (i.e. when you attempt to select one item
with the stylus, another item is erroneously selected).

To recalibrate the touch screen, complete the following steps:

1. Select Start > Settings > Control Panel > Stylus to open the Stylus Properties dialog as
shown in Figure 2-19 on page 2-24.

2. Adjust Double-Tap sensitivity if needed or desired.

3. Select the Calibration tab to open the Calibration application.
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Figure 2-19. Stylus Properties Control Panel

Stylus Properties n m H
Double-Tap |Cai)ratlon ]

Double-tap this grid to
set the double-tap E
sensitivity for both the

speed and physical

distance between taps.

Double-tap this icon to
test your double-tap
settings. If this icon
doesn't change, adjust
your settings using the
grid above.

4. Tap Recalibrate to open
the Calibration screen
shown to the right

5. Carefully press and
briefly hold stylus on
the center of the target
as the target moves
around the screen or
press <ESC> to cancel
the stylus calibration.

For more information about
the touch-sensitive display,
refer to “Using the Stylus”
and “Navigating the Display”

Stylus Properties ? JOK m
[ Double-Tap| Calbraton |
. If your device isn't
responding properly to your
taps, you may need to
recalibrate your screen.

To start the recalibration process, tap
Recalibrate.

Recalibrate

Carefully press and briefly hold stylus
on the center of the target.
Repeat as the target moves around
the screen,

Press the Esc key to cancel.

.':-.‘)i -’

in the Quick Reference Guide (QRG).
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System Properties

Refer to the System control panel for information related to the system.To view the Sys-
tem properties, select Start > Settings > Control Panel > System Properties.

General Tab

To view the expansion card settings, select Start > Set- | E—_——-_—— ) 7 o]

tings > Control Panel > System Properties > General tab. General | Memory | Device Name | (<] »

System
Microsoft® Windows® CE
Version 5.00 (Build 1400)

Copyright © 2004 Microsoft Corp. Al
rights reserved.

This computer program is protected by
U.S. and international copyright law.

Computer
Processor: ntel Corp., ARM-X
Memory: 23976 KB RAM
Expansion cards: |Broadcorn-802. :I
Registered to:

&Gy || Jrsoran B By

Memory Configuration

RAM Memory Allocation and Usage
Complete the following steps to adjust the Memory

Allocation (RAM Memory): [ General | Memory | Device Name | <]

Move slider to the left for more
memory £o run programs. Move it to

1. Select Start > Settings > Control Panel > System the right for more storage space.
Properties. Only unused RAM (black portion of
the slider bar) can be adjusted.
2. Select the Memory tab. [ T
Storage Program

memory memory
31312KE total 31312KEB total
648KB in use 15284KBin use

3. Move the slider to adjust memory allocation.

4. Tap OK, or <Enter> on the Pegaso.

3|i@'5m. |_|_a‘llp.*.' 4:47 m|@ |%
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Device Name

Your device uses this information to identify itself to
other computers.

Copyrights

Refer to this tab for specific copyright data. As a
user, you are responsible to read this statement.

Volume and Sounds

[Eemyaj Memory! Devi:eNameIﬂ 4 | »
Your device uses this information to
identify itself to other computers.

Device name (without spaces):
|Pegaso

Device description:
[Pegaso

System Properties 7 Jokj x|
Device Name | Copyrights | [«[»

Depending upon which -
[components you are running,

your product may contain the
following third party

technologies:

Portions of this software are
based on NCSA Mosaic. NCSA
Mosaic was developed by the
[National Center for
ISupercomputing Applications at
the University of Ilinois at
Urbana-Champaign. Distributed

=]

To change the Volume and Sound settings, complete the following steps:

1. Select Start > Settings > Control Panel > Volume & Sounds Properties to open the Vol-

ume settings.
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Figure 2-20. Volume and Sounds Control Panels

Volume & Sounds Pro... m m Volume & Sounds Pro... m m
Volume | sounds | [ Vokume | Sounds | .
[ [ Event:
X | > | -
- g 0 une i I'.J | Windows CE -
Soft Loud §¢ asterisk
Enable sounds for: Close Program
E Events (warnings, system events) . '5 Critical Stop
[v] Applications /¢ Default Sound
— : : Empty Recycle Bin
Notifications (alarms, reminders) & Beciarat
[V Key dlicks: : Exclamation =
OcSoft @ Loud Sound: Preview:
[V Screen taps: |(None) =] [ » I = |
Osoft @ Loud e - :
hallad — | Save As |
|Windows CE Default ||
| Delete |

2. Set the volume by adjusting the slider from Soft to Loud.

3. Enable the desired sounds for key clicks, screen taps, notifications, and applica-
tions.

4. Select the Sounds tab to choose from various wave files in the menu.
5. You can listen to the sound by selecting Preview.

6. Save your new sound scheme by selecting Save As and entering a name for your
new Sound Scheme in the field. Delete a sound scheme by tapping Delete.

7. Tap OK when finished modifying your volume and sounds properties.
Wi-FI

Using the Summit Client Utility

The Summit Client Utility (SCU) is an application designed for end users and adminis-
trators of mobile devices that use a Summit radio module. For further information
beyond the scope of this manual, you can download the complete Summit User’s Guide
from www.summitdatacom.com.

Reference the QRG for details about the basic functions of this utility. After completing
an administrator login to the utility, you can perform these additional tasks:

* Create, rename, edit, and delete profiles
*  Alter global settings, which apply to every profile

SCU provides a graphical user interface (GUI) for access to all of its functions. Access to
these functions also is available through an application programming interface (API),
which an application programmer can use to enable another utility to manage the radio.
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To initialize SCU:
1. Go to Start> Settings > Control Panel.

2. Tap on the Wifi icon.

SCU Windows

SCU has five tabs: Main, Profile, Status, Diags (Troubleshooting), and Global Settings.

Tabs enable easy navigation. Each tab is described in more detail in this section.

Main Tab

Reference Figure 2-21 on page 2-28 to view the features of the Main tab.
¢ Enable/Disable Radio: Select or deselect to enable or disable the radio.

* Active Profile: Displays the name of the active configuration profile. An administra-
tor can use the selection list to select a different profile.

* Association Status: Indicates if the radio is associated to an access point and, if not,
what the radio’s status is.

Figure 2-21. Main tab

Main | profile | Status | Diags | Giobal |¢—{—— Taps
SUI}HAMIT Enable/Disable
Active Profie: [Default <—>1— Active Profile
Status: Not Associated «———+—— Association Status
Radio Type:  Non-Summit
Reg. Domain: WorldWide «———————— Regulatory Domain
Driver: vi03.08¢— | .
SCU: v1.03.05 4——— | Software Versions

| About scu |«——+—— About SCU

* Regulatory Domain: Indicates the regulatory domain or domains for which the
radio is configured. “Worldwide” means that the radio can be used in any domain.
The domain cannot be configured by an administrator or user.

e Software Versions: Indicates the version of the device driver and the version of SCU
that are running on the device.

*  About SCU: Supplies information on SCU.

Profile Tab

Profile settings are radio and security settings that are stored in the registry as part of a
configuration profile. When a profile is selected, its settings become active. An adminis-
trator can define, edit, or delete up to 20 profiles in the Profile tab in SCU. Profile
changes made are saved only when the Commit button is pressed.
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Figure 2-22 on page 2-29 is an example of a Profile tab. Here are the highlights:

*  Profile: Use to select the profile to be viewed or edited. If “ThirdPartyConfig” is
selected then, after the device goes through a power cycle, WZC is used for config-
uration of the radio.

* Actions: Four actions are available to an administrator:
- Rename: Give the profile a new name, one that is not assigned to another pro-

file
- Delete: Delete the profile, provided that it is not the active profile

- New: Create a new profile with default settings and give it a name (and then
change settings using other selections on the tab)

- Commit: Ensure that changes to profile settings made on the tab are saved in

the profile

Figure 2-22. Profile tab

| Main | Profie | status | Diags | Global|
Bratie: [Default - Profile

_ New | Rename| pelete| scan #————Actions
Radio:
> NflGes]

Client Name

B S Radio Attributes & Settings
Tx Power El

Encryption: EAP Type: . .

[asower  [=][eap [=]#—— Security Settings

| WEP keys/PSks || Credentials

Save Changes: |  Commit |

3. Radio attribute and setting: Actributes in the list box can be selected individually.
When an attribute is selected, the current setting or an appropriate selection box
with the current setting highlighted appears on the right. For example, selecting
SSID causes an edit box to appear; selecting transmit power causes SCU to display
a drop-down list box with available settings.

4. Security settings: The items at the bottom of the tab enable the administrator to
configure the settings for EAP Type (used for 802.1X authentication) and Encryp-
tion.

To connect a Summit radio to a typical business WLAN, you must select a profile that

specifies the SSID, EAP type, and encryption type supported by the WLAN:
* SSID: The name or identification of the WLAN.

* EAP type: The protocol used to authenticate the device and its user if the WLAN
uses the Enterprise version of Wi-Fi Protected Access (WPA) and WPA2. SCU
supports four EAP types: PEAP with EAP-MSCHAP (PEAP-MSCHAP), PEAP
with EAP-GTC (PEAP-GTC), LEAP, and EAP-FAST
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*  Encryption: Specifies the type of key used to encrypt and decrypt transmitted data

and how that key is specified or derived. Encryption options include:
- WPA2 or WPA with dynamic keys (derived from the EAP authentication pro-

cess)
- WPA2 or WPA with pre-shared keys
- Static WEP keys

Consult the Summit User’s Guide for details on all profile settings, including security
settings.

Status Tab

The Status tab shown in Figure 2-23 on page 2-30 provides status information on the
radio. Status items include IP address and MAC address for the client radio, IP address

and MAC address for the AD, signal strength, channel, transmit power, and data rate. A
sample Status tab is shown in Figure 2-23 on page 2-30.

 Client info: Name of active profile, client name, client IP address, and client MAC
address

¢ AP info: AP name, AP IP address, and AP MAC address
* Connection info: Channel, transmit power, and bit rate

One status item, the radio association state, is shown on both the Status tab and the
Main tab. Potential values are: Down (not recognized), Not Associated, Associated, or

[EAP type] Authenticated.

Figure 2-23. Status tab

| Main | Profie | Status | Diags | Global|

Profile: Default

. Status: Not Associated
Client —— | Device Name: [Unnamed]
1P: ————

MAC: 00.0b.6b.1c.dc.01
APinfo ——— »| AP Name: [Unknown]

3DC

Beacon Period: - DTIM: —-
Connection = ————»| Connection Channel: —

Bit Rate: - Mbps Tx Power: 50 mW
| Signal Strength: — dBm

| Signal Quality: —- %
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Diags Tab

A sample Diags, or troubleshooting, tab is shown in Figure 2-24 on page 2-31.

Figure 2-24. Diags tab, with ping active

summit Client utiity [ [ B3

| Main | Profie | status | Diags | Global|
Profile: Default
1P Address: -——.-—,—.—

3DC

| (Re)connect | | Releasef/Renew |

[ startpmng | | <« Ping address

 Diagnostics | | Save To... |

*—Diagnostics OQutput—*

<«—+t— Ping results

Here are the functions available on the Diags tab:

(Re)connect: Disable and enable the radio, apply or reapply the current profile, and
attempt to associate and authenticate to the wireless LAN, logging all activity in
the output area at the bottom.

Release/Renew: Obtain a new IP address through DHCP release/renew, and log all
activity in the output area at the bottom.

Start Ping: Start a continuous ping to the address in the edit box next to it. Once
the button is clicked, its name and function will change to Stop Ping. Leaving the
Diags tab also will stop the ping, as will pressing any other button on the screen.

Diagnostics: Attempt to (re)connect to an AL, and provide a more thorough dump
of data than is obtained with (Re)connect. The dump will include radio state, pro-

file settings, global settings, and a BSSID list of APs in the area.
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Global Settings Tab

Global settings include:

* Radio and security settings that apply to all profiles

*  Settings that apply to SCU itself
An administrator can define and change most global settings on the Global Settings tab
in SCU. Figure 2-25 shows a sample Global Settings tab.

Figure 2-25. Global Settings

summit Client utiity [ [ B2

[ Main | Profie | Status | Diags| Giobal |

Property: Value: SDC
Roam. Triqger...ia | |-70 dém v
Roam Delta

Roam Period

BG Channel Set ) )
Aggressive Scan Changing this
CCX features setting wil
WMM reqduere a power-
TX Diversity cyoe.

DV Minsnrcite E

The default setting for each global setting ensures reliable operation in most environ-
ments. Consult the user’s guide for details on all global settings.
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Chapter 3
Software Applications

Overview

This section contains the following topics:

* "Inbox" starting on page 3-2.

* "Internet Explorer" starting on page 3-2.
*  "Media Player" on page 3-3.

*  "WordPad" starting on page 3-3.

*  "Persistent Memory" starting on page 3-4

* "Installing Programs” starting on page 3-5.

* "Using an Installation Wizard" starting on page 3-6.

"Installing Programs Manually" on page 3-6.

"Using Windows Explorer to Add to the Start Menu" on page 3-7.

"Using ActiveSync to Add to the Start Menu" on page 3-7.
* "Removing Programs" starting on page 3-7.

* "Datalogic Firmware Utility" on page 3-8.
* "Retrieving a Firmware Image Update" on page 3-8.
* "Installing DFU on the Host PC" on page 3-8.
* "Updating the Pegaso Firmware" on page 3-9.

* "Restoring Pegaso Firmware" on page 3-10.
* "Datalogic Configuration Utility" on page 3-12

*  "AutoStart" on page 3-12.
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Inbox

The Pegaso comes with Inbox for Windows CE installed from the factory. Inbox is a

familiar Microsoft email interface. To set up your Inbox:

1.

2.

10.

Open Inbox by selecting Start > Programs > Inbox.

Select Services > Options from the command bar
to configure email.

Drag the screen to show Add.... Select Add....

Select the Service Type and type the email service
name in the Service Name text box. Select OK.

Enter the server and user information in the Mail
Service Definition.

Configure your inbox using the Mail General Pref-
erences dialog.

Fle Zoom ook He i
[Ele Compose servic|# 2| x|
D Activesync [=1 | From Subject

&7 Deleted

I 3 1 X | 0
|Inbox 0 Ttems. [e8%

Configure your mail retrieval settings in the Mail Inbox Preferences.

Tap OK to complete the Inbox configuration.

Select Services > Connect from the command bar.

Select Services > Send/Receive Mail from the command bar to manually retrieve
mail. Pending email appears in the inbox after connecting.

Internet Explorer

The Pegaso comes with Internet Explorer for Windows
CE installed.

1.

Open Internet Explorer by selecting Start > Pro-
grams > Internet Explorer.

To set a default home page, navigate to the
desired default web page.

Select View > Internet Options from the com-
mand bar.

Enter the desired URL in the Start Page field.

. Tap OK.

ee2[o[E[ala]  [X]

[I]Addressl http://www.datalogic.com/ | =

SOATALOG

SCANNING § MOBILE  AUTOMATION

HOME OURCOMPANY BUSINESSD

RORECIALRNEIS]

e e
HENEWIDATAUOGIG]

KT - LIE
[ [[[ @memer |

-

Internet Explorer window with the
Status bar and View menu.
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Media Player

Internet Explorer uses sliding menus for application
and navigation control. Tap and drag the sliding
menus to the left or right to see the hidden menu
items and toolbars.

To achieve more screen real estate in Internet
Explorer, you can hide the Status bar and View menu.
From the top menubar, go to View > Hide Toolbars.

Once it is hidden, you must reset the Pegaso to
access these features again. Refer to the Pegaso Quick
Reference Guide (QRG) for reset instructions.

For more control over the way Internet Explorer is
displayed, refer to "Datalogic® Desktop Utility for
Windows® CE", starting on page B-1

Media Player

The Pegaso comes with Media Player for Windows CE
installed.

1. Open Media Player by selecting Start > Programs >
Media Player.

2. Select File > Open to open an available existing
media file.

3. Please refer to www.microsoft.com for additional
information and help with your Microsoft Win-
dows Media Player.

WordPad

The Pegaso comes with WordPad for Windows CE
installed from the factory. The following text and doc-
ument file types are compatible with WordPad:

e Text (*.txt)
¢ Word Document (*.doc)
e Rich Text File (* . xtf)

*  WordPad (*
When file types other than * . pwd are transferred to

the device, Windows CE translates the files into a
compressed file type.

.pwd)

To start WordPad, select Start > Programs > Microsoft
WordPad.

COATALOG

SCAHHING § MOBILE : AUTOMATION

HOME OURCOMPANY BUSINESSD

SREGIAIYNEWVS]

THEINEVWIDATAUOGIC]

April 2nd marks the beginning of a new Gr
focus and market focus:

Datalogic Scanning, Datalogic Mobile,
The objective: To develop a new framework
scope - a winning factor that creates comp

4 | o

-

Internet Explorer window with the
Status bar and View menu hidden.

[ o B ] 4] X

[Fle Edit view For @ 2| x|
This is a Microsoft Word Pad text file
test.

This information can be typed on the
Pegaso using the soft input panel
or the keypad.

kscl1[2[3]4[5]6]7[8[0[0]-]=]«
Tabla[w]e IrItIvIuIIIol ' [.11
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Persistent Memory

In addition to the RAM-based storage standard on Windows CE terminals, the Pegaso
is also equipped with a persistent storage application and file storage area.

The persistent storage memory persists across all reset (warm/cold reboot) conditions

= and software/firmware updates.

1 | Because of this, Datalogic very strongly recommends installing all applications, applets,
programs, and important data files to the persistent disk of the Pegaso.

If an application or a data file is only installed or saved in RAM, a hard reset may result in
the loss of that application or data file.

CAUTION

Saving to Persistent Memory

To save an application or data to the persistent memory, from your current application
select File > Save As > and navigate to the location as described below.

Location

To access the contents of Persistent Memory:
1. Double-tap the My Device icon on the desktop.

2. Double-tap the FlashDisk icon to view.

Figure 3-1. Location of the FlashDisk

) >\/—\———

vl ) =
evice e er
. . Application  FlashDisk My
Data Documents
Z W 3 . .
Y U U
P
Mordad Network profiles Program
e .
S’] | ﬂ"/ - " Files
[Inbox| My ' '
Documents ,./ _,/ "
@ Temp Windows  Control
e Panel
Internet g
Explorer =
Fod | 2ap 12:14“!!?|% :ﬂ’llgﬂyb J_-).p*b S:BP‘N|@
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Disk Size

The size of the persistent storage disk will vary, depending upon several factors, such as
the size and number of currently running applications and the amount of memory cur-
rently consumed by the OS.

To view the current size of flash memory:

1. Double-tap the My Device icon on the desktop. (See Figure 3-1).

2. DPress and hold the FlashDisk directory with the stylus, and select Properties from
the pop-up menu.

3. The FlashDisk Properties dialog opens. The number following Free is the amount

of memory currently available on the Pegaso.

[Ele Edit view Go| | 7] Xx]

NFeT» 1ml XTe] e -l

Table 3-1. Persistent Memory Specifications

\ [ -
Open = [
Network
Cut nts
Copy
-y
Delete s
m Temp.
Rename P -
Properties ﬁ;‘?)
" eidows  Control
Panel

-

Properties |

Lme=®  FlashDisk

Type: Folder

Location: My Device

Used: 191KB (195,584 bytes)
Free: 85.7MB (89,905,664

Persistent Memory Specifications

Total Flash size 128 MB
OS/Firmware uses 32 MB
FlashDisk size 96 MB

Installing Programs

Programs pre-installed on the Pegaso are stored in ROM (read-only memory). You can-
not remove or modify this software.

You may add programs and data files to RAM (random access memory) or into persis-

tent storage memory via the persistent storage disk. You can install *. cab, *.exe
* . zip files, or other files designed for the Pegaso.

Please follow the directions provided with the software to install it.

Product Reference Guide

3-5



Using an Installation Wizard

If the file has an installer, the installation wizard begins automatically if you have Active-
Sync installed. Most installation programs require an ActiveSync connection. (Refer to
"Installing & Setting Up Microsoft ActiveSync" on page 4-1.)

Installing Programs Manually

Utility (DFU) or Wavelink Avalanchee.

‘ rm[r To quickly install programs on multiple Pegasos, use the Datalogic Firmware

Follow the directions on the screen. Once the software is installed on your desktop com-
puter, the installer transfers the software to your Pegaso.

If the file does not contain an installer, an error mes-
sage indicates the program is valid but is designed
for a different type of computer.

Start by downloading the program to your desktop

K ) ) ntel Corp., ARM-X
computer (or insert the CD or disk that contains METOr ST
the program into your desktop computer). Expansion cards: | Broadcom-802. [+

Registered to:

1.

General | wemory | Device Name | (1>
System
Microsoft® Windows® CE
Version 5.00 (Buid 1400)

Copyright © 2004 Microsoft Corp. All

i feat ; rights reserved.
Many Windows CE applications will also This computer program is protected by

work on the Pegaso. epqational copyright law.

Install * . cab, *.exe *.zip, setup.exe
files, or other files designed for the Pegaso.

|V ————

Select Start > Settings > Control Panel > System >
General on the Pegaso. Make a note of the
information in the Processor field as shown at right. The processor type is required
to determine file type compatibility.

Many programs provide installation instructions. Read the installation instruc-
tions such as ReadMe files or a manual that may have come with the program.

* If you cannot find installation instructions for the program in the ReadMe file
or manual, use ActiveSync Explore to copy the program file to the Program
Files folder on your Pegaso.

* For more information on copying files using ActiveSync, refer to the ActiveSync
online Help.

Connect your Pegaso and desktop computer. Refer to "Networks, Communica-
tions, and Connections", starting on page 4-1 to connect your Pegaso with your
PC.

Double-click the * . exe or *. cab file.

Once the installation is complete, double-tap the program icon from the desktop,
or select Programs > and tap the program icon to select it.

Refer to "Using ActiveSync to Add to the Start Menu" on page 3-7.
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Removing Programs

Using Windows Explorer to Add to the Start Menu

1. Select Start > Programs > Windows Explorer, and select the directory where the appli-
cation or program is stored.

2. Select Cut from the Edit menu.

3. Open the Programs folder located in the Windows folder, select Paste from the
pop-up menu.

The program appears on the menu.

Using ActiveSync to Add to the Start Menu

1. Use the Explorer in ActiveSync on your desktop computer to explore the files on
your Pegaso and locate the program. For more information on using ActiveSync,
refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1, or see the
ActiveSync online help on your unit.

2. Right-click on the program, then select Create Shortcut.

Move the shortcut to the Programs folder in the Windows folder. The shortcut
appears on the menu.

Removing Programs
Only user-installed programs can be removed.

Remove Programs ]

1. To remove a program, select Start > Settings > Con- .
To remove a program, select it and
trol Panel > Remove Programs. then press Remave.

2. Select the program you wish to remove from the
list and tap Remove.

Remove.
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Datalogic Firmware Utility

The Pegaso is equipped with a field upgradeable firmware mechanism. Firmware
updates for the Pegaso are available on the Datalogic Mobile website (www.mobile.data-
logic.com). After you have downloaded the desired update, there are several ways you
can update the firmware on the Pegaso.

*  Use Wavelink Avalanchee if you have multiple Datalogic mobile devices to
update. Refer to the Product CD included with your device for more information.

e If Wavelink Avalanche® is not available or you have only a few Datalogic Mobile
devices to update, use the Datalogic Firmware Utility (DFU), described below, to
install or update the firmware using an ActiveSync connection. Refer to "Installing
& Setting Up Microsoft ActiveSync" on page 4-1 for more information.

DFU can also be used to restore the firmware onto a Pegaso that has become corrupted,
such as would happen if the Pegaso were powered down during an ActiveSync firmware
update. See "Restoring Pegaso Firmware" on page 3-10.

The following sections provide procedures for the retrieval and installation of the most
current firmware image onto a Pegaso.

Retrieving a Firmware Image Update

The following instructions use Internet Explorer to retrieve the most current firmware
image.

1. Launch Internet Explorer on your PC and navigate to the Datalogic Mobile web-
site.

2. Navigate to the Downloads section of the website.

3. Select the file you want to download, then click Save to begin copying the files to
your local machine (or local network location).

Installing DFU on the Host PC

The Datalogic Firmware Utility (DFU) provides administrators with a field upgrade
mechanism. You must have Microsoft® ActiveSync already loaded and running on the
host PC to use DFU. Refer to "Installing & Setting Up Microsoft ActiveSync" on
page 4-1 and "Using ActiveSync" on page 4-6 for more information about ActiveSync.

orel# Prior to installing, you must remove any previous versions of DFU installed on
||/ thehostpc.

To install the Datalogic Firmware Utility, complete the following steps on the PC:

1. Insert the CD ROM shipped with your Pegaso and click on the link to Datalogic
Firmware Utility.

3-8 Pegaso™ Industrial PDA with Windows® CE


http://www.mobile.datalogic.com
http://www.mobile.datalogic.com

Datalogic Firmware Utility

OR

Go to the Datalogic Mobile website and download the most current version of the
Datalogic Firmware Utility. Unzip the file, then double-click to run
DFU_Setup.exe

Click OK to continue once you have removed previous versions of DFU.
2. The Welcome to DFU Setup Program screen opens.

* Please exit all Windows applications before running this setup.

* Click Cancel to quit Setup and close any programs you have running.

* Click Next to continue the Setup.

3. Follow the onscreen instructions to complete the installation.

Updating the Pegaso Firmware

After copying the firmware image to the host PC ("Retrieving a Firmware Image
Update" on page 3-8) and installing DFU (see "Installing DFU on the Host PC" on

page 3-8), you can upgrade the firmware on your Pegaso.

- The following steps require that you have already established an ActiveSync
‘ / connection between the host computer and the Pegaso. To establish an
I ActiveSync connection with the Pegaso, refer to "Installing & Setting Up
Microsoft ActiveSync" on page 4-1 and "Using ActiveSync" on page 4-6, for

more information on ActiveSync.

1. Go to Start > Programs > DFU > Datalogic Firmware Utility.

2. Verify that ActiveSync is selected by clicking Communications > ActiveSync.

3. Click browse (...) and navigate to the location where you saved the firmware file for
your terminal.

hory =
File Communications Help
Firmware Image ta Install Firmware Image in Device
Modet: Pegaso Modet:
05 Type: windows CE 05 Type:
Wersion: 3.00.048 Test 03 Wersion:
Language: ‘Western European Language:
Keyboard: 19-Key Keyboard:
C:AData\Projects\Wwavelinkink img |E] I Query Device
Status:
Terminate Actior: Reboot | Update
Patch Condition: IF Mewer =
Werbose: False Block Progress:
ActiveSync: Mot connected ]
ActiveSonc: Connected
C:AD ata\Projectsiw avelinksnk.img Total Progress:
Load image file: Success [ | [ ]

4. Select the current *. img file and click Open.
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5. Verify that the Pegaso is turned on. Insert the device into a powered dock con-
nected to the host computer.

6. Click Update on DFU on the host PC to begin the update process.

7. DFU will compare the selected firmware image with the firmware already loaded on
the Pegaso; if the images are different, DFU will proceed to update the firmware
image on your Pegaso.

. Please be patient and do not remove the Pegaso from the Dock during this proce-
‘ ¢ dure. The firmware image of the Pegaso can take as long as:

* 12 minutes to download using a USB connection.
» 22 minutes to download using a serial connection with 115K baud rate.
» 130 minutes to download using a serial connection with 19.2K baud rate.

8. After the firmware of your Pegaso has been updated, you must perform a warm
reset of the Pegaso. Refer to the Pegaso Quick Reference Guide (QRG) for reset

instructions.

Restoring Pegaso Firmware

If the firmware image on the Pegaso becomes corrupted, the unit will beep twice and
show a blank screen when powered on. This can happen if a firmware update is aborted,
such as during a power loss or if the Pegaso is removed from the Dock before comple-
tion of the procedure.

To reinstall the firmware, complete the following steps:
1. On the PC, click Start > Programs > DFU > Datalogic Firmware Utility.

2. From the Communications menu, select the communication mode you are using to
attach your dock to the PC (USB or Serial).

[ pFy PEX]

Eile: Compuumiest I Help

v | ActiveSync
i = Firmware Image in Device
USE  (Repair mode) _
_I:r Serial (Repair mode) Ej/ <Select Ports [P Pegaso
05 Type: W <Select Parts Windows CE
. Ciomi
“ersion: 3.00.048 Test 09 coMz 3.00.048 Test 09

Language: ‘wiestemn European Language: ‘whestern European
Keyboard: 19-Key Keyboard: 19-Key
C:AD atahProjectsiw avelink \nk.img ‘ [I] I Query Device ]

Status:
ActiveSync: Connected |
U_Dg:lat\ng image..
Finished Block Progress:
Update Time: 00:00:04 [ I
ActiveSyne: Not connected =
ActiveSync: Connected = | Total Progress:
Ouery Device: Success [wel l I

3. If you are using Serial, DFU will display the COM ports available on your PC.
Select the specific COM port to which the dock is connected.

4. Click browse (...) to navigate to the file location.
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Datalogic Firmware Utility

i DFU =

File Communications Help

Firmware Image ta Install Firmware Image in Device

Madel: Pegasa Madel:

05 Type: ‘Windows CE 05 Type:

Yersion: 3.00.043 Test 09 “ersion:

Language: ‘western European Language:

K.eyboard: 19-Key Feyboard:

C:ADatahProjectziw avelink \nk img |E] [ Query Device
Shatus:

Terminate Action: Feboat »

Patch Conditior: |f Mewer

“Werboze: Falze Block Progress:

ActiveSyne: Mot connected
ActiveSync: Connected

C:\Data\Proiecls\Wave;jnk\nK.img Total Progress:

Load image file: Succes: | [

5. Select the current *. img file and click Open.

6. Verify that the Pegaso is turned on. Insert the Pegaso into a powered dock con-

nected to the host computer.
7. Click Update on DFU on the host PC.

8. DFU will restore the firmware on the Pegaso.

Please be patient and do not remove the Pegaso from the Dock during this proce-
‘ dure. The firmware image of the Pegaso can take as long as:

* 12 minutes to download using a USB connection.
* 22 minutes to download using a serial connection with 115K baud rate.
» 130 minutes to download using a serial connection with 19.2K baud rate.

9. After the firmware has been restored, the Pegaso will automatically reset.
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Datalogic Configuration Utility

Datalogic Configuration Utility (DCU) is a Datalogic Windows-based utility tool
allowing the uploading, modifying and downloading of a Datalogic brand Windows CE
device. Configuration settings include Scanner, Control Panel, and Datalogic Desktop
Utility (DDU). The DCU installer is available on the product CD which came with

your device or from the Datalogic Mobile web page (www.datalogic.mobile.com).

DCU functions in both direct (with an ActiveSync connection) and indirect (with
Wavelink Avalanche™) modes.

In direct mode, connect a device through ActiveSync (follow the ActiveSync connection
procedure in "Setting Up ActiveSync" starting on page 4-2), and then click on the Get
from Device icon to receive the device’s current configuration.

Once loaded, the Configuration Tree (on the left side of the window) is used to navigate
the device’s configuration. The right side of the window is a work area where the values
of different parameters may be set for each branch of the configuration tree. Click on

the parameter group branch to open it and visualize the parameters you wish to modify.

After altering the device’s configuration, the new configuration can be sent to the termi-
nal by clicking on the Send to Device icon .

Reference the Wavelink Avalanche™ documentation on your Datalogic CD for a
description of indirect mode for DCU, which will allow you to update the configura-
tion of multiple devices simultaneously over Wi-Fi.

AutoStart

The AutoStart program provides three functions:

*  Allows you to create a list of applications (with optional command line arguments)
to run automatically prior to loading CAB files.

* Automatically reinstalls specified CAB files when the Pegaso is Hard Reset.

*  Allows you to create a list of applications (with optional command line arguments)
to run automatically after loading CAB files.

AutoStart launches each time the Pegaso is rebooted. AutoStart first runs

PreAuto. ini (reference Table 3-3 for the location), executing each line with the spec-
ified command line arguments. It will take into account any AutoStart options at the
begining of the line.

Upon a Cold Reset, AutoStart installs all the CAB files located in the AutoStart CAB
folder. If the AutoStart CAB folder does not exist, no CAB files will be installed.
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AutoStart

Table 3-2. AutoStart CAB folder location

Product Operating System Location
Pegaso Windows CE \FlashFX Disk
g Windows Mobile \FlashDisk

AutoStart will then run the Autostart. ini (reference Table 3-3 for the location),
executing each line with the specified command line arguments. It will take into
account any AutoStart options at the beginning of the line.

Table 3-3. PreAuto.ini and Autostart.ini location

Product Operating System Location
Pegaso Windows CE \FlashFX Disk
g Windows Mobile \FlashDisk

Installing CAB files

Copy any CAB files you want to install into the AutoStart CAB folder. These CAB files
will then be automatically installed in alphabetical order the next time you start the
device.

How AutoStart Uses Wceload

orelw If you intend to create highly interactive installers, you should either install the CABs manually or
‘ 7 review the section on “Interactive CAB Install” in this chapter.

& In certain environments, CAB files will be deleted after execution. To prevent the CAB file from
being deleted, write protect the file before copying the file onto the device.
CAUTION

CAB files are installed by AutoStart using the Weeload.exe application. Table 3-4 on
page 3-13 shows available command line options:

Table 3-4. AutoStart command line options

Option Description

Specifies that you will not be prompted for any input during the instal-
lation. If the CAB file is signed, any responses will automatically be

noui answered ‘Yes. If the CAB is unsigned, then any responses will be
answered ‘No’
[silent Suppresses dialog boxes during the installation.

Please refer to the Microsoft documentation on your device for further details on Wee-
load.exe.

Sample:

\Windows\Wceload.exe /delete 1 /noui /silent “\Flash-
Disk\CAB\<cab file>"
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Interactive CAB Install

If the CAB installer requires user interaction that must be performed during the
AutoStart CAB installation process, you can specify a special file name to disable the
silent mode installation. If this mode is specified, the CAB file will be installed with
Wceload without any command line arguments specified.

An example of what AutoStart would execute is: \Windows\Wceload.exe <cab
file>

>

To force this mode of installation via AutoStart, rename the CAB file to include a *_
character before the “. cab” extension of the file.
Example:

“File.cab” should be renamed “File_.cab” to force AutoStart to not install the
CAB in silent mode. This specially-named CAB file should be placed in the AutoStart
folder with other CAB files intended for installation on the next reboot.

Autostart.ini

4

LS S|

74

ol J

Autoexec.ini, which uses AutoCE on some older models, has been deprecated. These
files should be renamed to Autostart.ini and reformatted as described in "AutoStart" on
page 3-12.

In the following section, all references to AutoStart.ini also pertain to PreAuto.ini.

Autostart.ini and PreAuto.ini are text files that AutoStart will run upon star-
tup of the Pegaso, and after any CAB files are installed. This file should be placed in the
AutoStart folder. AutoStart will run the Autostart. ini file on each reboot of the
device.

Line Formatting

Each line of the Autostart. ini can consist of Autostart options, an executable, and
any command line arguments.

< Autostart option(s)> <full path to executable> <command line
arguments>

Sample: - \windows\pword.exe \file.doc
Table 3-5 breaks down the sample Autostart.ini line.
Table 3-5. Autostart.ini line formatting

Autostart option(s) Full path to executable Command line arguments
- \windows\pword.exe \file.doc

Spaces must be placed between each component of the line in the Autostart.ini.

If the executable path is in a folder that contains spaces in the name, quotes are required
to distinguish what the actual executable name is. The following is an example of this:

“\Program Files\ScannerApp.exe” /run (valid)
\Program Files\ScannerApp.exe /run (invalid)

The second line is an invalid line because there is no way to distinguish the executable
from the argument.
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AutoStart

AutoStart Options

Table 3-6 shows options you can use when writing a line in the Autostart.ini or
PreAuto. ini file.

Table 3-6. Options for Autostart.ini and PreAuto.ini
Description Character Comments

This may only be used as the
first character of the line. If the
comment option is specified in
the options elsewhere, it is
ignored.

Comment: This line will notbe |‘#’ OR
executed. (space)

Do not wait on line completion:
This will cause the line to exe-
cute and immediately move
onto the next line.

This will halt parsing the

Query: Request user confirma- Autostart.ini until the confirma-
tion when running the execut- | ‘2’ tion is answered. This is
able. intended for debugging the

Autostart.ini file.

Execute only on Cold Reset I

Cold Reset Only: This will cause the line to execute only after a Cold Reset.

‘ ?"”‘:? An empty line will be treated as a comment line.

Combining Options

Autostart options can be combined together as shown in the following sample:
?- \Windows\Pword.exe

This line would:

*  Request confirmation before executing the line. The next line would not be pro-
cessed before the confirmation is answered.

* Run the next line without waiting on the current line to complete execution.

Query Option

The query option is intended for use when debugging the autostart.ini. When a
line with this option is executed, the following dialog will appear with the specified exe-
cutable and command line arguments. The populated fields shown in the AutoStart

Execute Query are described in Table 3-7 on page 3-16.
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AutoStart Execute Query

AutoStart Execute Query

(1)Execute the following:
Exe:(Pword.exe)

Args:("\My
Documents\fie.doc")

Yes No

Cancel

Table 3-7. AutoStart Query options

Line Number This

is the line number in the script being executed.

Exe The

executable as parsed by AutoStart.

Args The

argument as parsed by AutoStart.

orelp The fields may be broken up into
Il space in the dialog.
Parentheses are used to

the field is.
Table 3-8 describes the

multiple lines (as shown in the example) due to limited

surround the given field and make it very clear what the value of

results of each choice:

Table 3-8. AutoStart Query actions

Yes The current line will execute.

No

The current line will not execute. AutoStart will continue pars-
ing the Autostart.ini.

Cancel

The current line will not execute and AutoStart will discon-
tinue parsing the Autostart.ini.

Autostart.ini Sam

ples

Table 3-9 on page 3-16 is a collection of sample Autostart.ini lines.

Table 3-9. Sample Autostart.ini lines

? \windows\wceload.exe “\My
Documents\Sample.cab”

This will confirm the execution of \Windows\wceload. exe with
specified argument *\My Documents\Sample.cab”

\Program Files\App.exe

(invalid) This will execute \Program with the argument
Files\App.exe.

\Program Files\App.exe /run

(invalid) This will execute \Program with the argument
Files\App.exe /run.

“\Program Files\App.exe” /
run

This will execute the program \Program Files\App .exe Wwith the
argument /run.

?- \Windows\Pword.exe

This will confirm the execution of \Windows\Pword. exe. If the exe-
cution is confirmed, AutoStart will immediately process the next line.

I"\Program Files\App.exe” /run

This will execute the program \Program Files\App .exe Wwith the
argument /run ONLY after a Cold Reset.
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Chapter 4
Networks, Communications, and
Connections

Overview

Microsoft Windows Vista® does not support ActiveSync. Windows Vista users, please refer to
‘ _ Microsoft’s documentation for “Windows Mobile Device Center.”

This section contains the following topics:

* "Installing & Setting Up Microsoft ActiveSync" starting on page 4-1.
* "Installing Microsoft ActiveSync" on page 4-2.
* "Setting up ActiveSync" on page 4-2.

* "Installing the USB Driver" on page 4-3.

*  "Using ActiveSync" starting on page 4-4.

*  "Networking" starting on page 4-7.
* "Setting up the Network ID" starting on page 4-7.
* "Network and Dialup Connections" starting on page 4-7.
* "Network Setup: Remote ActiveSync" starting on page 4-8.

e "SNMP" starting on page 4-8.

Installing & Setting Up Microsoft ActiveSync

— Windows Vista® uses a different mechanism (interface) to talk with mobile devices. ActiveSync
1 ; is not supported in Windows Vista.

This section provides instructions on setting up the Host PC so that the PC can com-
municate with the Pegaso and the dock.
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Networks, Communications, and Connections

The screen shots in the manual were taken and the procedures were written using Win-

dows® XP. If you are using a different Windows operating system, appearances and pro-

cedures may be slightly different.
OTE

l ' Important! You must disconnect any other PDAs, PDTs, or Pegasos using USB Active-
Sync from the Host PC prior to connecting the Pegaso or the Host PC and Microsoft
ActiveSync may not recognize the new device.

Installing Microsoft ActiveSync

Microsoft® ActiveSync is a file transfer tool used to synchronize the files on a PC with
the files on your Pegaso. The device comes from the factory with ActiveSync loaded. If
you have ActiveSync already installed on your PC, make sure that you have v3.7.1 or

higher.

To install Microsoft® ActiveSync on the PC, complete the following steps:

1. Download the current version of ActiveSync from the Microsoft website at:
http://www.microsoft.com/downloads/.

2. Install ActiveSync on your host PC. Follow the on-screen instructions to complete
the installation.

3. Reboot your PC.

4. You have completed installing ActiveSync.

Setting up ActiveSync
1. Open ActiveSync from the Host PC.
2. Connect the Pegaso to the Host PC via a dock or USB/Serial cable.
3. Verify that the Pegaso is turned on.

4. Within a minute, the ActiveSync window should appear, attempting to connect to
a new device.

Figure 4-1. Microsoft ActiveSync dialog

o el

File View Tools Help

® 0 B 8 B

Sync Stop | Details Explore Options

Pegaso
Connected

Synchronized
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Installing the USB Driver

5. If ActiveSync does not connect within two minutes, try the following:

* Double-click and open ActiveSync from the Host PC’s System Tray if it is not
already open.

* Remove the Pegaso from the dock and then reinsert it into the dock or discon-
nect the cable from the Host PC and reconnect it.

* Select File > Get Connected for ActiveSync to look for a mobile device.

* Go to File > Connection Settings and make sure that your Connection Settings
dialog show the same selections as that in Figure 4-2 below if you have a USB
connection. If you have a serial connection, select the correct COM port from
the pull-down list.

Figure 4-2. Connection Settings
X

o Click Get Connected to connect your mobile device to
>  this computer.

Status Device connected Get Connected...

[~ Allow serial cable or infrared connection to this COM port:

[com =

Status  COM port is not available

[¥ Allow USB connection with this desktop computer.
Status Connected

[ Allow network [Ethernet] and Remote Access Service (RAS)
server connection with this desktop computer.

Status  Network connections are disabled

~ Status icon

[+ Show status icon in Taskbar.

0K ‘ Cancel | Help |

6. You have completed setting up ActiveSync. Proceed to "Installing the USB
Driver", below, to install the USB driver.

Installing the USB Driver

In order for the Host PC to communicate with the Pegaso, you must install the USB
driver file from the CD that came with the Pegaso, or download it from the Datalogic
website at www.mobile.datalogic.com.
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Networks, Communications, and Connections

orel» Microsoft ActiveSync must be installed on your computer before proceeding. See "Set-
‘ 7 ting up ActiveSync" on page 4-2.

Important! Install the USB driver PRIOR to connecting the Pegaso to the host PC.

1. Copy the USB driver file (Datalogic ActiveSync inf file for Windows CE
USB) from your Datalogic CD or the Datalogic website to the following location
on your computer:

C:\Program Files\Microsoft ActiveSync\Drivers.

2. Connect the USB or Serial cable to Pegaso or place the unit in the dock.
3. Connect the USB or Serial cable to a Host PC.

4. Follow the directions onscreen. The specified source directory will be the one
identified in step 1.

5. You are now ready to use ActiveSync.

Using ActiveSync

Use ActiveSync to transfer and synchronize (share) files between the Pegaso and the
Host PC.

orel» Important! You must disconnect any other PDAs, PDTs, or Pegasos using USB Active-
‘ ~ Sync from the Host PC prior to connecting the Pegaso, or the Host PC and Microsoft
ActiveSync may not recognize the new device.

Setting up a Partnership

During the Microsoft ActiveSync installation, you were prompted to create a partner-
ship with your mobile device. When you set up a partnership, you select synchroniza-
tion and file conversion settings, which are contained in a file on your desktop
computer. This file enables your desktop computer to recognize your device. Only
devices that have a partnership with a desktop computer can synchronize information
between the two computers.

Partnerships are stored in ActiveSync and have the same name as the corresponding
device. Your desktop computer can set up partnerships with many different mobile
devices, but the Pegaso can have partnerships with only two computers. For more infor-
mation on partnerships, please refer to your Microsoft ActiveSync documentation or

help file.

Transferring Files

To transfer files, complete the following steps on the host PC:

1. Select Start > Programs > Microsoft ActiveSync.
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Using ActiveSync

2. Double-click on the ActiveSync icon in the System Tool Tray.

3. After you have established a connection with your Pegaso, tap Explore at the top of
the ActiveSync window (or select Explore from the File menu). Refer to Figure 4-3
on page 4-5.

Figure 4-3. ActiveSync Dialog
@ Microsoft Activesyne LT NN ol

File View Tools Help

® © | B 8 B
Options

Sync Stop | Details Explore

Pegaso

Connected
Synchronized

4. Navigate to the target directory (folder) on your portable.

Figure 4-4. Exploring the Mobile Device

=1oix]
Fle Edt Vew Favortes Took Help | A

.\_;] Back \_‘,) - ?‘ | /?}m ‘.‘___' Folders |,.
address | [ mobile Device

|«

Folders % | Name = | size | Type | Modified
= E} Control Panel :I myCDmpu‘tet System Folder
B @Inbox 21 bytes  Shortcut 6/1/1999 5:00:01 AM
E+_‘ E’Elntwm Explorer 24 bytes  Shortcut 6/1/1999 S:00:00 AM
+ & .gg]Meda Player 15 bytes  Shortcut 6171999 S5:00:01 AM
= .3 ::(I::tew;rnk Places B Microsoft WordPad 21 bytes  Shorteut 6/1/1999 5:00:01 AM
J | = 1 52)My Documents 18 bytes Sharteut 6/1/1999 5:00:01 AM

5. Copy the desired file by using the Copy/Paste method or dragging and dropping
the desired file(s) into the directory (folder).

Depending on the file type, ActiveSync may convert the file into a format appropriate
for the Windows CE device.
File Synchronizing using ActiveSync

ActiveSync file synchronization requires an ActiveSync partnership between the Pegaso
and the Host PC. Refer to "Setting up a Partnership" on page 4-4.

1. Select the controls in the synchronization configuration for the Pegaso partner-
ship. Refer to Figure 4-5 on page 4-6.

2. Select Tools > Options from the ActiveSync command bar to configure the synchro-
nization options.
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Figure 4-5. File Synchronization Options
x|

Sync Options | Sync Mode | Rules |

@"; To synchronize a particular type of information, select its check
4 5 box Tostop synchronization of that information, clear its check
= box

al

Mobile Device ] Desktop Computer

[ B inbox

I Tasks

L™ paly Record
LIEIFC Task

[] %) Channels
[I% JPocket Access

Microsoft Outiook
Microsoft Dutlook
FranklinCovey PlanPlus
FranklinCovey PlarPlus
Channel Synchionization
Microsoft Databases

Synchionized Files

To find out more about and to customize what gets
synchrorized, click on that information type in the list
and then click S ettings.

Settings... |

¥ Synchronize mobile device clock upon connecting.

[ ok ]

Cancel I

3. DPlace the file to be synchronized in the Synchronization folder created in your
My Documents directory (defaults to the desktop). Refer to Figure 4-4 on page

4-5.

During the ActiveSync connection, all files in the Synchronization folder will be
synchronized with (copied to) the \My Documents directory on the Pegaso.

Figure 4-6. Select Synchronization Settings

Select Synchronization Sellings
Select the type of information you want to synchronize.

x|

Ta synchronize a particular type of information, select its check box. To stop
synchronization of that information, clear its check box.

Mobile Device | Desktop Computer [~
[1¢® Calendar Microsoft Outlook

O Q Channels Channel Synchionization

[ 42 Contacts Microsoft Outlook

™ Daily Record FranklinCovey PlanPlus

CIFFC Task FrankinCovey PlanPlus il

Synchronized Files

1@ Inbox Microsoft Outlook ~|
To find out more about and to customize what gets synchronized, click  gettings...
on that information type in the list and then click Settings.

< Back Next> Concel | Help

4-6

Pegaso™ Industrial PDA with Windows® CE



Networking

Networking

Setting up the Network ID

To set up your Network ID (configure the Windows user settings, such as the user
name, password, and domain), complete the following steps on the Pegaso:

1. Go to Start > Settings > Control Panel > Owner.
2. Select the Network ID tab on the Owner Properties dialog box.
3. Enter your User Name, Password, and Domain on the Network ID tab.

4. Select OK on the command bar to save your network ID information.

Access basic network connection information by double-tapping on the Network icon in
the system tray. Tap Details to show more information.

The Network Icon

The network icon in the system tray indicates if the network is currently connected or
not.

Figure 4-7. The Network Icon

Network
Connection lcon

System Tray

Network and Dialup Connections

Radio Card settings will vary depending on the type of radio card you are using. For
assistance configuring the Pegaso for your RF network, reference Remote Connections
in the online help on your unit. Reference the documentation for your radio card type
for further information.
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Network Setup: Remote ActiveSync

To execute a Remote ActiveSync, complete the following steps:
1. Go to Start > Programs > Communication > Netlink.
2. Select the target host to which you wish to connect in the Connect To field.
3. Tap Connect.

4. A network ActiveSync connection will be established.

Network functions and operations work the same when using the Dock.

orel»  You must have established an ActiveSync partnership with a host before you can use
‘ 7 Remote ActiveSync to connect to it. To establish an ActiveSync connection with the
Pegaso, refer to "Installing & Setting Up Microsoft ActiveSync" on page 4-1.

SNMP

SNMP (Simple Network Management Protocol) is the standard protocol for managing
devices on a network. With SNMP running on the terminal, other SNMP based net-
work management tools such as HP Openview® and CastleRock SNMPpc® may also
be used to interface with the terminals. To support this capability, Datalogic has released
the Management Information Base (MIB) for the Datalogic Windows-based terminals.
The MIB is used by the management tools to allow them to better support the configu-
ration values provided on the terminals, such as scanner controls and terminal type
information.

E’ The MIB is available at www.mobile.datalogic.com.

For more information on SNMP, refer to "SNMP Interface", or go to:
http://www.microsoft.com.
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Appendix A
Accessories

Overview

This appendix covers the following topics:
"Power Supplies” on page A-2.
* "Powered USB Cable & Power Supply”
*  "Battery Pack"
* "Single Slot Dock"
* "Four-Slot Charge Dock"
e "Four-Slot Ethernet Dock"
* "Four-Slot Battery Charger"
* "Car Charging Adapter”
"Powered Mobile Dock" on page A-6
"Modem Module" on page A-7
"Ethernet Module" on page A-8
"Handstrap" on page A-9
"Handle" on page A-10
"Belt Clip" on page A-11
"Screen Protector” on page A-13
"Magnetic Stripe Reader” on page A-15

ore]p Contact your Datalogic reseller for accessories and supplies for the Pegaso; go to the
‘ * Datalogic website for the most current information.
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Accessories

Power Supplies

Powered USB Cable & Power Supply

orelp Use only the correct battery chargers and docks with this Windows CE Pegaso. The tech-
‘ " nology used for these models is incompatible with other Datalogic chargers and docks.

Figure A-1. Power Supply and Powered USB Cable

Battery Pack

The Battery Pack and the Battery Door are integrated and are not sold separately. The
Pegaso is available with either a standard or high-capacity battery.

To remove the Battery Pack on the Pegaso, complete the following steps:

1. While pushing the Battery Latch (shown in Figure A-2), lift out the Battery Pack,
top first.

2. To replace, seat the bottom end first, then click the Battery Pack into place.
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Figure A-2. Battery Pack

Battery Pack

Battery Latch

(push in to release) Seat this

end first

Single Slot Dock

Figure A-3. Single Slot Dock

USB/Serial Connector

Battery Pack in Charge

Pull Upward to Remove
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Four-Slot Charge Dock
The Four-Slot Charging Dock provides the ability to charge up to four Pegasos and four

spare batteries simultaneously.

Figure A-4. Four-Slot Charge Dock

Four-Slot Ethernet Dock

Like the Four-Slot Charging Dock, the Four-Slot Ethernet Dock provides the ability to
charge four Pegaso and four spare batteries simultaneously. In addition, the built-in
Ethernet hub gives all the docks a unique Ethernet address accessible through one phys-
ical 802.3 CAT5 connection. See "Ethernet Module"on page A-8 for more information
on setting up an Ethernet connection.

Use when you want to connect to an Ethernet network, or for batch units to synchro-
nize without the need for wireless technology.

There are two LEDs; one for 10/100 Mbps link and the other for Tx/Rx.

& The Equipment shall not be directly connected to a Telecommunication Network.

CAUTION
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Figure A-5. Four-Slot Ethernet Dock

Four-Slot Battery Charger

Charge up to four spare battery packs simultaneously with the Four-Slot Battery
Charger.

Figure A-6. Four-Slot Battery Charger
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Car Charging Adapter

A Car Charging Adapter is available for the Pegaso. To attach, just plug the adapter into
the connector on the bottom of the unit, and tighten the thumb screws to secure it.

Figure A-7. Car Charging Adapter

&

Powered Mobile Dock

The Pegaso Powered Mobile Dock (PMD) is a rugged cradle for Pegaso PDAs, used to
install it on mobile applications such as forklifts.

Power-On
Indicator

Release Button
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Modem Module

Features include a power on indicator, holder for the Pegaso PDA, battery charging for
the Pegaso, versatile mounting options, serial port connection for peripherals (with

power available), and a USB mini AB OTG port available for peripherals.

For ordering information, go to the Datalogic Mobile website or your reseller. Reference
the Powered Mobile Dock Installation Guide for further information on installation and
use of the Powered Mobile Dock.

Modem Module

An optional Modem Module allows you to use the Pegaso to dial a server in a remote

office.

Features:

V.92/56K data rate backward compatible with

lower speeds

V.44 and V.42 bits data compression
V.42 error correction

AT command compatible

U. S. Caller ID reporting

FastPOS (V.29) and V.22vis Fast Connect
V.80 Synchronous Access

Built-in speaker

Easy to use

To connect:

1.

2.

Remove the Pegaso from the dock and detach power from the dock.

Plug the modem module into the dock, and then plug the phone cable into
modem.

Replace the Pegaso into the dock and restore power.

Select Start > Settings > Network and Dial-up Connections to open dial-up network-
ing.

Tap Make New Connection to create a new connection.

Type a name for the connection, and tap the radio button to select Direct Connec-
tion. Tap Next.

Select Hayes Compatible Modem on Com1 as the device.
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Gomacion | .| [x[11] [2][x]

} }
)1‘ v!’ o =
- e ot Type a name for the connection: - bt
Serial uUsB e -
| ‘-E.'I |I‘~-1\,r Connection
Z Select a device:
Select the connection type: |serial Cable on COM1:

(OF:

() virtual Private Network (PPTP)
(O Virtual Private Network (L2TP)
{O) PPP over Ethemet [PPPoE]

<ok [ Next> | | <Back || Fnsh |

8. Click on TCP/IP Settings and Security Settings and fill in as needed to connect to
the remote server. Check with your network administrator for settings. Tap Finish

when complete.
9. Double tap the newly named connection.
10. Fill in the necessary username, password, and domain.

11. Tap Connect to continue.

A PPP connection has now been created. TCP/IP network communications can com-

mence.

Ethernet Module

The optional Ethernet Module allows the Pegaso to connect to an Ethernet network.
There are two LEDs; one for 10/100 Mbps link and the other for Tx/Rx. The commu-
nications rate is 10/100Mbps — Auto-negotiate.

To Connect:

1. Remove the Pegaso from the Dock, and
unplug the power from the Dock.

2. Plug the ethernet module into the Dock, then
plug a CAT cable into the Ethernet module.

3. Replace the Pegaso into the Dock, and restore
power to the Dock.

A network icon will be displayed in the system tray.
All normal network activities can now take place.

& The Equipment shall not be directly connected to a Telecommunication Network.
CAUTION
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Handstrap

Handstrap

‘ UTE_ It is not necessary to remove the Handstrap to install the Handle or the Belt Clip.

Removing the Handstrap

An elastic Handstrap is included with the Pegaso. To remove the Handstrap, complete
the following steps. Reference Figure A-8 while performing these actions.

1. Grasp the lower handstrap attachment and pull to slide out from the unit.

2. Using a Phillips screwdriver, remove the two screws securing the upper handstrap
attachment to the unit.

Figure A-8. Removing/Replacing the Handstrap

Upper g é Closure Area
Handstrap

Assembly

Handstrap

Back Enclosure
Handstrap Holder

Installing the Handstrap

To install a Handstrap on the Pegaso, follow the steps described below.

1. Feed the strap end of the handstrap down through the Back Enclosure Handstrap
Holder slot as shown in Figure A-8 and loop it up to engage the closure area at the
desired position.

2. Attach the Upper Handstrap Assembly to the unit using the two Phillips screws.
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Handle

The Pegaso is available with an attachable handle
which provides an additional trigger for scanning.
When you remove the handle, you lose the ability
to press the trigger on the handle and must use the
<Scan> key on the keypad or Scan triggers on the
Pegaso instead.

To install a handle, refer to the following sections.
Reverse the instructions to remove the handle.

orelp The Handstrap can be left on when installing the
Handle.

Installing a Handle on the Pegaso

The handle may be installed without removing the handstrap. To install the handle on
the Pegaso, complete the following steps:

1. Align the “ears” on the handle with the corresponding holes on the underside of
the Pegaso and slide them into place.

Ears
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Belt Clip

2. Seat the top of the Handle against the Pegaso and turn the quarter-turn fastener to
secure the Handle to the unit.

Unlocked
Position

Handle

Position

The trigger is automatically activated and available. Press to initiate scanning

Belt Clip

OTE

The Handstrap can be left on when installing the Belt Clip.

The Belt Clip comes with two separate pieces:
one that attaches to the Pegaso, and one that
attaches to your belt.

To install the Belt Clip on the unit, complete
the following steps:

1. Turn the Pegaso face-down and ensure
that power is off.

2. Orient the Belt Clip on the underside of
the Pegaso.
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3. Align the “ears” on the inside of the Belt Clip with the corresponding holes on the
underside of the Pegaso and slide them into place.

Ears

4. Push the top of the Belt Clip against the Pegaso and turn the quarter-turn fastener
to secure it.

Figure A-9. Installing the Belt Clip

Unlocked
Position

1/4 Turn Latch

Locked
Position
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Attaching to a Belt

To attach the Pegaso to a belt, snap the Belt Attachment onto your Belt. Slide the Pegaso
onto the Belt Attachment sideways, then rotate to an upright position to secure it into
place, as shown in Figure A-10.

Figure A-10. Attaching to a Belt

Screen Protector

A Screen Protector is available for the Pegaso. Use the following instructions to attach a
Screen Protector.

You may find it helpful to have the unit firmly seated in its dock while performing these
) procedures. Another useful tip is to have a credit card handy to assist in smoothing the
? Screen Protector in place.

1. Gently but thoroughly clean the touchscreen using a lens
cloth or other soft, lint-free cloth. If necessary, dampen
the cloth with a mild cleaning solution, such as liquid
hand soap and water. Thoroughly dry the area after
cleaning, and ensure it is lint-free.

Never use corrosive or abrasive cleaners or cloths on the
Pegaso.

CAUTION

2. Remove the Screen Protector from its packaging

and, while holding it by the edges, pull the tab to Tab
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begin peeling the backing from about one inch of the adhesive side. Fold the back-
ing down as you go.

& DO NOT touch the adhesive area, as this could leave a fingerprint when installed.

CAUTION

3. Orient the Screen Protector with its adhesive side towards the screen and CARE-

FULLY align its top edge and corners with the screen recess, as shown in
Figure A-11A. If alignment is not perfect, gently lift up and start again.

Continue to peel the backing while slowly seating the protector in place. Use a
credit card (if available) or similar soft-edged object to evenly smooth the Screen
Protector and push out any bubbles between the surfaces. Reference Figure A-11B.

Figure A-11. Applying a Screen Protector to the Pegaso

A
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Magnetic Stripe Reader

Magnetic Stripe Reader

Installing and Disconnecting

Align the Magnetic Stripe Reader (MSR) with the bottom edge of the PDA as shown
below, then snap the two units together to seat the connection. To disengage the MSR,
push in firmly on both of the snap releases on either side of the MSR, then slide it down
and away from the PDA.

Installing the MSR/Releasing the Snaps

Using the MSR

1. Once the MSR is seated in place and the PDA powered-on, open the program into
which you wish the magnetic stripe data to be read.

2. Orient the magnetic stripe card as shown below and swipe it through the MSR slot
in either a right-to-left or left-to-right motion.

3. The swiped magnetic stripe data should be read into the program.
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NOTES
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Appendix B
Datalogic® Desktop Utility
for Windows® CE

Overview

Datalogic® Desktop Utility (DDU) allows Pegaso™ Windows® administrators to con-
figure Windows® CE devices to control individual user access. This includes:

* DPrevent users from changing Pegaso OS settings.
*  Define keys to access specific functionality/programs.

*  Use Application Selector to replace desktop with a selection of authorized applica-
tions.

* Internet Explorer access restriction, configuration and customized recovery mecha-
nisms.

This section covers the following information:
e "Datalogic Desktop Utility" on page B-2

* "Administrative Options" on page B-3.

"Setting Hot Keys" on page B-5.

"Internet Explorer Configuration” on page B-8.

"Modifying Windows Controls" on page B-9

"Add Application" on page B-12.

Product Reference Guide B-1



Datalogic® Desktop Utility for Windows® CE

Datalogic Desktop Utility

To open the DDU for the first time, select Start > Settings > Datalogic Desktop Utility.

Figure B-1. Accessing DDU

Datalogic
Deskt..,

Date/Time Decoding

R 5 G
Devica Info Display Error
Reporting

E T

g 9 =

Input Panel  Internet Keyboard
Options F

.‘fj’”[}{:om.o.l Lo @ ¥ 1110 PM |@ |%

These options are available from all screens:

Table B-1. Options Available on all Screens

Command

Description

oK Tap OK to apply the settings and modifications you have made in the
DDU tabs. OK saves every modification.

X Tap X to cancel the settings and modifications you have made in the
DDU tabs. X cancels all modifications you have made in DDU.

B-2
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Administrative Options
When you open the DDU control panel, the Admin tab will open.

Figure B-2. Setting a Password/Admin Tab Fields
Datalogic Desktop Utlity  [i4 B3
Admi | Hieys | I _| wo | Appsslct]
[V Enable Datalogic Desktop:
Enter Password:

Re-Enter Password:

waxw

[ setpassword |
[estre pefata |

Restore Defaults

Note: Alphanumeric characters used within a
password should not be defined as hot keys.

Version: 2.0.0.0

Table B-2. Setting a Password/ Admin Tab Fields

Command Description

Select/tap this checkbox to activate the DDU functions such as
Hot Key assignments, |E Restrictions, Windows Settings, and the
authorized application menu.

Enter a password in the text box. This allows the user to specify a
password when this utility is launched. By default there is no
password. A password can consist of all standard keyboard char-
acters.

Re-Enter Password |Carefully re-enter the password in the second text box.
Select/tap Set Password to enable the password.

Set Password To change or remove the password, enter a new value, re-enter
the new value, and select/tap Set Password.

Select/tap Restore Defaults to reset the default values of all the
Restore Defaults functions on all the tabs. After you select this option, you will
receive a prompt to verify this selection.

Enable Datalogic
Desktop

Enter Password
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Setting a Password

To set a password:

1. Enter a password in the field. This allows the user to specify a password when
this utility is launched. By default there is no password set.

‘ UTE_I‘__ Be sure to record the Password for future reference.

2. Re-enter the password in the second field.

3. Select/tap Set Password to enable the password.

4. Select/tap OK close the Set Password Confirmation dialog.
= You must select/tap Set Password prior to exiting DDU in order to store
8]

" and activate your new password. It is not necessary to select Enable Data-
‘ logic Desktop.

& If you select/tap Restore Defaults it will remove all custom settings and
restore all the factory default settings, except a previously set password.

CAUTION

Changing a Password

To change to a new password:
1. Enter a new value in the Enter Password field.
2. Re-enter the new value in the Re-enter Password field.
3. Select/tap Set Password.

Removing a Password

To remove a password:
1. Enter blanks in both Password fields.
2. Select/tap Set Password.

Password Request Dialog Box

Once the password is set, the next time you open the Datalogic Desktop Utility, the DDU
Password dialog box opens.

This dialog box will only open if a password was defined.
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Figure B-3. Setting a Password
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Table B-3. Setting a Password Dialog

Command Description

Enter your password using the keypad, or using the stylus on the
soft input panel (SIP) in the text box.

OK Select/tap OK to accept the password.
X Select/tap X to cancel the request to start the DDU.

Enter Password

Complete the Datalogic Config dialog:

1. Type in your password using either the keypad on the unit, or using the stylus
on the soft input panel (SIP).
If you enter an incorrect password, the system will prompt you to input the cor-
rect one.

2. Select/tap OK to verify the password. Or tap X to cancel.

Setting Hot Keys

You can use Hot Keys (HKeys) Tab to associate specific keys, such as <F1>-<F10>, with spe-
cific applications. You can also create a new Hot Key combinations ("Adding a New Hot Key" on
page B-7). Select the HKeys tab to access these options.

For example, you could set <F2> to launch a sample application like:

\Windows\pword.exe.
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Figure B-4. Hot Keys Tab

Datalogic Desktop utiity [ K4 Datalogic Desktop utiity [ K4
| Admin| HKeys |1 | win | AppSelect | | Admin| HKeys |1 | win | AppSelect |
Hot Key: Hot Key:
|F1
Assodated Function
Action
Application
No Action ~l
3| @paaoni. | 5o 4327uB By 3| @paaoni. | 5o 43 ruB B
Table B-4. Hot Keys Tab Fields
Command Description
Hot K This pull-down list displays the available function keys to define.
otrey Select the desired one from the list.
Select/tap to specify a new Hot Key, not on the Hot Key list. This
New :
opens a new dialog, shown on page B-7.
Delete Tap to delete the selected Hot Key. You can only delete the Hot

Keys you have added. You cannot delete <F1> -<F10>.

Associated | This pull-down list displays the available functions. Select either
Function Application orAction.

Application |Displays path to the selected application.

Browse Select/tap E] to browse for application files. You can associate an
executable program with the specified Hot Key.

Type the command-line arguments that are needed for the specified
Arguments |application. This option is only available when Application is
selected in the Associated Function pull-down list.

Specify an action to associate with a Hot Key. This list includes:
SIP toggle Taskbar,Datalogic Config Admin,
Action and Application Switcher. This option is only available
when Action is selected in the Associated Function pull-down
list.

The <F6> is the key initially assigned to DDU Admin.

If you wish to assign this key to a different function, you must first select an unassigned
Hot Key and assign it to the Action - DDU Admin. You can then go back and reassign the
FKey to something else.
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Table B-5. Pegaso Hot Keys Available

Pegaso

19-key models

Numeric
F1-F10
Alpha keys
Side/top triggers

7 tions. To prevent DDU Hot Keys from overriding existing application keys, select “No

@, The administrator is responsible for verifying that these keys don’t override existing func-
‘ Action” in the Action combo box.

Adding a New Hot Key
When you select New on the HKeys tab, this opens the Add New Hot Key dialog box.

To define a new Hot Key, complete the following steps:
1. Enter the key combination to define a new Hot Key in the Enter Key textbox.

2. The Note displays important information indicating Hot Keys that should not
be used.

w Hot Key

Figure B-5. Add a Ne

| Admin| HKeys [IE_| win | Appsekect]

Hot Key:

I:]. Add New Hotkey

Al Enter Key:
91

Note: On this keyboard Ctrl + Alt +
Backspace will reset the terminal.
You cannot use this combination as
a shortcut. Do not add characters
used in the password as hot keys.

}{H@Damog- B 430 nl!ﬂ |%

Table B-6. Adding a New Hot Key Dialog

Command Description
Enter the desired key combination in this text box to define a Hot
Enter Key
Key.
OK Select/tap OK to add the specified Hot Key.
X Select/tap X to cancel the specified Hot Key.
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OTE

‘ ¥ Make sure you do not attempt to add a Hot Key that is already defined.

3. Select/tap OK to save the New Hot Key. If you select/tap X, the key will not be
saved.
It is possible for the keyboard wedge to activate assigned Hot Keys using
alphanumeric characters. Barcodes containing characters associated with
assigned Hot Keys will trigger the action or application assigned to that
Hot Key.

Internet Explorer Configuration

Tap the IE (Internet Explorer) tab to access the IE Configuration option. Use the IE Error
Redirection option to provide customized recovery from common IE errors. When an
error occurs, the browser can redirect access to a specified error page with instructions
on how to recover from the problem.

Figure B-6. IE Configuration Tab / IE Window Features

Datalogic Desktop utiity  [4 E3 IE ﬁzdﬁ/lress gar IE Tool
Admin | HKeys| E | win | AppSelect | | | enu bar
e (e i viw_rvorl ]
{(400) Invalid Syntax v ]]Al:ldml \Wwindows\default.htm |
Error Page: j

)
=
E
£l
=
—
=

||l|1|‘||||”|
\o

IE Interface
[V] Enable Address Bar k —
[] Enable Toolbar 14) FALCON
[ Enable Status Bar
[ Enable Menu Bar IE Options
:-{H@Damog- 83 4:42n|!¢|% j
AT |ooia e
|E Status Bar—— | l"; PN A

Table B-7. IE Tab Fields

Command Description
The Error Types pull-down list displays available IE Error
Types:
(400) Invalid Syntax, (403) Request Forbidden, (404) Object
Error Type Not Found, (406) No Response Format, (410) Page Doesn't

Exist, (500) Internal Server Error, (501) Server Can't Do That,
Generic Error, Server Is Busy, Couldn't Find Server, URL Syn-
tax Error, Request Cancelled, Not Available Offline

Edit this textbox to associate a website or html file with the
specified error.

Error Page
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Command Description

Select/tap to set a specified error page as the default. A confir-
Assign as Default |mation dialog opens to ask if the default error page applies to

all errors.
Browse Select/tap to browse for files.
ngw ARRITEES Select/tap this check box to show the IE address bar.

Show Tool Bar | Select/tap this check box to show the IE toolbar.
Show Status Bar |Select/tap this check box to show the IE status bar.
Show Menu Bar  |Select/tap this check box to show the IE menu bar.

Internet Options

Tap Internet Options on the IE tab to open the Windows CE Internet Options control
panel. Customize these settings as necessary.

The Internet Options control panel applet is part of the Microsoft® Win-
OTE dows® CE operating system.

‘ ' For more information on the Windows CE operating system, please refer
to the Microsoft website at http://www.microsoft.com.

The DDU allows you to cancel prior to applying your changes. However,
any settings modified in the Internet Options control panel applet through

the DDU interface will be applied even if you later cancel the your modifica-
cAauTion tionsinthe DDU.

Modifying Windows Controls

Selecttap the Win (Windows Controls) tab to access the Windows Controls option. Use
Windows controls to allow or restrict access to Windows system functions.

You can disable normal Windows functions such as the desktop and taskbar, leaving
nothing but a blank workspace. This allows applications to be run on the full screen and
prevents users from accidental or unauthorized use of the taskbar, Internet Explorer, and
any other resident applications.
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Table B-8. Win Tab Fields

Figure B-7. Windows CE Desktop and Win Tab

Datalogic Desktop Utlity  [iI4 [E3
| Admin | HKeys | IE | Win | AppSelect

Taskbar

Note: These settings will be applied when OK
is pressed.

&9/ yataoni. | 55 4saru BB

Command

Description

Show Taskbar shown or hidden.

Select/tap Show Taskbar to specify that the taskbar is

Select/tap Taskbar Enabled to specify whether the taskbar
Taskbar Enabled is accessible. This option is only available when the Show
Taskbar is checked.

Select/tap Start Menu Enabled to specify whether the Start
Start Menu Enabled |menu is accessible or not. This option is only available when
both Show Taskbar and Task Bar Enabled are checked.

Windows CE Desk- |Select/tap Windows CE Desktop Enabled to specify that
top Enabled the desktop icons are accessible or not.

Application Selector

Use the Application Selector (AppSelect Tab) function to edit, add, or delete applications

for the application selector.

B-10
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Figure B-8. AppSelect Tab

Datalogic Desktop Utlity [ [E3
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Table B-9. AppSelect Tab Fields

Command Description

Select/tap Enable Application Selector to enable/disable the
Enable Applica- |application selector. When this is enabled, the Application
tion Selector Selector replaces the desktop and allows only authorized use
of applications.

é;ttig?]!zed Al This is a list of applications that the user may access.

New Select/tap New to create a new application entry.

Edit Select/tap Edit to edit the selected entry.

Delete Select/tap Delete to delete the selected entry.

Up/Down a(e;:;.ct/tap Up/Down to move an entry up or down in the list-
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Add Application

The Add Application dialog opens when you tap either New or Edit. From the Add Applica-
tion dialog the administrator can configure and/or add/change an a new application
entry in the list.

Applications with the Run Application at Startup option enabled will start automatically

when the Application Selector starts up.

Appication Title: [wordPad
Arguments: |
ot 2]

Run Application at Startup: [ |

Delay (Seconds): ]_:|

Table B-10. Add Application Dialog

Command

Description

Application Title

Type the name of the application in this textbox in the way you
wish it to appear for the user.

Executable Displays the path for the executable file which you want to run.

Browse Select/tap E] to browse for the desired executable file. The
results of this search are placed in the Executable textbox.

Arguments Typg any command line arguments to be used when an applica-
tion is executed.

Icon File Displays the path/link to the desired icon file.

Browse Select/tap E] to browse for the desired icon file. The results of

this search are placed in the Icon File textbox.

Run Application

Select/tap this box to force this application to auto start when the
Application Selector starts up. Applications will be started in the

at Startup order listed in the authorized application list.
Enter a delay duration in seconds in the combo box.

Delay This option delays auto start of application(s) to allow drivers to
load prior to starting applications

OK Select/tap OK to add/save changes.

X Select/tap X to cancel the creation of this entry.
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Application Selector

Application Selector

The administrator can choose for the user to have access to the desktop or not. The
Application Selector can replace the desktop and limit the user to the specified list of
applications.

Figure B-10. Application Selector
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The user can select/tap the desired application.

The administrator can customize this list as shown in "Application Selector" on

page B-10.

Application Switcher User Interface

The application switcher provides the same functionality as the standard Windows®
Ale+Tab function. This allows the user to cycle through the various open applications.

‘ ‘ m? The <Esc> key can be used to close the Application Switcher.

The application switcher is activated via an assigned Action

key specified in the Hot Key tab. (Refer to "Setting Hot B Q

Keys" on page B-5.) When the assigned Hot Key is pressed, | W=

the dialog shown to the right will be displayed. 2 @

The application switcher can only be assigned to a single =

Hot Key, not a Hot Key with modifier keys. For instance, ?; -Ea28r

<Shift>+<F3> cannot be assigned to the task switcher action, - —

but <F3> can be. !

Press the Hot Key assigned to open the application switcher. —

Press the assigned Hot Key to cycle through the running

applications when the dialog is open. Press <Enter> to —— :
Eod |._.:,__l_.> 12:24 P |8 |

switch to the selected application or <Ese> to close the
application switcher.
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Appendix C
Configuring the Web Server

Overview

The Web Server can perform several different actions, including generating a web page
containing statistics relating to performance of the mobile computer. The Web Server
can also be used for creating an interface for interaction with the Terminal to configure
system behavior.

This section contains the following topics on configuring the Web Server:
* "Enabling the Web Server" below.
e "Testing the Web Server" on page C-3.
* "Launching the Network Administration Page" on page C-4.
e "Web Server Registry Settings" on page C-4.
* "Creating and Using an ISAPI Service" on page C-5.

Enabling the Web Server

By default the Web Server is disabled. The following demonstrates how to enable the
Web Server:

1. On the Pegaso, either through a CE-based registry editor or using the Remote
Tools RemoteRegEdit included with eVC++ 4.0, modify the following registry

entry:
[ HKEY_LOCAL_MACH INE\COMM\HTTPD 1
"Enabled"=dword:1

2. Ina Command Prompt window on the Terminal, type the following:

\> services list

This will display a list of loaded and services and their state.

3. If the service HTPO: is not listed, then type the following to load the HTTP Web
Server:

\> services load httpd

4. If the service is listed and not running, type the following to start the HTTP Web

Server:

\> services start HTPO:
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5. To restart the Web Server, type:
\> services refresh HTPO:
This will cause the Web Server to reload any information pertaining to the Web Server

in the registry. For additional information on the registry entries, see "Web Server Regis-
try Settings” on page C-4.

To configure the Web Server to allow access to the Web and Net administration pages:

1. On the Pegaso create the following registry entries:
[HKEY LOCAL MACHINE \COMM\HTTPD\VROOTS\ /NetAdmin]
“Default” = “\windows\natadmin.dll”
[HKEY LOCAL MACHINE \COMM\HTTPD\VROOTS\ /WebAdmin]
“Default” = “\windows\httpdadm.dll”

2. Ina Command Prompt window on the Terminal, type the following:

\> services refresh HTPO:

Setting up a User

The following example demonstrates how to set up a user named Testuser in a group
called Testgroup.

To configure User and Group Permissions for the Web Server:

1. On the Pegaso, launch Internet Explorer and type the following address in the
address bar: http://localhost/NetAdmin. The Web-based network configuration
utility appears.

2. Fill in the Enter new password and Confirm new password boxes, then click Submit
on the bottom of the page.

3. On the menu bar of the displayed web page, click the User Accounts link. The
Enter Network Password dialog box appears.

4. Type Admin in the User Name box, and type the password that you specified above
in the Password box. Leave the Domain box empty.

5. Click OK. The User Manager Setup page appears.

6. In the Logon Name dialog, type Testuser in the Create a new user box, then click
Create. The User Manager Setup page appears.

7. On the User Configuration page, type a password for Testuser, confirm the pass-
word, and then click Create Account. The new user will appear below the Logon
Name box on the User Manager Setup page.

8. In the User Group Setup box, type Testgroup in the Create a new group box. Click
Create.
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Testing the Web Server

9.

Click Return to user configuration page to return to the User Manager Setup page.
The new group will appear below the Group Name box on the User Manager Setup

page.

10. Click Modify beside the Group Name box containing Testgroup. The Group Con-

figuration page appears.

11. Select the check box in the Member of group? column for Testuser, and then

click Submit Changes.

You have now added Testuser to the Testgroup group.

 Windows CE also exposes the NTLMDeleteUser function, which is used to delete a user

E,You can also create users programmatically by calling the NTLMSetUserinfo function.

I from the local database, and the NTLMEnumUser function, which is used to enumerate
users in the local database.

Testing the Web Server

After you have created your user accounts and groups for the Web Server, you can test
the Web Server by launching the Web Server configuration page from a host PC. This
will demonstrate that your user has been granted administrative rights for the Web
Server and therefore can access any virtual directory on the Web Server.

To launch the Web Server configuration page from your host PC:

1.

On the Pegaso, verify that the Connected Network icon appears on the taskbar. This
icon indicates you are connected to the network.

Double-click the Network icon, and then select the IP Information tab to obtain the
Pegaso’s IP address.

On the PC, launch Internet Explorer and type the following information in the
address bar: http://<IP address from Pegaso>/Webadmin.

The Web Server Login dialog appears. Type Admin in the User Name box and enter
the password you specified. Click OK, and the Web Server Configuration page will

appear.

Scroll to the bottom of the page, and click Modify to the right of the Default Website
box. The Default Website page appears.

Click the link to Configure the Virtual Directories. The Virtual Directory Configuration
page appears.

Verify that the following virtual directories are listed on the page:
/WebAdmin/
/NetAdmin/
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8. Click Return to the Default Website configuration page. The Default Website page
appears.

9. Click Configure the Administrative Users for this Website. The Administrative Users
page appears.

10. Select Enabled for Testuser, and then click Update. A message telling you that
your modifications have been saved and asking you to restart the Web Server

appears at the top of the page.

11. To restart the Web Server, select Restart Web Server from the menu bar.

Launching the Network Administration Page

To launch the network administration page from your host PC:

1. Open Internet Explorer and type the following information in the address bar:
http://<IP address from Pegaso>/NetAdmin. A dialog box asking for the user name
and password appears.

2. Type Testuser in the User name box and the password you created for this user
in the Password box, and then click OK. The Network Administration page appears.

Web Server Registry Settings

To gain access to a virtual path, a user must be authenticated using NTLM authentica-
tion or Basic authentication. Specify the authentication level by setting the “a” value for
each virtual path.

For more information on the registry settings and what each key represents, see the
Windows® CE SDK help documentation included with embedded Visual C++ 4.0
SP2. The help file contains a wealth of information on this topic.

Adding these values will create virtual root directories for the Basic and

NTLM-based authentication methods.

[HKEY LOCAL MACHINE \COMM\HTTPD\VROOTS\ /WebAdmin]
@="\\windows\\httpdadm.d1ll"

"a"=dword: 0

[HKEY LOCAL MACHINE\COMM\HTTPD\VROOTS\/BasicOnly]
@=H \ \ 1]

"a"=dword:1

"Basic"=dword:1

"NTLM"=dword:O0

[HKEY LOCAL MACHINE\COMM\HTTPD\VROOTS\/NTLMOnly]
@=" \ \ 1]

"a"=dword:1

"Basic"=dword:O0

"NTLM"=dword:1

[HKEY LOCAL MACHINE \COMM\HTTPD\VROOTS\ /BothAuth]
@=" \ \ 1]

"a"=dword:1

"Basic"=dword:1

"NTLM"=dword:1
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Creating and Using an ISAPI Service

virtual directory. This potentially opens the device up to hackers. Setting this value to
zero (0) is permissible for internal development and testing purposes. However, you
should never ship a Web Server device with the "a" value set to zero (0) for any configura-
tion page.

Q Setting the "a" value to zero (0) enables anonymous users to have access to all files in the

CAUTION

orel» To set the password for the entire Web Server device for Basic authentication, you can
‘ #  create a configuration application that runs on the device and calls the SetPassword
function. Setting the password programmatically through SetPassword is the equivalent

of the device password setting that you add in Control Panel.

Creating and Using an ISAPI Service

Developers can create an ISAPI service written in eVC++ to access the APIs available on
the Terminal. The two sample .dlls below demonstrate setting and getting a few of the
configurable items available in the Pegaso SDK.

Setting Configuration Items

The following example shows how to set the Code 39 minimum label length to 10 char-
acters:

1. Create a virtual directory under the root called SetSym and set the Default regis-
try entry to SetSym.d11 while making sure the full path is included.

[HKEY LOCAL MACHINE \COMM\HTTPD\VROOTS\ /SetSym]
@="\\windows\\SetSym.d1l1"

2. Restart the Web Server as described on page C-2.

3. Enter the following information into Internet Explorer on the Terminal or host

PC:
http://<ip address of Terminal>/SetSym?CD39MIN&10

Getting Configuration Items

The following example demonstrates how to get all the settings for Code 39:

1. Create a virtual directory under the root called GetSym and set the Default regis-
try entry to GetSym.dll while making sure the full path is included.

[HKEY_LOCAL_ MACHINE\COMM\HTTPD\VROOTS\/GetSym]
@="\\windows\\GetSym.d1l1l"

2. Restart the Web Server as described in the first section. (C-2)

3. Enter the following information into Internet Explorer on the Terminal or desktop
computer:

http://<ip address of Terminal>/GetSym?C39

These two samples are only the beginning of what can be accomplished with the Web
Server. Please note that ISAPI is currently the only method of server-side method invo-
cation. Please consult the Help file associated with the SDK and eVC++ for more infor-
mation on ISAPI and Web Server features.
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Appendix D
SNMP Interface

Overview

SNMP Concepts

Simple Network Management Protocol (SNMP) is a standardized protocol for network
management services using a client/server model. The network management program
(client) issues queries and commands to the remote device (agent/server). The protocol
itself defines a number of variable types and structures, and the rules for using them for
data transfer. Using these variable types and rules, there are a number of standard vari-
ables that are supported by all SNMP agents. These standards include network address-
ing (IP address, subnet mask, etc.), and network statistics (total packets, bad packets,
etc.).

MIB Files

A Management Information Base (MIB) is a file that defines a set of SNMP variables,
their types and usage. There are a number of standard MIBs available, depending on the
information being managed.

Datalogic MIBs

Beyond the standard values, SNMP allows manufacturers to define their own private
MIBs. For example, Datalogic has been assigned an MIB by the Internet Assigned
Numbers Authority that allows Datalogic to define SNMP values relating specifically to
devices that we manufacture. Within the Datalogic MIB, several categories of values
have been defined including scanner Configurations, Terminal power Configurations
and Terminal network parameters.

The format of an MIB follows rules laid out in the appropriate standards, allowing the
manufacturers of network management tools such as HP OpenView and CastleRock
SNMPc to make use of the MIBs developed by manufacturers. So by following the pro-
cedures used by the management tool, the MIB can be processed by the tool allowing
the proper display of SNMP values retrieved from the agent.
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For example, if the Datalogic MIB is loaded into OpenView, the administrator can then
view all of the values defined by Datalogic using the names assigned by Datalogic, as
well as a brief explanation of what each value represents. This will also allow the admin-
istrator to update most values, and provides range checking information for the tool to
take advantage of. The current Datalogic MIB can be found on the Datalogic Mobile

website at www.mobile.datalogic.com in the Downloads area.

Additional Resources

Additional information on SNMP can be found at the following websites:
www.snmplink.org
www.snmpworld.com

www.simpleweb.com
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Appendix E
Cable & Connector Configurations

Introduction

The following pages contain information about standard interface cables for use in
interconnecting the Dock to power and/or peripheral devices.

General Specifications

Wire Requirements

* Cable length should not exceed 15 feet.

e Wire gauge:
5V and GND — 26 AWG min, 24 AWG recommended.
All others 28-26 AWG.

Supply Voltage

Current power supply voltage = 5V, 3 amp.

Docking Connector

Table E-1. Docking Connector Pin Definitions

PIN Signal Description
1 PWR GND GND/Return
2 Cradle IN When Grounded Mobile computer detects it is in the cradle
3 NC No Connect
4 USB_N USB D- Signal
5 USB_P USB D+ Signal
6 GND GND/Return
7 VBUS USB VBUS Signal
8 USB ID USB OTG ID Signal
9 TXD RS232 TXD (Output from Mobile Computer)
10 RXD RS232 RXD (Input to Mobile Computer)
11 RTS RS232 RTS (Output from Mobile Computer)
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12 CTS RS232 CTS (Input to Mobile Computer)

13 DTR RS232 DTR (Output from Mobile Computer)
14 DSR RS232 DSR (Input to Mobile Computer)

15 NC No Connect

16 POWER IN Power Into Mobile Computer

USB Cable

Figure E-1 illustrates the connector configuration of the USB cable for the Pegaso.

Figure E-1. USB Connector Configurations
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Appendix F
Programming Parameters

Overview

This section contains information about programmable settings for the Pegaso with
Windows CE. Use the Decoding Control Panel applets or the bar codes provided in
Appendix G to program the Pegaso.

Table F-2 starting on page F-3 provides the following information:
* Code Parameter is the “human” name for the programming option.

* LD. #is the “decoder” name for the programming option. For example, to set a
Code 39 minimum label length, use I.D. 0120. Programming I.D. numbers given
in this appendix can be used with all programming methods.

*  On/Off is a toggle. 1 turns the parameter on, and 0 turns it off.
* Acceptable Input gives the settings or range of settings for each code parameter.

* Defaults indicates how the parameter is set when the predefined default FF39,
FF3A, or FF3B is selected.

* Minimum (FF39) turns every on/off parameter off and sets all minimum and
Maximum Label Lengths to the lowest values.

* Maximum (FF3A) turns every on/off parameter on, sets all Minimum Label
Lengths to the lowest values, and sets all Maximum Label Lengths to the highest
values. Use this default for troubleshooting; it provides the best settings for read-
ing an unknown bar code symbology and can identify the symbology of scanned
bar codes.

* Factory (FF3B) is the factory setting installed on the Pegaso. This default set will
work for most applications. To reset the Pegaso to the original defaults, scan the
Factory bar code on page G-2.
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Programming Codes Without Parameters

The following table describes the functions of special bar codes that take no parameters:

Table F-1. Programming Codes Without Parameters

Eleel I.D. # Function

Parameter

Defaults FF39 Turns every On/Off parameter off and sets all minimum

Minimum and Maximum Label Lengths to the lowest values.

Turns every On/Off parameter on and sets all minimum
and Maximum Label Lengths to the highest values. This

Defaults default set is normally used only for troubleshooting. It

. FF3A | . .

Maximum gives the best chance of reading an unknown bar code
symbology and also identifies the symbology of each bar
code scanned.

Defaults FF3B This is the default parameter settings that was installed at

Factory the factory. This default set will work for most applications.
This restores all parameter settings to the values that

Defaults exist in the registry. This is useful for restoring parameters

. FF3C . )

Registry to a known working set of values which have been saved
using code parameter FF3F.

Exit and Stops a label programming sequence and restores all

FF3D . o :

Restore parameter settings to the values that exist in the registry.

Exit and Stops a label programming sequence. The last valid

FF3E : .
Save parameter settings are left intact.
Stops a label programming sequence and writes all
Exit and parameter settings into the registry. This can be used to
: FF3F . : :
Commit save a customized set of parameter settings for restoring

later via parameter FF3C.

F-2
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Bar Code Parameters

The following table lists the standard customer programmable settings for the Pegaso.

Table F-2. Programmable Standard Bar Code Settings

Codabar Enter 1 for On
and 0 for Off.
Enable Enables/disables the Codabar symbology. 0300 On/ Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0301 On/ Off Off On Off
Decoding labels.
Enable Requires the use of checksum characters to
Checksum verify a bar code. 0302 On/Off ot ot ot
Send Check- !nstructs the termlqal _to include the checksum 0303 On / Off off Off off
sum in the label transmission
Instructs the decoder to transmit the decoded
Send Start/ start and stop characters of Codabar labels.
Stop The start and stop characters will both be 0305 On /O Ot On ot
translated as A, B, C, or D.
Restricts the Codabar decoder to only read
c t labels that conforms to "CLSI" specifications.
Cfg‘l’er © | Labellength must be 14, and the datais split | 0306 | On/Off | Off | Off off
into fields of 1, 4, 5, and 4 characters sepa-
rated by spaces.
Allow Wide :
Intercharac- ;Allovys W;dte) glaps to appear between charac- 0307 On/ Off Off On On
ter Gaps ers in a label.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0320 01-50 01 01 04
This feature specifies the maximum allowable
Maxi length of a Codabar label. The length includes
L:I;(:InltI:r‘\gth check and data characters. Maximum Label 0321 01-50 01 50 20
Length should be greater than or equal to Min-
imum Label Length.
Rea_xd Verifi- Sets thg pumber qf times a label must be read 0302 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent when parameter Send Code ID (Index XSCISIJ
User ID 0025) is set to 3. "ASCII" code zero (null) is 0323 I I )
S A character
used to indicate that an identifier is not to be
(00 = Off)
sent for the symbology.
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Code 39 Enter 1 for On
and 0 for Off.
Enable Enables/disables the Code 39 symbology. 0100 On / Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0101 On / Off Off On Off
Decoding labels.
Enable Requires the use of checksum characters to
Checksum verify a bar code. 0102 On / Off Off Off Off
Send Check- !nstructs the termlqal 'to include the checksum 0103 On / Off off off Off
sum in the label transmission.
Full ASCII Supports the entire ASCII character set by
Mu replacing various encoded ASCII characters 0105 On / Off Off On On
Ode H H H n n H
with their corresponding "ASCII" equivalents.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0120 01-50 01 o1 01
This feature specifies the maximum allowable
Maximum length of a Code 39 label. The length includes
Label Eength check and data characters. Maximum Label 0121 01-50 01 50 20
Length should be greater than or equal to Min-
imum Label Length.
Read Verifi- Sets the number of times a label must be read
cation before it is transmitted. 0122 01-04 01 02 01
Specifies the symbology identifier (if any) that Anv sindle
is sent when parameter Send Code ID (Index XSCI?
User ID 0025) is set to 3. "ASCII" code zero (null) is 0123 'C 'C 'C
e e character
used to indicate that an identifier is not to be
(00 = Off)
sent for the symbology.
Code 93 Enter 1 for On
and 0 for Off.
Enable Enables/disables the Code 93 symbology. 0400 On / Off Off On Off
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0401 On / Off Off On Off
Decoding labels.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0420 01-50 o1 o1 02
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This feature specifies the maximum allowable
Maximum length of a Code 93 label. The length includes
Label Length check and data characters. Maximum Label 0421 01-50 01 50 20
Length should be greater than or equal to Min-
imum Label Length.
Ree_zd Verifi- | Sets thg pumber qf times a label must be read 0492 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent when parameter Send Code ID (Index XSCI?
User ID 0025) is set to 3. "ASCII" code zero (null) is 0423 character L L L
used to indicate that an identifier is not to be (00 = Off)
sent for the symbology. -
Code 128 Enter 1 for On
and 0 for Off.
Enable Enables/disables the Code 128 symbology. 0408 On/ Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0409 On/ Off Off On Off
Decoding labels.
Instructs the decoder to recognize UCC-128
Enable UCC/ versions of Code 128 labels and process them
EAN-128 differently by changing the Code ID, and 040C On/ Off Off On Off
replacing each occurrence of the FNC1 char-
acter with GS ("ASCII" 29) characters.
ISBT Concat- Instructs the decoder to concatenate Code
enation 128 labels conforming to the ISBT 128 stan- 040E On/ Off Off Off
dard.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0424 01-50 01 o1 02
This feature specifies the maximum allowable
Maximum length of a Code 128 label. The length
Label Eength includes check and data characters. Maximum | 0425 01-50 01 50 20
Label Length should be greater than or equal
to Minimum Label Length.
Read Verifi- | Sets the number of times a label must be read
cation before it is transmitted. 0426 01-04 01 02 01
Specifies the symbology identifier (if any) sent Anv sinale
when parameter Send Code ID (Index 0025) XSCI?
User ID is set to 3. "ASCII" code zero (null) is used to | 0427 character 'K' 'K 'K
indicate that an identifier is not to be sent for (00 = Of)
the symbology. -
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Defaults
Code Parameter/ Description L.D. # Ac(I:rt‘epLa:ble
P Min | Max Factory
European Article Numbering-13 (EAN- Enter 1 for On
1 3) and 0 for Off.
Enable Enables/disables the EAN-13 symbology. 0510 On/ Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0511 On / Off Off On Off
Decoding labels.
St_an_d Check Includgs a check digit in the label which is 0512 On / Off off on off
Digit transmitted.
Send S This instructs the decoder to include the sys-
enc Sys- tem digit in the label transmission. For UPC-E, | 0513 On/ Off Off On On
tem Digit -
the system digit is zero.
This instructs the decoder to identify ISBN
Convert EAN- L
13t labels and append the check digit (per ISBN 0514 On / Off Off Off Off
o ISBN o
guidelines) to the end of the label.
c tEAN- This instructs the decoder to identify ISSN
1; :nver labels and append the check digit (per ISSN 0515 On/ Off Off Off Off
0 ISSN o
guidelines) to the end of the label.
Enable EAN
4-Digit Price/ | Requires the use of a 4-digit price/weight
Weight check digit to verify a bar code. 0516 . Of Off Of
Check Digit
Enable EAN
5-Digit Price/ | Requires the use of a 4-digit price/weight
Weight check digit to verify a bar code. 0517 On/Of Off Off Off
Check Digit
Read Verifi- | Sets the number of times a label mustbe read | -, 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 0525 ‘M ‘M ‘M
: e S character
zero (null) is used to indicate that an identifier (00 = Off
is not to be sent for the symbology. -
European Article Numbering-8 (EAN-8) Enter 1 for On
and 0 for Off.
Enable Enables/disables the EAN-8 symbology. 0518 On / Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0519 On / Off Off On Off
Decoding labels.
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Defaults
Code Parameter/ Description L.D. # Ac(l:rc‘ep:]a:ble
P Min | Max Factory

qud Check !nstructs the termm_al lto include the check digit 051A On / Off off on off
Digit in the label transmission.

Instructs the decoder to expand EAN-8 labels
Convert EAN- . .
81 to their EAN-13 equivalents. Any EAN-13 051B On / Off Off On Off

o EAN-13 .

parameters will then apply to the result.
Rea_md Verifi- Sets thg pumber qf times a label must be read 0526 01 - 04 01 02 01
cation before it is transmitted.

Specifies the symbology identifier (if any) that Anv sinale

is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 0527 'G' 'G' ‘G

. o A character

zero (null) is used to indicate that an identifier (00 = Of)

is not to be sent for the symbology. -
GS1 DataBar-14 Enter 1 for On

and 0 for Off.
?48:5 DataBar- | Enables/disables the GS1 DataBar-14 sym- 0800 On/ Off off on on
nable bology.

GS1 DataBar- | Instructs the decoder to transmit the label data
14 to UCC- as one or more UCC-128 labels. The trans- 0804 On / Off Off On Off
EAN 128 mission will use the UCC-128 AIM identifier.

OTE

1

If GS1 DataBar-14, GS1 DataBar Expanded, GS1 DataBar Limited, or GS1 DataBar Composite sym-
bologies are enabled for UCC-EAN 128, then that setting is also enabled for all other GS1 DataBar

symbologies.

NOTE: For the 2D Imager, GS1 DataBar Expanded User Code ID is used for GS1 DataBar-14

GS1 DataBar Limited

Enter 1 for On

and 0 for Off.
GS1 DataBar . -
Limited Enables/disables the GS1 DataBar Limited 0808 On / Off off on on
Enable symbology.
f_?_ththar Instructs the decoder to transmit the label data
UICCI:-Z A,\? as one or more UCC-128 labels. The trans- 080C | On/Off Off | On Off
128 mission will use the UCC-128 AIM identifier.

OTE

J

If GS1 DataBar-14, GS1 DataBar Expanded, GS1 DataBar Limited, or GS1 DataBar Composite sym-
bologies are enabled for UCC-EAN 128, then that setting is also enabled for all other GS1 DataBar

symbologies.

NOTE: For the 2D Imager, GS1 DataBar Expanded User Code ID is used for GS1 DataBar Limited
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Defaults
Code Parameter/ Description L.D. # Ac(l:rc‘ep:]a:ble
P Min | Max Factory
GS1 DataBar Expanded Enter 1 for On
and 0 for Off.

GS1 DataBar .
Expanded Enaglels/dlsables the GS1 DataBar Expanded 0810 On/ Off off on on
Enable Symbology.
ES1 l;gte:jBtar Instructs the decoder to transmit the label data
U)((:pciE :N © | as one or more UCC-128 labels. The trans- 0804 On/ Off Off On Off
128 mission will use the UCC-128 AIM identifier.
GS1 DataBar -
Expanded ISet t{]he nm|nr|mum Ibtar r%oiziamlalr)fll I%nglgtlh r:otl;e 0824 1-74 ” 74 1
Minimum ess than or equal to maximum label length.

This feature specifies the maximum allowable
GS1DataBar | length of a label. The length includes check
Expanded and data characters, if applicable. Maximum 0825 1-74 1 74 74
Maximum Label Length should be greater than or equal

to Minimum Label Length.

Specifies the symbology identifier (if any) that Anv sinale
GS1 DataBar | is sent when parameter Send Code ID (Index ASCy)II cr?ar-
Expanded 0025) is set to 3. "ASCII" code zero (null) is 0827 acter (00 = R R R
User Code ID | used to indicate that an identifier is not to be B

Off)

sent for the symbology.

Interleaved 2 of 5 Enter 1 for On
and 0 for Off.

Enable Enables/disables the Interleaved 2 of 5 sym- 0210 On / Off off on on

bology.
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0211 On / Off Off On Off
Decoding labels.
Enable Requwes the use of checksum characters to 0212 On/ Off off Off off
Checksum verify a bar code.
Send Check- !nstructs the term|r_1al lto include the checksum 0213 On / Off off off off
sum in the label transmission.

Restricts Interleaved 2 of 5 label lengths to
Enable Case | only 6 and 14 dgta charactgrs. Enabling th|§ 0214 On / Off off off off
Code parameter overrides the minimum and maxi-

mum length values.
Minimum Set the mwmur_n label length to be less than 0228 02 - 50 02 02 06
Label Length | or equal to maximum label length.

F-8
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Bar Code Parameters

This feature specifies the maximum allowable
Maxi length of a Interleaved 2 of 5 label. The length
L:t):;rlnlij;gth includes check and data characters. Maximum | 0229 02 - 50 02 50 10
Label Length should be greater than or equal
to Minimum Label Length.
Ree_zd Verifi- | Sets thg pumber qf times a label must be read 022A 01- 04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 022B character B' B' B
zero (null) is used to indicate that an identifier (00 = Off)
is not to be sent for the symbology. -
Matrix 2 of 5 Enter 1 for On
and 0 for Off.
Enable Enables/disables the Matrix 2 of 5 symbology. | 0208 On/ Off Off On Off
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0209 On/ Off Off On Off
Decoding labels.
Enable Requires the use of checksum characters to
Checksum verify a bar code. 020A On/ Off Off Off Off
Send Check- !nstructs the termlpal 'to include the checksum 020B On / Off off off off
sum in the label transmission.
Minimum Set the minimum label length to be less than 0204 01-50 01 01 06
Label Length | or equal to maximum label length.
This feature specifies the maximum allowable
Maxi length of a Matrix 2 of 5 label. The length
L:;;T‘fggth includes check and data characters. Maximum | 0225 01-50 01 50 10
Label Length should be greater than or equal
to Minimum Label Length.
Ree_zd Verifi- | Sets thg pumber qf times a label must be read 0226 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 0227 character D’ D' D'
zero (null) is used to indicate that an identifier (00 = Off)
is not to be sent for the symbology. -
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MSI Enter 1 for On
and 0 for Off.
Enable Enables/disables the MSI symbology. 0608 On / Off Off On Off
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0609 On / Off Off On Off
Decoding labels.
Require
2 Check Dig- | An MSCI label must contain 2 check digits. 060A On/ Off Off Off Off
its
This instructs the decoder to include any
Send Check VNS e
Digits enableq check digit(s) in the label which is 060B On/ Off Off On Off
transmitted.
ond Check Instructs the decoder to interpret any second
it Mo MSI check digit as modulo 11 instead of mod- | 060C | On/Off | Off | Off off
igit Mod 11
ulo 10.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0624 01-15 o1 o1 04
This feature specifies the maximum allowable
Maximum length of an MSI label. The length includes
L:;él Eength check and data characters. Maximum Label 0625 01-15 01 15 10
Length should be greater than or equal to Min-
imum Label Length.
Read Verifi- | Sets the number of times a label must be read
cation before it is transmitted. 0626 01-04 o1 02 01
Specifies the symbology identifier (if any) that Anv sinale
is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 0627 H' H' H
: e S character
zero (null) is used to indicate that an identifier (00 = Off
is not to be sent for the symbology. -
Pharmacode 39 (Code 32) Enter 1 for On
and 0 for Off.
Enable Enables/disables the Pharmacode 39 (Code 0110 On/ Off Off On Off
32) symbology.
Send Check- !nstructs the termmal .to include the checksum 0112 On / Off off off off
sum in the label transmission.
Send Start/ Instructs terminals to prefix a Pharmacode 39
Stop label with an “A” prior to transmission. 0113 On/Off Off On Off
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Bar Code Parameters

Specifies the symbology identifier (if any) that

is sent when parameter Send Code ID (Index AnXSsggI;Ie
User ID 0025) is set to 3. "ASCII" code zero (null) is 0127 Y Y Y
e o character
used to indicate that an identifier is not to be
(00 = Off)
sent for the symbology.
Standard 2 of 5 Enter 1 for On
and 0 for Off.
Enable Eg;bles/dlsables the Standard 2 of 5 symbol- 0200 On / Off off on off
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0201 On/ Off Off On Off
Decoding labels.
Enable Reguwes the use of checksum characters to 0202 On/ Off off Off off
Checksum verify a bar code
Send Check- !nstructs the termlqal 'to include the checksum 0203 On/ Off off off off
sum in the label transmission.
Use 2-b Allows the terminal to recognize labels that
se char are printed using only two bars for start/stop 0204 On/ Off Off Off Off
Start/Stop
characters.
Minimum Set the minimum label length to be less than
Label Length | or equal to maximum label length. 0220 01-50 01 01 06
This feature specifies the maximum allowable
Max] length of a Standard 2 of 5 label. The length
L:l;(tl;lnltl:r\lgth includes check and data characters. Maximum | 0221 01-50 01 50 10
Label Length should be greater than or equal
to Minimum Label Length.
Rez_ad Verifi- | Sets thfe pumber qf times a label must be read 0292 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent when parameter Send Code ID (Index XSCI?
User ID 0025) is set to 3. "ASCII" code zero (null) is 0223 'F ' 'F
g A character
used to indicate that an identifier is not to be
(00 = Off)
sent for the symbology.
Trioptic Enter 1 for On
and 0 for Off.
Enable Enables/disables the Trioptic symbology. 0108 On/ Off Off On Off
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0109 On/ Off Off On Off
Decoding labels.
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Defaults
Code Parameter/ Description L.D. # Ac(I:rt‘epLa:ble
P Min | Max | Factory
Rea}d Verifi- | Sets thg pumber qf times a label must be read 0124 01-04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) that Anv sinale
is sent when parameter Send Code ID (Index KSCI?
User ID 0025) is set to 3. "ASCII" code zero (null) is 0125 X X X
g o character
used to indicate that an identifier is not to be
(00 = Off)
sent for the symbology
Universal Product Code-A (UPC-A) Enter 1 for On
and 0 for Off.
Enable Enables/disables the UPC-A symbology. 0500 On/ Off Off On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0501 On/ Off Off On Off
Decoding labels.
Sgn_d Check Ingludes check digit in the label which is trans- 0502 On / Off off on off
Digit mitted.
Send Svs- Includes the system digit in the label transmis-
te?: Di ‘ﬁ sion. For UPC-A, the system digit is always 0503 On/ Off Off On On
g zero.
Instructs the decoder to expand UPC-A labels
Convert UPC- . .
At to their EAN-13 equivalents. Any EAN-13 0504 On / Off Off On Off
0 EAN-13 .
parameters will then apply to the result.
Regd Verifi- | Sets thg pumber qf times a label must be read 0520 01 - 04 01 02 01
cation before it is transmitted.
Specifies the symbology identifier (if any) sent Anv sinale
when parameter Send Code ID (Index 0025) XSCIIg
User ID is set to 3. "ASCII" code zero (null) is used to | 0521 ‘A ‘A ‘A
o SR character
indicate that an identifier is not to be sent for
(00 = Off)
the symbology.
Universal Product Code-E (UPC-E) Enter 1 for On
and 0 for Off.
Enable Sys- | Enables/disables UPC-E labels with a system
tem Digit 0 digit of zero. 0508 On /O o On On
Enable Enables more aggressive decoding algorithms
Aggressive to be used in order to scan hard to read 0509 On/Off Off On Off
Decoding labels.
St_an_d Check Includgs the check digit in the label which is 050A On/ Off off on off
Digit transmitted.
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Send S This instructs the decoder to include the sys-
end Sys- tem digit in the label transmission. For UPC-E, | 050B On/ Off Off On Off
tem Digit -
the system digit is zero.
Convert UPC Instructs the decoder to expand UPC-E labels
E° vert 7% | 1o their UPC-A equivalents. Any UPC-A 050C | On/Off | Off | On off
to UPC-A ,
parameters will then apply to the result.
Read Verifi- | Sets the number of times a label must be read
cation before it is transmitted. 0522 01-04 o1 02 o1
Specifies the symbology identifier (if any) that Anv sinale
is sent by the decoder when parameter Send XSCI?
User ID Code ID (Index 0025) is set to 3. "ASCII" code | 0523 'E' 'E' 'E'
. e o character
zero (null) is used to indicate that an identifier (00 = Off)
is not to be sent for the symbology. -
UPC/EAN Extensions Enter 1 for On
and 0 for Off.
Enable 2- Requires a 2 digit extension (supplemental
Digit Exten- | label) to be verified for a successful decode of | 051C On/ Off Off On On
sions a label.
Enable 5- Requires a 5 digit extension (supplemental
Digit Exten- | label) to be verified for a successful decode of | 051D On/ Off Off On On
sions a label.
Instructs the decoder to require any enabled
Require UPC/EAN extensions (supplemental labels) to
Extensions be with a label in order for a scan to be suc- 051F On /O ot Of ot
cessful.
Sets the number of times an extension (sup-
Read Verifi- | plemental label) must be read before it is )
cation included in the transmission of the base UPC/ 0528 01-04 o1 o1 o1
EAN label.
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Table F-3. Other Controls

Other Controls Enter 1 for On and 0 for Off.
Enable Label Enables/disables the ability to per-
Programming form label programming. FF00 On / Off On | On On
00 = Off
00-09
. (01 = Lowest;
Beeper Volume | Adjusts the beeper volume. FF20 07 = Highest 07 07 07
08 = Higher;
09 = Lower)
Long Range Selects the Long Range Trigger 0000 Og - Rg?fa_se off | off off
Trigger Mode mode. can it =
Spot Timeout
:g:;tli:g Beam Enables/disables the Spotting Beam 0001 On/ Off On | On On
00 = 0.25 sec.
. . 01=0.5sec.
Spotting Beam | Sets the duration of the spotting ~
Timeout beam before it automatically turns off. 0023 | 02=1.0sec. o1 01 0f
03 =1.5sec.
04 =2.0 sec.
Release Scan Sets the duration of the scan before it
Timeout turns off. 0024 1-10 02 | 02 02
Number of Determines the number of beeps for
Good-Read d read indicat 0020 01-04 01 01 01
Beeps a good read indicator.
Good-Read Adjusts the pitch of the beeper fre- 00-07
Beep Tone quenc 0021 | (00 =Lowest; | 00 00 00
y 07 = Highest)
00 = 0.07 sec.
Good-Read Determines the duration of a good 01=0.13 sec.
Beep Duration | read beep. 0022 | 0o -g1gsec. | 0 | 0 | 00
03 =0.36 sec.
Specifies the symbology identifier (if
any) that is sent by the decoder when 00 = Off
Send Symbol- parameter Send Code ID (Index 0025 01 =DLM IDs* 00 01 00
ogy Identifiers 0025) is set to 3. "ASCII" code zero 02 = AIM IDs
(null) used to indicate an identifier not 03 = User IDs
to be sent for the symbology.
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Bar Code Parameters

Label Prefix

Any single

Indicates a label prefix. 0026 ASCIItg?arac- N;)n Ngn None

(00 = Off)

Label Suffix

Any single

Indicates a label suffix. 0027 ASC”tg:‘arac' cR | cR | cR

(00 = Off)

Table F-4. Datalogic Label IDs

UPC-A=A Code 128 =K Trioptic = X

UPC-E=E [20f5=B Pharmacode 39 =Y
EAN-8=G S20f5=F GS1 DataBar-14 =P
EAN13=M M2of5=D GS1 DataBar Limited = Q
Code 39=C Code 93=L GS1 DataBar Expanded = R
Codabar = | MSI = H

Table F-5. ASCII/Hex Conversion Table

NUL 00 SP 20 @ 40 60
SOH 01 ! 21 A 41 a 61
STX 02 ‘ 22 B 42 b 62
ETX 03 # 23 C 43 c 63
EOT 04 $ 24 D 44 d 64
ENQ 05 % 25 E 45 e 65
ACK 06 & 26 F 46 f 66
BEL 07 & 26 G 47 g 67
BS 08 ( 28 H 48 h 68
HT 09 ) 29 | 49 i 69
LF 0A * oA J 4A j 6A
VT 0B ¥ 2B K 4B k 6B
FF 0C , 2C L 4C | 6C
CR 0D 2D M 4D m 6D
SO OF oF N 4E n 6E
S| OF / oF 0 4F 0 6F
DLE 10 0 30 P 50 p 70
DC1 11 1 31 Q 51 q 71
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ASCII Hex ASCII Hex ASCII Hex ASCII Hex
DC2 12 2 32 R 52 . 72
DC3 13 3 33 S 53 s 73
DC4 14 4 34 T 54 { 74
NAK 15 5 35 u 55 u 75
SYN 16 6 36 v 56 v 76
ETB 17 7 37 W 57 w 77
CAN 18 8 38 X 58 X 78
EM 19 9 39 Y 59 y 79
SUB 1A : 3A Z 5A z 7A
ESC 1B : 3B [ 5B { 7B
FS 1C < 3C \ 5C | 7C
GS 1D = 3D ] 5D } 7D
RS 1E > 3E A 5E - 7E
us 1F ? 3F _ 5F DEL 7F
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Overview

Appendix G
Programming Bar Codes

This appendix provides bar codes for common setup parameters for programming the
Pegaso. Factory default settings are OUTLINED.

To make settings that are not provided in the chapter, you can design custom bar codes

to program the Pegaso. Refer to "Configuring the Pegaso", on page 2-1.

1D Symbologies

Symbologies and bar code setup parameters included in this appendix are:

OTE

"Predefined Defaults" on page G-2.
"Codabar" starting on page G-2.

"Code 39" starting on page G-5.

"Code 93" starting on page G-7.

"Code 128" on page G-8.

"EAN-13" starting on page G-9.
"EAN-8" on page G-11.

"GS1 DataBar-14" on page G-12.

"GS1 DataBar Limited" on page G-12.
"GS1 DataBar Expanded"” on page G-12.
"Interleaved 2 of 5" on page G-14
"Matrix 2 of 5" on page G-16

"MSI" starting on page G-18.
"Pharmacode 39 (Code 32)" on page G-20.
"Standard 2 of 5" starting on page G-20.
"Trioptic" on page G-22.

"UPC-A" starting on page G-23.
"UPC-E" on page G-24.

"UPC/EAN Extensions" on page G-25.
"Other Controls" starting on page G-25.

Depending on which Pegaso options you have, some programming parameters may not

‘ / be available on your unit. Refer to Table F-2 on page F-3 for specific details on which
parameters are applicable.
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Predefined Defaults

]/ FF39FFZ3F* /] FF3CFF3F*

Restore
From
Registry
*/ | FF 3 AFTF3F* */ | FF 3D *
Save To
Registry
*/ | FF 3 BFFJ3F* */ | FF 3 F*

Codabar

ENABLE
On Off

on
*/ /1 03001FFJ3E?™ */ / 03 00O0FFZ3E ™

ENABLE AGGRESSIVE DECODING

0]
*/ /1 0301 1FFZ3E™ */ /03 010FFJ3E*™

ENABLE CHECKSUM
On Off

on
*/ / 03021FFZ33E*™ */ 1/ 03 020FFJ3E™

SEND CHECKSUM

Minimum

Maximum

Factory

n Off

Off

On
|‘““”|”|/”|||!l‘llj"”!|||L|H||J‘|‘|!"||!Hllmlllm‘ll‘ R R L

SEND START/STOP

n Off

0] Off
*/ /1 03051FFJ3E™ */ / 03 050FFZ3E ™~
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Codabar

CONVERT TO CLSI

n Off

0] Oft
*/ / 03 06 1FFZ3E"* */ / 03 06 0FF 3E*

ALLOW WIDE INTERCHARACTER GAPS
On off

n
*/ 1/ 0307 1FFZ3EF™ */ / 0307 0FFZS3E*™

MINIMUM LENGTH

1 30

*/ /1 03 2001FFJ3E* */ [/ 03 2030FFJ3E*
4 40

*/ / 03 2004FFJ3E* */ [/ 03 2 040FF3E*
10 50

*// 03 2010FFJ3E* */ [/ 03 2 050FTFJ3E*
20

*/ / 03 2020FF3E*

MAXIMUM LENGTH

1 30
*/ /03 2101FFZ3E?"”* */ / 03 2130FFJ3E?"~
10 40
*/ /03 2110FFZ3E"”* */ / 03 2140FFJ3E"~
50
// 0321 20FFJ3E?"* */ / 03 2150FFZ3E*”*
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READ VERIFICATION

1 3
*/ / 03 22 01FFJ3E* */ / 03 2203 FF 3 E *
2 4
*/ [/ 0 3 22 02 FF 3E* */ / 03 22 04FF 3 E *
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Code 39

Code 39

ENABLE
On off

n
*/ /01 001FFZJ3E"* */ / 0100O0FFS3E ™

ENABLE AGGRESSIVE DECODING

0 off
777701 011FF3E * 777 01010FFG3E *

ENABLE CHECKSUM
n

0 off
*/ /7 01021FFZ3E?" */ / 01020FTFZ3E*

SEND CHECKSUM

n

Off

On
*/ /1 01031FFJ3FE* *// 0103 0FF3E*

FULL ASCII MODE

off

On
*/ / 01051FFJ3E™ */ / 01 050FF3E*~

MINIMUM LENGTH
1

30
// 012001FF3E* */ /] 01 2030FTFJ3E*

*

10 40
*// 01 2010FFJ3E?"* */ / 01 2040FF3E*
20 50
* /01 2020FFJ3E?"~* * /01 205O0FFJ3E?"*
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MAXIMUM LENGTH

1 30
*// 01 2101FFZ3E?"* *// 01 2130FFZ3E"”*

10
* /01 2110FFZ3E?"*
20
* /01 2120FFZ3E™

READ VERIFICATION

/1 012201FF3E?"*
2
*/ / 01 2202FFJ3E*

—

l——

» —

50
3
4

40
*

/0121 40FFJ3E?"~

/01 2150FFZ3E ™~

/1 01 2203FF3E"™

// 01 2204FFJ3E"*

G-6
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Code 93

Code 93

ENABLE

n

0

ENABLE AGGRESSIVE DECODING

n

0]

MINIMUM LENGTH

2

10
20

// 04 2010FFZ3E"”
// 04 2020FFJ3E"*

MAXIMUM LENGTH

2 30
*/ / 04 2102FFJ3E?"* */ / 04 2130FFZ3E”*

10
20

~ —_—

/04 2110FFZ3E"™
/0421 20FFJ3E?"™~

~ —

READ VERIFICATION

1 3
*/ / 042 201FFZ3E”* */ / 042 203FFJ3E*”*
2 4
*/ 1/ 042 202FF3E* */ / 042 204FF3E*™

Off

/1 04001FFJ3E"™ */ / 0400O0FF3E"”

40
50

40
50

Off
L RO
// 04011FF3E?" */ / 04010FTFTJ3E*
30
M0 RRACRAR TR ORD O A TA A A EAERT
/10 42002FTFTJ3E* * /7 /7 042030FTFTJ3E*

/1 04 2040FFJ3E?"*
/1 042 050FTFJ3E*

// 0421 40FFJ3E"*
/1 04215 0FFJ3E?"*
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Code 128

ENABLE

On Off

on
*/ / 0408 1FFJ3E"* */ / 0408 0FF3E*~*

ENABLE AGGRESSIVE DECODING

0]
*/ / 040 91FFZ3E"* */ / 0409 0FF3E ™~

ENABLE UCC/EAN-128

n Off

n Off

0] Oft
*/ / 04 0CH1TFFJ3E"™* */ / 04 0CO0FFZ3E"*

ISBT CONCATENATION
On Off

on
1/ 040E1FFGJ3E* 7/ 040EO0FFZS3E*
MINIMUM LENGTH

1 30

*/ / 042 401FFZ3E"”* */ / 042 43 0FFZ3E"”*
40

// 04 2 40 2FFJ3E"”* */ / 042 4 40FF3E*”*

10 50

*/ 1/ 042 410FF3E* */ |/ 042 45 0FF3E*

20

*/ / 042 42 0FF3E*”
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EAN-13

MAXIMUM LENGTH

1 30
*/ / 0425 01FFZ3E"”* */ / 0425 30FFZ3E*
10 40
*/ / 04 2510FFZ3E"”* */ / 0425 40FFZ3E*

20

50
/1 0425 20FF3E* */ 1/ 04255 0FF3E*

*

READ VERIFICATION
1 3

*/ / 04 2 6 01 FF3E * */ / 0 4 26 03 FF3FE*
2 4
*/ / 04 2 6 02 F F 3 E * */ |/ 0 4 26 04 FF 3 E *

EAN-13

ENABLE
Off

On
*/ / 05101FFZ3E*~ */ / 05100FF3E*

ENABLE AGGRESSIVE DECODING

0]

SEND CHECK DIGIT

n Off

Off

On
*/ /7 05121FFJ3E™ */ / 05120FF3E*~
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SEND SYSTEM DIGIT
Off

On
*/ / 05131FFZ3E"* */ / 05130FF3E*~

CONVERT EAN-13 TO ISBN
off

On
*/ /1 0514 1FFJ3E* */ 1/ 0514 0FF 3 E *

CONVERT EAN-13 TO ISSN
Off

On
*/ / 05151FFZ3E* */ / 05150FF3E*~

ENABLE EAN 4-DIGIT PRICE/WEIGHT CHECK DIGIT
Off

On
*/ /1 0516 1FF3E™ */ 1/ 0516 0FF3E ™~

ENABLE EAN 5-DIGIT PRICE/WEIGHT CHECK DIGIT
Off

On
0]
f
*/ / 051 71FFZ3E"* */ / 0517 0FF3E*~

READ VERIFICATION

1 3
*/ |/ 052 4 01FF3E * *
2 4
*/ |/ 05 2 4 02 FF 3 E * *

/ 052 403FFJ3E"*
/ 0526 04FFJ3E"*

——
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EAN-8

EAN-8

ENABLE

On
/70518 1FFZJ3E"*

ENABLE AGGRESSIVE DECODING

0
*/ / 051 91FFZ3E*

SEND CHECK DIGIT

On
/105 1TA1TFF3E*

CONVERT EAN-8 TO EAN-13

On
*/ /1 05 1B1FF3FE*

READ VERIFICATION

1

// 0526 01FFZ3E"”*
2

*/ / 0526 02FFZ3E*

n

o I——

Off

*/ / 05180FF3E"”*

Off

*/ 1/ 05190FFZ3E ™~

Off

*/ / 051 A0FFZ3E"*

Off

*/ / 051BO0FFZ3E"”

3
]
4

/ 0526 03FF3E"*
/ 0526 04FFJ3E?"*

a———
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GS1 DataBar-14

ENABLE
Off

On

ENABLE GS1 DataBar-14 to UCC-128

On off
*/ / 0 8 041 FF3E * */ |/ 0 8 04 0FF 3 E *

GS1 DataBar Limited

ENABLE

On
71008

ENABLE GS1 DataBar Limited to UCC-128

On off
*/ / 08 0C1FF3E * */ / 0 8 0COFF 3 E *

GS1 DataBar Expanded

Off
81 FF3E "~ */ / 08 08 0FF 3 E*~

0

ENABLE

Off

On
*/ / 081 01FFJ3E*™ */ / 0810O0FF3E*™

ENABLE GS1 DataBar Expanded to UCC-128

off
// 081 41FF3E"™ */ 1/ 081 40FF3E*

n

0
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GS1 DataBar Expanded

MINIMUM LENGTH

1 45
*/ / 08 2 4 01FF3E* */ |/ 0 8 2 4 45 FF3E*

15 6
*/ / 08 2 415FFZ3E”* * / 082 46 0FF3E ™
4
/ 082 47 4FFJ3E?"*

30 7
* / 082 43 0FFJ3E "~ *
MAXIMUM LENGTH
1 4
*/ / 08 2501FFZ3E?"”* */ / 08 25 45 FFJ3E*”*
15 6
*/ / 08 2515FFZ3E*”* */ / 08 256 0FFJ3E”*
/ 08257 4FFJ3E?"*

0

~ —

—~—

/

5

0 74

3 4
* / 08 25 30FFJ3E "~

o

/
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Programming Bar Codes

Interleaved 2 of 5

ENABLE
On

n
*/ /02101 FFZ3E?"*

ENABLE AGGRESSIVE DECODING

0
*/ /02111 FFZ3E*™

ENABLE CHECKSUM

On
*/ /1 021 21FF3E*

SEND CHECKSUM

On
*/ 1/ 021 31FF3FE*

ENABLE CASE CODE

On
* /7 / 021 41FFZ3E*

MINIMUM LENGTH

n

Off

*// 02100FFZ3E"*

Off

*/ /1 02110FFZ3E™~

Off

*/ / 021 20FFZ3E"”*

Off

*/ / 02130FFZ3E"”

Off

*/ / 021 40FFZ3E"”

2 30
*/ /1 0228 02FF3E* */ /1 0228 3 0FF3E*

// 02 28 06 FF3E "~
*/ / 02281 0FFJ3E"”~
* /0228 20FFS3E ™~

40
*/ 1/ 0228 40FF3E*

50
*/ / 0228 50FF3E*
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Interleaved 2 of 5

MAXIMUM LENGTH

2 30

*/ |/ 02 2 9 0 2 FF 3 E * */ |/ 02 2 9 3 0FF 3 E *
10 40

*/7 / 022 910FF3E * */ / 02 2 94 0FF 3 FE *
20 50

* / 02 2 9 2 0FF 3 E * * / 022 95 0FF 3E *

READ VERIFICATION

3

/ 02 2 A01FF3E* */ /] 022 A03FFJ3E*
4

/ 022 A02FFJ3E* */ |/ 022 A04FF 3 E *

/ /

*_ =1
~ ——

2

~ —
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Programming Bar Codes

Matrix 2 of 5

ENABLE

On
*/ / 0208 1FFJ3E"*

ENABLE AGGRESSIVE DECODING

0]
*/ / 0209 0FF3E ™

ENABLE CHECKSUM

On
/7 020A1FFJ3E"*

SEND CHECKSUM

On
1/ 020B1FFJ3E*

MINIMUM LENGTH

1
// 022 401FFJ3E?"*

6
7/ 022406FFS3E*

n

/

20
*/ / 022 420FFZ3E"”*

Off

*/ / 02 08 0FF 3E*~

Off

/1 02091FFJ3E"™

Off

*/ / 02 0AO0FF3E ™

Off

*/ / 02 0BOFFJ3E"*

30
* / 022 430FFJ3E"*
40
*/ / 022 4 40FF3E"”*

~ —_—

10 50
*// 022 410FFZ3E"” */ / 02245 0FF3E"”*
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Matrix 2 of 5

MAXIMUM LENGTH

1 30
*/ / 0225 01FFZ3E?”* */ / 02253 0FFJ3E”*

10
*/ /1 022510FF3E*
20
* / 0225 20FF3E?"”

READ VERIFICATION

// 0226 01FFJ3E"”*
2
*/ / 0226 02FF3E*

/

1

o+ I——

40
50
3
4

~ —_—

~ —_—

/
/

/0225 40FFZ3E ™
/ 02255 0FFJ3E"*

/ 0226 03FFJ3E"*
/ 0226 04FFJ3E"”*
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Programming Bar Codes

MSI

ENABLE

Off

On
*/ )/ 06 081 FF 3 E * */ / 06 08 0 FF 3E *

ENABLE AGGRESSIVE DECODING

On off
*/ / 06 091FF3E* */ |/ 06 09 0FF3E *

REQUIRE 2 CHECK DIGITS

On off
*/ / 06 0 A1FZFS3E* */ / 06 0 AOFFS3E*

SEND CHECK DIGITS
off

On
*/ / 06 0B 1FF3E* */ / 06 0B OFF3E*

2ND CHECK DIGIT MOD 11
off

On
*/ / 06 0C1FFJ3E* */ / 06 0COFF3E*

MINIMUM LENGTH

1 10

*/° 706 2 401FFZ3E * */7°7 06 2410FTF23E *
4 12

*// 06 2 404FTF3E* * / 06 2412FFZJ3E*
7 15

*/ /706 2 407TFTFZ3E * */°/J 06 2 415FTFS3E*
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MSI

MAXIMUM LENGTH

1 10
*7°7062501FFS3E * 7706 2510FFZ3E*

4
*
7

/

/ 06 25 04FFZ3E*
/ 06 2507FF3E?"”

READ VERIFICATION

1
2

~—

~——

/ 06 26 01 FFJ3E?”~
/ 06 26 02FF3E?"”*

15
3
4

12
*

/
/

/ 06 2512FFZS3E*™
/ 06 2515FF3E"*

/ 06 26 03 FF3E"*
/ 06 26 04FFJ3E "~
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Programming Bar Codes

Pharmacode 39 (Code 32)

ENABLE

On
*/ /011 01FFS3E*

SEND CHECKSUM

On
*/ / 011 21FF3E*

SEND START/STOP

On
*/ /011 31FF3E*

Standard 2 of 5

ENABLE

On
*/ /1 02 001FFJ3E*

ENABLE AGGRESSIVE DECODING

0]
*/ /02 011FFZ3E™

ENABLE CHECKSUM

On
/770202 1FF3E*

SEND CHECKSUM

On
/7 02031FFJ3E*

n

off

*// 01100FF3E"*

Off

*/ /011 20FFZ3E"*

Off

*/ /0113 0FF3E"*

Off

*/ /1 02 00O0FFZ3E™

Off

*/ / 02010FFZ3E"™

Off

*/ / 02 020FF3E*™

Off

*/ / 0203 0FF3E"*

G-20

Pegaso™ Industrial PDA with Windows® CE



Standard 2 of 5

USE 2-BAR START/STOP
Off

On
*/ / 02041 FFJ3E"* */ / 02 040FF3E*™

MINIMUM LENGTH

1 30
// 02 2001FFJ3E?"* */ / 02 2030FFJ3E?"”*

6 40
*/ | 02 2 0 06 FF 3 E * */ |/ 02 2 0 4 0F F 3 E *
10 50
*/ / 022 010FF3E * */ / 02 2 05 0FF 3 E *

20
*/ / 022020FF3E"”

MAXIMUM LENGTH

1 30
*/ / 0221 01FFJ3E* */ / 02 21 3 0FF3E *
10 40

*/ / 0221 10FF 3 E * */ / 02 21 4 0FF 3 E *
20 50

* /] 0221 20FF 3 E * * /] 02 2150FF3E *

READ VERIFICATION

1 3
* / 022 2 01FFJ3E * */ |/ 02 2 2 0 3 FF 3 E *
2 4
* / 02 2 2 02 FF 3 E * */ |/ 02 2 2 0 4 FF 3 E *
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Programming Bar Codes

Trioptic

ENABLE

Off

On
*/ / 0108 1FF 3 E * */ / 0108 0F F 3 E *

ENABLE AGGRESSIVE DECODING

0]
*/ /01 091FFZ3E*™ */ 1/ 01090FFS3E ™~

READ VERIFICATION

n Off

1 3

*// 01 2 4 01FFJ3E * */ / 01 2 4 0 3 FF 3 E *
2 4
*/°7° 012 402FFTJ3E * */°7° 012 404FFGJ3E*
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UPC-A

UPC-A

ENABLE
Off

On
*/ / 05 001FFJ3E*~ */ / 05 00O0FF3E™

ENABLE AGGRESSIVE DECODING
n Off

0 Off
*/ / 05 011FFZ3E*™ */ 1/ 05010FFZ3E ™~

SEND CHECK DIGIT

Off

On
*/ / 05 021FF3E* */ / 05 02 0FF3E*

SEND SYSTEM DIGIT
Off

On
*/ / 05031FFZ3E™~ */ / 05 030FF3E"”

CONVERT UPC-A TO EAN-13

Off

On
*/ /1 0504 1FF3E* */ / 05 04 0FF 3 E *

READ VERIFICATION

| |

3

*/ / 05 2001FFZ3E"”* */ / 05 2003FF3E*
2 4
*/ / 05 2002FFS3E* */ / 05 2004FF3E"”~
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Programming Bar Codes

UPC-E

ENABLE SYSTEM DIGIT 0

On
/770508 1FFZJ3E*

ENABLE AGGRESSIVE DECODING

0]
*/ / 05 091FFZ3E*™

SEND CHECK DIGIT

On
*/ /1 05 0A1FFJ3E*

SEND SYSTEM DIGIT

On
*/ /1 05 0B1FFJ3E*

CONVERT UPC-E TO UPC-A

On
*/ / 05 0C1FFJ3E*

READ VERIFICATION

n

1

*/ / 05 2201FFZ3E?"”*

2
*/ / 05 2202FFJ3E?”*

Off

*/ / 0508 0FF3E*

Off

*/ / 0509 0FF3E*™

Off

*/ [/ 05 0A0FFS3E"™

off

*/ / 05 0BOFFS3E ™

Off

*/ / 05 0CO0FFS3E ™

3

*/ |/ 05 22 03 FF 3E *
4
*/ |/ 05 2 2 04FF 3E *
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UPC/EAN Extensions

UPC/EAN Extensions

ENABLE 2-DIGIT EXTENSIONS
Off

On
*/ / 051 C1FFZ3E?*™* */ / 051 CO0FFZ3E"*

ENABLE 5-DIGIT EXTENSIONS

0]
*/ / 05 1D1FFZ3E* */ / 051 DO0OFF3E*~

REQUIRE EXTENSIONS

n Off

Off

On
*/ /1 051F1FFJ3E* */ / 051 FO0OFFJ3E*

READ VERIFICATION

3
// 0528 01FFJ3E"* */ / 0528 03FF3E*
2 4
*/ / 0528 02FF3E*”* */ / 0528 04FF3E"”*

Other Controls

> EEE— . |
—

BEEPER VOLUME

* /! FF20O0O0FTFJ3E?"™
*/ / FF20O01FFZ3E?"*
/1 FF20O04FFJ3E?™

~ —

Medium

*
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Programming Bar Codes

Highest

Higher

(Increases the current
value one increment
higher)

Lower
(Decreases the current
value one increment lower)

*
*

—— ——

——————

/ FF20O07FFZ3E"™
/ FF20O08FFS3E™
/ FF2009FFS3E™

NUMBER OF GOOD-READ BEEPS

*
*
*
*

/

/ 002 001FFJ3E"*
/ 002002FTF3E*
/ 002003 FF3E ™
/ 002 004FF3E ™

GOOD-READ BEEP TONE

Lowest

Medium

Highest

*
*

——

-

/ 002100FF3E"™
/002103FTFJ3E*

*/ /1 002107FF3E*™
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Other Controls

GOOD-READ BEEP DURATION (IN SECONDS)

*/ / 002 200FF3E*™
*/ / 02 2001FFZ3E"*
* / 002 202FF3E?"*
*/ /1 002203FF3E"™

Long Range Trigger Mode

*/ / 00O0O0OOFFZ3E "™
*/ / 00O0O1TFFJ3E™

Spotting Beam Enable

*/ / 00O011FFZJ3E™~
*/ / 00O01O0FFZ3E"™

Spotting Beam Timeout

* / 00 2 3 00FF3E ™
* /02 2001FFZ3E*™
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Programming Bar Codes

*/ / 002 302FFJ3E"”*
*/ / 002 303FFJ3E"*
* / 002 3 04FFJ3E"~

Release Scan Timeout (IN SECONDS)

* / 002 401FFZ3E*™
* / 002 402FTFJ3E*
*/ / 002 403FF3E*
*/ / 002 405FFZ3E*
*// 002 410FFZ3E?"~

——

~ —

~ —
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Other Controls

SEND SYMBOLOGY IDENTIFIERS

*/ / 002 500FF3E*™

DLM IDs

AIM IDs

User IDs

LABEL PREFIX

*
*

/0 0 2 5
/0 0 2 5

01 FF3E "™
02 FF3E"*

*/ / 002503FF3E*™

*/ / 0026 $MFFJ3E*
/ 0026 %I FFZ3E?*™*

(TAB)

None

LABEL SUFFIX

(CR)

(TAB)

None

*
*

*
*
*

/
/

/

/ 0 0 2 6

/0 0 2 7
/00 2 7
/00 2 7

%

UFF3E?"™

$ MFF 3 E *

%

$ 1 FF3E*™
UFF3E?"™

Product Reference Guide

G-29



Programming Bar Codes

NOTES
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Appendix H
Glossary

Many definitions for this Glossary were taken directly from the Microsoft Developer’s
Network website at http://msdn.microsoft.com/library/default.asp.

1D bar code

2D bar code

4-way rocker key

active notification

active window

ActiveSync

AP

ASCII

AutoCAB

AutoCE

Batch units

A traditional linear bar code. The code itself contains no information about the
item to which it is assigned but represents a string of identifying numbers or let-
ters.

Two-dimensional (2D) bar codes permit the encoding of information about an
item in addition to an identifying code. Two axes, or directions, are used for
recording and reading the codes and the bar size is reduced, increasing the
space available for data.

Refer to "navigation key".

The state of a user notification from the time the user is notified until the user
handles the event.

The window in which a user is currently working or directing input. An active
window is typically on top of the Z order and is distinguished by the color of its
title bar.

Microsoft Windows Communication application that synchronizes a Windows
CE device with a Microsoft Windows-based host PC. ActiveSync can use RS-
232, USB, and Wireless networks.

Access Point used for RF applications.

American Standard Code for Information Interchange; a code for information
exchange between computers made by different companies; a string of 7 binary
digits represents each character; used in most microcomputers. Any member of
the standard code for representing characters by binary numbers. Refer to
Table F-5 on page F-15.

The AutoCAB program allows the Pegaso to automatically reinstall selected
applications when the terminal is cold reset. When the Pegaso is rebooted, the
AutoCAB program runs automatically and determines if it is a warm or cold
reset.

The AutoCE program allows the user to create a list of applications to run when
the Pegaso is rebooted. Each application may be designated to run only on a
cold reset, or on both warm and cold resets. The applications run sequentially,
allowing interdependencies to be handled.

Batch Pegaso units are synchronized and updated using Microsoft ActiveSync
software and a dock for communication with the host PC.
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Glossary

Bluetooth

calibration

checksum

CLSI

command band

command bar

CompactFlash

Concatenate

control

context sensitive
help

control panel

Datalogic Configu-
ration Utility (DCU)

Datalogic Desktop
Utility (DDU)

Datalogic Firm-
ware Utility (DFU)

device manager

A short-range radio technology for Internet and mobile devices, aimed at simpli-
fying communications among them.

You may need to calibrate the touch screen. One way to know that the touch
screen needs to be calibrated is that you will notice that when you attempt to
select one item with the stylus, another item is erroneously selected.

A number used to verify the contents of a data file. This number is generated by
calculating the contents of the data. If the calculated checksum is different from
the expected checksum, the data has errors in it.

CLSI, Inc., developer of the “LIBS 100 scanning and decoding system”. The
“’Convert to CLSI" parameter refers to formatting a Codabar bar code label in
the manner defined by CLSI, Inc.

A rebar control with a fixed band at the top that contains a toolbar with a Close
(X) button, an OK button, and optionally a Help (?) button in the upper right cor-
ner.

A control window that can contain buttons, combo boxes, and menu bars. Win-
dows CE-based applications can use a command bar rather than a separate
menubar and toolbar to efficiently use available screen space.

A CompactFlash (CF) card is a popular memory card developed by SanDisk in
1994 that uses flash memory to store data on a very small card.

To arrange (strings of characters) into a connected list.

A standardized part of the window that can be manipulated by the user to per-
form an action or display information. The most common controls are buttons
that allow the user to select options and scroll bars that allow the user to move
through a document or position text in a window.

Tap “?” to open a help dialog about the specific windows application you are
using. Context sensitive help can tell where you are in a program and can pro-
vide assistance with the specific problems you might be having.

Control Panels are several different applets that allow you to configure the
Pegaso to meet your specific requires. There are control panels for scanning,
keyboard, display, etc. Access the control panels at Start > Settings > Control
Panel.

A Datalogic Windows-based field configuration mechanism, compatible with
Wavelink Avalanche™. See page 3-12.

Datalogic® Desktop Utility (DDU) allows Datalogic Mobile Windows® adminis-
trators to configure Windows®CE Pegasos to control individual user access.

A Datalogic Windows-based field upgradeable firmware mechanism. Use the
Datalogic Firmware Utility (DFU), described starting on page 3-8, to install or
update the firmware using an "ActiveSync" connection.

A tool to track all loaded device drivers and their interfaces. It issues notification
of the appearance, disappearance of device interfaces, loads and tracks drivers
by reading and writing registry values, and unloads drivers when their devices
are no longer needed.
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device partnership

embedded

firmware

FlashFX

GPRS

GSM

gripper bar

host PC system

Infrared Data Asso-
ciation

input method (IM)

input panel

ISBN

ISSN

A registry key on a "Windows CE" device that a desktop computer uses to iden-
tify the device when it is connected. The key defines values for synchronization,
file conversions, and backup and restore information, which enable multiple
"Windows CE" devices to connect to the same desktop computer. A device part-
nership is created the first time you connect a "Windows CE" device to a host
PC.

Broadly, software code or commands built into a device, as opposed to software
that is added. In a narrower sense, code that is typically stored in ROM and ded-
icated to either controlling a device or providing a specific functionality.

Operating System on the Pegaso.

Persistent Flash Memory management system made by Datalight™. Data in the
flash memory is retained when a battery pack is fully discharged. The backup
battery must be charged to retain flash memory.

General Packet Radio Services (GPRS) is a packet-based wireless communica-
tion service that promises data rates from 56 up to 114 Kbps and continuous
connection to the Internet for mobile phone and computer users. GPRS is
based on Global System for Mobile (GSM) communication and complements
existing services.

GSM (Global System for Mobile communication) is a digital mobile telephony
system. GSM uses a variation of time division multiple access (TDMA) and is
the most widely used. GSM digitizes and compresses data, then sends it down
a channel with two other streams of user data, each in its own time slot.

A gripper bar is a tall, thin rectangle with a dark stripe running through it that
appears on a rebar or a command band control. By touching and dragging a
gripper bar with a stylus, a user can reposition a rebar or command bar. Gripper
bars are especially useful for bringing off-screen rebar or command bar controls
into view.

PC using the Microsoft Windows operating system and "ActiveSync".

The industry organization of computer, component, and telecommunications
vendors who have established the standards for infrared communication
between computers and peripheral devices such as printers. Windows CE sup-
ports the IrDA standard through the Winsock API. Windows CE-based applica-
tions that communicate over serial cables using the Winsock APl communicate
over IrDA-compliant infrared links with only minimal reprogramming.

A component that allows the user to input text using a touch screen.
Refer to "soft input panel (SIP)".

International Standard Book Number. A unique number assigned to each book
to allow ease of ordering from any source: local bookstore, online book dealers,
or directly from the publisher. The ISBN number is usually printed on the back
cover of a book near the bar code, but can also appear within the book.

International Standard Serial Number. An ISSN consists of eight digits compris-
ing two groups of four digits each, separated by a hyphen. The eighth digit is a
check digit used as a computer validity check; it consists of a number between 0
and 9 or an uppercase X (for the arabic numeral 10).
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Glossary

MIB (Management
Information Base)

mounted file sys-
tem

navigation key

Network ID

non-persistent
state

object store

portable data
assistant (PDA)

portable data ter-
minal (PDT)

Persistent Memory

persistent state

PRG

program memory

RF card

QRG

A Management Information Base (MIB) is a file that defines a set of "SNMP
(Simple Network Management Protocol)" variables, their types and usage.
There are a number of standard MIBs available, depending on the information
being managed. The MIB is used by the management tools to allow them to bet-
ter support the configuration values provided on the terminals, such as scanner
controls and terminal type information.

A file system located on a removable medium, such as a PC Card storage
device. The operating system loads, or mounts, the file system when the
medium is inserted into the device. It unloads, or unmounts, the file system
when the medium is removed or when the user issues a command to do so.

A large navigation button (4-way rocker key) on the keypad with 4 arrows: point-
ing up, down, left, and right that allows the user to move the cursor or high-
lighted text entry during menu selection. Press and release one edge of the key
to move the display screen one line or one character in the direction of the
arrow.

Here used to mean that you should configure the Windows user settings, such
as the user name, password, and domain name. Microsoft’s definition includes
some wireless network IDs as equivalent to SSIDs.

A non-persistent state affects only the next keypress. FN state is a non-persis-
tent state.

The persistent storage that Windows CE makes available to applications. For
example, Windows CE reserves part of its available RAM for the operating sys-
tem and uses the rest for the object store. This data can be stored in files, regis-
try entries, or Windows CE databases.

A handheld Windows-based (Pocket-PC or Windows CE) computer that can be
synchronized with a host PC to share files and data. Sometimes contains an
infrared device to beam information to another unit.

An industrial strength handheld computer with a keypad, navigation keys, and a
bar code scanner used in inventory, retail, and warehouse activities to collect
data and upload it to a host PC.

Persistent Memory is the Pegaso’s flash application and file storage area.
The persistent storage memory persists across all reset (warm/cold reboot)
conditions and software / firmware updates.

A state which is maintained after releasing a key. Alpha mode is a persistent
mode. Also called a “sticky” state. A persistent state must be turned off by
pressing the key again.

Product Reference Guide.

Memory that is used for stack and heap storage for both system and nonsystem
applications. Nonsystem applications are taken from storage memory, uncom-
pressed, and loaded into program memory for execution.

A small card-shaped device installed in a Pegaso that allows wireless connec-
tion and communication with a network.

Quick Reference Guide.
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RAM (random
access memory)

ROM (read only
memory)

rebar

remote access
server (RAS)

RTC

Secure Digital (SD)
Card

shortcut menu

SNMP (Simple Net-
work Management
Protocol)

soft input panel
(SIP)

splash screen

start

status bar

status icons

stylus

suspend mode

You can add applications and data files to RAM or into Flash memory via the
"FlashFX" Disk. While Flash memory is persistent (as long as the backup bat-
tery is charged), RAM is not and will be cleared when you remove or replace the
battery. As you can only suspend the device, the only way to turn it fully off is to
remove the battery or to perform a cold reset.

The operating system ("Windows CE") and applications are pre-installed on
ROM and cannot be removed or modified. These applications are persistent.

A command bar with a gripper bar.

A feature that connects a device to a host computer. Windows CE can connect
to a remote access server using direct serial, infrared, and dial-up connections.
Windows CE supports the standard Microsoft Win32 RAS functions; however, it
allows only one connection at a time. RAS functions can be implemented for
direct serial connections or dial-up modem connections.

Real Time Clock on the PC.

A Secure Digital (SD) card is a tiny memory card used to make storage portable
among various devices. It features a high data transfer rate and low battery con-
sumption. An SD card is about the size of a postage stamp and weighs approxi-
mately two grams.

A menu that is displayed for a selected object. The menu contains commands
that are contextually relevant to the selection.

SNMP is the standard protocol for managing devices on a network. Simple Net-
work Management Protocol (SNMP) is a standardized protocol for network
management services using a client/server model. The network management
program (client) issues queries and commands to the remote device

Click on the Keyboard icon in the system tray to open the SIP. Use this virtual
QWERTY keyboard like you would a computer’s keypad to enter alpha numeric
and symbols in the current application.

An initial screen displayed by software, usually containing a logo, version infor-
mation, author credits, or a copyright notice.

The start button opens the Start menu. The Start menu contains a list of the res-
ident applications, applets, and utilities available to the user.

An area that displays state information for the content in the window, typically
placed at the bottom of a window.

A graphic representation of the status of a feature or function.

The stylus is the equivalent of a mouse on the Pegaso. Use the stylus on a
touch-sensitive display. Only a plastic tipped stylus should be used on a touch-
sensitive display.

Use the stylus to navigate the "touchscreen display", select characters in the
softinput panel (SIP), select applications from the desktop or system tray, select
tabs, fields and text within applications and dialog boxes.

The Pegaso will go into a suspend or sleep mode when it is idle for a period of
time. Suspend mode works and looks just like you have turned the unit off.
Press <Power> to suspend (put to sleep) the Pegaso. Press <Power> again for
the Pegaso to resume its previous state.
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Glossary

Symbology

system tray

system tray key-
board Indicators

task bar

touchscreen dis-
play

Tracert

Uniform Resource
Locator (URL)

usB

Web Server

Wi-Fi

Windows CE

XPING

A symbology is a protocol for arranging the bars and spaces that make up a par-
ticular kind of bar code. A bar code is made up of numbers, letters, and com-
puter-recognized characters that can be represented in a combination of bars
and spaces. There is not one standard bar code; there are currently over 400
bar code symbologies that serve different uses, industries, or geographic needs.

An area of the display screen located at the bottom, within the Task bar that dis-
plays status icons and symbols.

The System Tray Keyboard Indicators are located at the bottom of the display in
the "task bar" and contain "status icons" and symbols indicating open features
and active applets.

The Task bar at the bottom of the screen displays the "start" icon, an icon for the
active program, an icon for the current character, the current time, and system
icons for utilities loaded in memory, including the keyboard icon, which opens
and closes the "soft input panel (SIP)".

A graphical computer interface display screen that allows the user to enter and
select items with a "stylus".

Trace Route. A utility/command to determine TCP/IP packet routing.

The address of a resource on the Internet. URL syntax is in the form protocol.//
host/localinfo, where protocol specifies the means of returning the object, such
as HTTP or FTP. Host specifies the remote location where the object resides
and localinfo is a string, often a file name, passed to the protocol handler at the
remote location. Also called a Uniform Resource |dentifier.

Universal Serial Bus is a protocol for connecting PCs with peripheral devices,
including PDTs, PDAs, Pegaso mobile computers, cameras, printers, mice,
scanners, etc.

The web server can perform several different actions, including generating a
web page containing statistics relating to performance of the mobile computer
and creating an interface for interaction with the terminal to configure system
behavior.

Wi-Fi (short for "wireless fidelity") is a term for certain types of wireless local
area network (WLAN) that use specifications in the 802.11 family.

As per Microsoft, Windows CE combines an advanced real-time embedded
operating system with the most powerful tools for rapidly creating the next gen-
eration of smart, connected, and small-footprint devices.

XPing is a protocol that sends a message to another computer and waits for
acknowledgment, often used to check if another computer on a network is
reachable.
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SYMBOLS

... (browse)  B-9, B-12
.exefiles 3-6

NUMERICS

400 Invalid Syntax B-8
403 Request Forbidden  B-8

404 Object Not Found  B-

406 No Response Format  B-8
410 Page Doesn’t Exist B-8
4-way rockerkey H-1

500 Internal Server Error  B-8

501 Server Cant Do That B-8

A

Accessories  A-1
accessories

handle A-10
handstrap A-9
overview A-1
action B-6,B-13
active notification  H-1
active window H-1
ActiveSync  H-1
connection  3-9, H-2, H-3
copying filesusing  3-6
file synchronization  4-5
installing  4-1
network setup  4-8
partnership  4-4
purpose  4-2

remote  4-8

settings  4-6

setup  4-1

Start Menu  3-7
transferring files  4-4
using 4-4

version 4-2

INDEX

version required  4-2
add

new hotkey B-7
program B-12

address bar, enable  B-9
Admintab B-3

alignment, touchscreen  2-23
and 34
application B-6
adding B-12
authorized B-11
enable selector B

-11
selector B-10, B-13
tite B-12

applications  3-1

adding 3-5

overview  3-1

reboot list  H-1

removing 3-7
AppSelecttab  B-10
arguments  B-6, B-12
Assign as Default  B-9
associated function  B-6
audio, decoding properties  2-8
authorized applications  B-11
AutoCAB  H-1

AutoCE  H-1

Autoexec.ini  3-14
AutoStart  3-12

Autostart.ini  3-14
Installing CAB files  3-13
Weeload 3-13
Autostart.ini  3-14

backlight 2-2

bar codes
codabar G-8
code 128 G-8
code39 G-5
code93 G-7

decoding 2-10
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EAN-13  G-9

EAN-8 G-11

GS1 DataBar G-12
interleaved 2 of 5  G-14
label suffix ~ G-29
matrix20f5 G-16

MSI  G-18

parameters  F-3
Pharmacode 39 (Code 32) G-20
predefined defaults G-2
programming  G-1
standard2 of 5 G-20
symbologies  2-8, 2-9, 2-10, 2-11
trioptic  G-22

UPC/EAN extensions  G-25
UPC-A  G-23

UPC-E G-24

without parameters  F-2
battery

CAUTIONS 1-3,1-4
disposal  1-3,1-4

failure  1-3

window 1-3
lithium-ion ~ 1-3

tab 2-21
WARNINGS 1-2
Battery Pack A-2
beep

duration, good-read  F-14, G-27
good-read number  F-14, G-26
tone, good-read  F-14, G-26

volume F-14, G-25
beeps twice on reboot  3-10

Belt Clip  A-11
button
new B-12

OK B-2,B-5,B-7,B-12

X -2, ,B-7,B-12

C

CAB files
Installing  3-13
Interactive 3-14
cab files 3-5, 3-6
cable
serial E-2
calibration H-2
control panel  2-24
touchscreen  2-23
Car Charging Adapter  A-6
checksum H-2
clicking  i-vii

codabar 2-10, F-3, G-8
code 128  2-10, F-5, G-8
code 39 2-10,2-11, F-4, G-5
code 93 -10, F-4, G-7

code parameters  F-1, F-2
cold reset

reinstall applications  3-12, H-1
command band H-2

command bar H-2
communication

overview  4-1

configuration

backlight 2-2

decoding  2-

generaltab 2-8

symbologies tab 2-10, 2-11

o N

display 2-12
memory  2-25
overview 2-1
power 2-21
settings  2-1
sounds 2-26
volume 2-26
configure

connectors  E-1
connect to new device  4-2
connection

dialup 2-18,4-7
network 2-18, 4-7
overview 4-1
connector configurations  E-1
context sensitive help  H-2
control H-2
control panel  2-1, H-2
backlight 2-2

battery 2-21

calibration 2-24
date/time 2-7

decoding 2-8

options  2-8, 2-9, 2-10, 2-11
display 2-12

internet  2-1

keypad 2-17

owner 2-19
password 2-19
power 2-21

power gauge 2-21
regional settings  2-22
system 2-25
volume & sounds  2-26
controls, other F-14
copyrights  2-26
corrupted firmware 3-8
Couldn't Find Server  B-8

S
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Index

D

Datalogic H-2

Datalogic Config  B-5
Datalogic Configuration Utility = 3-12,
Datalogic Desktop Utility — 2-7, B-2
Datalogic Firmware Utility 3-8, H-2
Datalogic.omp 2-12

date, setting 2-7

H-2

DCU 3-12,H-2
DDU 27
decoding

configuration  2-8
decoding options  2-9
decoding properties  2-8, 2-9, 2-11
audio 2-8

configure  2-8
decoding options  2-9
devices 2-10
general options  2-9
settings 2-8

default parameters  E-1
factory E-1, E-2
maximum  F-1, F-2
minimum  E-1, F-2
predefined, bar codes  G-2
registy FE-2

defaults, restore  B-3, B-4
delay B-12

delete B-6,B-11
desktop B-9

device 2-10

name 2-26

device manager H-2
device partnership  H-3

DFU H-2

restoring firmware 3-8
DHCP 2-18

dialup connections  2-18, 4-7
display

configuration 2-12
control panel  2-12
DNS 2-18

dock

which Datalogic dock to use ~ A-2
document
conventions  i-vi
overview  i-v
domain  4-7
double-click  i-vii
double-tap  i-vii
driver

USB 4-3

EAN-13  2-10, F-6,

EAN-8 2 0, E-6, G_

edit B-11,B-12

email application  3-2

embedded H-3

enable 2-11
address bar  B-9
application selector  B-11
checksum  2-11
Datalogic Desktop  B-3
menu bar B-9
read-ahead 2-10
status bar B-9

toolbar B-9
enterkey B-7
error

400 Invalid Syntax  B-8

403 Request Forbidden  B-8
404 Object Not Found  B-8
501 Server Can't Do That B-8
Couldn’t Find Server  B-8
generic B-8

Generic Error  B-8

Not Available Offline  B-8
page B-8

Request Cancelled B-8
ServerIsBusy B-8

type B-8

(406) No Response Format B-8
URL Syntax Error  B-8
Error Type

(410) Page Doesn't Exist  B-8
(500) Internal Server Error  B-8
Ethernet Module  A-8
exe files 3-5,3-6

exit and
commit F-2
restore F-2
save F-2

expansion card 2-25

explore mobile device  4-5

Explorer
Internet  3-2, 3-3
Windows 3-7

F

F2key B-5

factory G-2

failure, battery  1-3
file

cab 3-5,3-6
Datalogic.omp 2-12
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Index

exe 3-5,3-6

MIB D-1

ReadMe 3-6

setup.exe 3-6
synchronization  4-5
transferring with ActiveSync ~ 4-4
zip 3-5,3-6

fleicons B-12

firmware H-3

aborting update  3-10
restoration 3-8

retrieving image 3-8
updates link 3-8
updating 3-9

FlashFX H-3

formatting conventions  i-vi
Four-Slot Battery Charger  A-5
Four-Slot Charge Dock ~ A-4
Four-Slot Ethernet Dock ~ A-4
Full ASCII conversion  2-11

G

general options  2-9
decoding control panel  2-8, 2-9, 2-10, 2-11
generic error  B-8

glossary H-1

good-read

beep duration F_ G-27

beeptone F-14, G-26

numberofbeeps E-14,
gripper bar  H-3

GS1 DataBar Expanded  F-8,
GS1 DataBar Limited  E-7, G-12

GS1 DataBar-14 G-12

4, G-2

G

H

Handle A-10
removing A-10
Handstrap A-9
handstrap
instaling  A-9
host PC system H-3
hotkey ~B-5, B-6, B-13

addnew B-7
new B-6

I

input state  H-6

status H-6

systemtray H-6

[ETab B-8

Inbox 3-2

Infrared Data Association H-3
input method H-3

input panel  H-3
installation

handstrap A-9
software  3-6

wizard 3-6
interleaved 2 of 5 2-10, F-8,
Internet Explorer  3-2, _3,_
redirection B-8

internet options  B-9

internet settings  2-14

IP

address 2-18

9, G-1

oo"rl

K

key
F2 B-5
hot B-6

navigation H-4

strokes entered by user
keypad

options 2-17

overview B-1

L

label

prefix  2-9

programming  2-9

suffix  2-9

long range trigger mode  F-14

M

Mag Stripe Reader  2-11
Magnetic Stripe Reader  2-10, A-15
manual, how touse  i-v
matrix2of 5 G-16
maximum default settings  G-2
memory

allocation  2-25

configuration  2-25

RAM  3-5
ID.# E-2 read-only 3-5
icons ROM 3-5
fle B-12 TrueFFS Disk  3-4
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usage 2-25

Memory, persistent  3-4
menu bar, enable B-9

MB H-4

Datalogic D-1

fles D-1

min/max lengths ~ 2-11
minimum default settings  G-2
mobile device 4-3

explore  4-5
mode

resume 1-1

suspend  1-1
Modem A-7

Modem Module ~ A-7
mounted file system H-4

mouse
click  i-vii
double-click  i-vii
right click  i-vii
select  i-vii
using  i-vii

MSI  E-10, G-18

my documents  4-6

name servers 2-18
navigation key H-4
Network

ID H-4

network

ActiveSync setup  4-8

connections 2-18, 4-7

D 47
overview 4-1
setupID  4-7
networking 4-7
new B-11
button B-12
hotkey B-6

non-persistent state  H-4
Not Available Offline  B-8
note B-7

o

object store  H-4
OK button  B-2, B-5, B-7, B-12
options, internet  B-9

other controls  E-1

overview B-1
overview, manual  j-v

owner properties  4-7

owner settings  2-19

P

parameters

acceptable input  E-1
barcodes F-3

bar codes without E-2

codabar FE-3

code 128 E-5
code39 F-4

code 93 F-4

code parameters  F-1
default F-1

EAN-13 F-6

EAN-8 F-6

ID# E-1

interleaved 2 of 5 F-8, F-9
label prefix  E-15, G-29

label suffix ~ E-15

MSI  E-10

on/off  E-1

Pharmacode 39 (Code 32) F-10
programming  F-1
standard2 of 5 F-11

trioptic  E-11
UPC/EAN extensions F-13
UPC-A F-12
UPC-E F-12

partnership

settingup  4-4
password 4-7, B-3, B-4
enter B-5

re-enter B-4
request B-4

set B-3,B-4
settings 2-19

PC card, expansion 2-25
Pegaso

dock A-2

power 1-1

persistent

state H-4

Persistent Memory ~ 3-4

Persistent Registry  2-20

Pharmacode 39 (Code 32) 2-10, F-10, G-20
pinouts E-1

portable data assistant (PDA) H-4

portable data terminal (PDT) H-4
portable keys  i-vi

portables
keys i-vi
power 1-1

check battery  2-21
configuration ~ 2-21
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control panel  2-21

power off tab  2-21
Power Supplies  A-2
Power Supply A-2
Powered Mobile Dock  A-6
product registration  i-vi
program memory  H-4
program, adding B-12
programming

barcodes G-1

parameters  F-1

programs
adding to the start menu  3-7
instaling  3-5

removing 3-7

R

RAM 2-25,H-5
ReadMe files 3-6
rebar H-5
reboot

after restoring firmware  3-11
application list  H-1

regional settings  2-22

registry defaults  G-2

reinstall applications from cold boot  3-12, H-1

release scan timeout  F-14
remote access server (RAS) H-5
remote ActiveSync  4-8
removing applications  3-7
Request Cancelled B-8
restore

firmware 3-11
fromregistry G-2

restore defaults  B-3, B-4
resuime 1-1

RF

card H-4

configuration  4-7

RFID 2-10

right click  i-vii

ROM H-5

RTC H-5

Run Program on Startup  B-12

S

save to registry G-2
Screen Protector A-13

SDCCF10G1  2-18

selector
application  B-10, B-13
enable application  B-11
send
check digit 2-11
checksum 2-11
system digit 2-11
serial
number 2-12,2-25
serial cable E-2
serial number 2-12
ServerIsBusy B-8
set ID character 2-9
set password B-3, B-4
settings
control panel  2-1
date and time 2-7
internet  2-14

modifying  2-1
regional 2-22
setup 3-6

network ID  4-7
network with ActiveSync ~ 4-8
shortcut  3-7
menu H-5
Show Taskbar B-10
Single Slot Dock  A-3
SNMP  4-8,H-5
concepts D-1
soft input panel  H-5
properties 2-14
software  3-1
installation  3-6
soundtab 2-27
sounds 2-26
splash screen H-5
spotting beam

enable F-14
timeout F-14
standard 2 of 5 2-10, F-11, G-20
start button  H-5

start menu, adding programsto  3-7
static IP settings 2-18
status

bar H-5

bar, enable B-9
icons H-5, H-6

style conventions  i-vi
stylus H-5

actions  i-vii
properties  2-23
Summit Client Utility  2-27
suspend mode  1-1, H-5
symbologies 2-9

selept barcode 2-8, 2-9, 2-10, 2-11
with a mouse  i-vii codabar F-3, G-8
with the stylus  i-vii code 128 F-5 F
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code 39 -4,
code 93 -4,
EAN-13  F-6, G- 9

EAN-8 F-6, G-11

GS1 DataBar G-12

IDs 2-9

interleaved 2 of 5 F-8, F-9, G-14
matrix2of5 G-16

MSI  E-10, G-18

Pharmacode 39 (Code 32) F-10, G-20
send identifiers  F-14, G-29
standard2 of 5 F-11, G-20

trioptic  E-11, G-22

UPC/EAN extensions  F-13, G-25
UPC-A  E-12,G-23

UPC-E E-12,G-24

synchronization folder  4-6
synchronizing files  4-5

system

firmware version  2-25

properties  2-25

serial number 2-25

systemtray H-6

icons H-6

keyboard indicators  H-6

—

tap stylus  i-vii
task bar B-9, H-6
enabled B-10

task switcher  B-13
time, setting  2-7

title

application B-12
touchscreen display
alignment 2-23
calibration 2-23
trioptic  2-10, F-11, G-22
TrueFFS Disk

location 3-4

using 3-4

two beeps on reboot  3-10

U

unauthorized use  B-9
Uniform Resource Locator (URL) H-6
Up/Down  B-11

UPC/EAN Extensions 2-10
UPC/EAN extensions  F-13, G-25
UPC-A  2-11, F-12, G-23
UPC-E E-12,G-24
URL 2-14

Syntax Error  B-8

USB H-6

driver 4-3

USB Cable A-2

userlDs 2-9

username 4-7

using

amouse  j-vii

ActiveSync  4-4

\'}

version

ActiveSync  4-2
volume

adjusting  2-26
beeper FE-14, G-25
tab 2-27

W

wakeup 1-1

Wceload 3-13

Wintab B-9

Windows

Explorer 3-7
Windows CE  H-6
Windows CE Desktop Enabled  B-10
windows controls  i-vi, B-9
WINS 2-18

wizard, installation  3-6
WordPad 3-3

X

X button -2, B-5, B-7, B-12

Z

zipfiles 3-5,3-6
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